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Preface

What this manual is about
The Oracle Financial Analyzer User’s Guide describes the Oracle®Financial Analyzer 
(hereinafter referred to as “Financial Analyzer”) user environment and provides 
information about database maintenance and document tasks. This guide is meant 
to be used as a companion to the Help system. Conceptual information and 
examples are included here; procedural information is included in Help. 
Throughout this guide you will find many references to specific Help topics.

Intended audience
Most of information in this guide is intended for users of Budget, Analyst, and 
Administrator workstations who are operating in the Microsoft Windows 
environment. Chapter 18 provides information for individuals who are using the 
Financial Analyzer web interface.

Structure of this document
The Oracle Financial Analyzer User’s Guide is structured as follows:

■ Chapter 1 describes the Financial Analyzer workstations and provides 
configuration information.

■ Chapter 2 describes Financial Analyzer menus and components.

■ Chapter 3 describes dimensions and dimension values, which are used to 
describe and structure data.

■ Chapter 4 describes financial data items, which are used to store and calculate 
financial data.
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■ Chapter 5 describes how you can create and use hierarchies.

■ Chapter 6 describes how to create and work with attributes.

■ Chapter 7 describes how to use the Selector.

■ Chapter 8 describes how to create and use models.

■ Chapter 9 describes how to solve data.

■ Chapter 10 describes how data and structures are transferred throughout the 
Financial Analyzer system.

■ Chapter 11 describes the features of the Task Processor and Task Queue, which 
manage information that is written to the shared database.

■ Chapter 12 describes the tasks that administrators must perform to set up and 
maintain system users.

■ Chapter 13 describes reports and explains how to create, edit, and maintain 
them.

■ Chapter 14 describes graphs and explains how to create, edit, and maintain 
them.

■ Chapter 15 describes worksheets and explains how to create, edit, and maintain 
them.

■ Chapter 16 describes data entry forms and explains how to create, edit, and 
maintain them.

■ Chapter 17 describes folders and explains how to manage them.

■ Chapter 18 describes how to use the Web interface to access, navigate, and exit 
Financial Analyzer with a browser.

■ Chapter 19 describes how to work with Web reports and graphs.

■ Chapter 20 describes how to use Web data entry forms to enter and submit data 
to the shared database.

■ Chapter 21 describes the Express Spreadsheet Add-In and explains how to use 
it with Financial Analyzer.

■ Chapter 22 describes how to use the data loader feature.

■ A glossary provides definitions for commonly used terms.
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Financial Analyzer Documentation 

Documentation set
This manual is part of a set of documentation, which also includes the following 
documents:

■ Oracle Financial Analyzer  Installation and Upgrade Guide — Describes how to 
install Financial Analyzer and upgrade an existing installation.

■ Oracle Financial Analyzer Application Programming Interface: Structure and 
Supporting Meta Data Guide — Describes how advanced users who are 
responsible for implementing the system can use custom programs to maintain 
Financial Analyzer structures and supporting metadata.

■ Integrating Oracle Financial Analyzer 6.3 with Oracle General Ledger 11 — 
Describes how to integrate Financial Analyzer with Oracle General Ledger.

■ Hooks in the Oracle Financial Analyzer 6.3 Application Interface — A technical note 
that describes worksheet hooks.

Help files
An online Help system provides procedural and reference information for both 
system administrators and general users in the Windows client environment.

An HTML Help system provides procedural and reference information for users of 
the Financial Analyzer web interface.
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Conventions

Text conventions
You will find the following text conventions in this document.

Mouse usage
Always use the left mouse button unless you are specifically instructed to use the 
right mouse button.

The term “left mouse button” refers to the dominant button. If you have 
reconfigured your mouse to reverse the functions of the left and right buttons, then 
you will need to use the reverse button when you follow the procedures in this 
manual.

Convention Usage

Boldface text Indicates menu items, command buttons, options, field names, 
and hyperlinks.

Bold text is also used for notes and other secondary information 
in tables (for example, Result).

Fixed-width text Indicates folder names, file names, operating system 
commands, and URLs. Also indicates examples and anything 
that you must type exactly as it appears.

For example: If you are asked to type show eversion, you 
would type all the characters exactly as shown in the 
fixed-width font.

Italic text Indicates variables, including variable text. Variable text is used 
when dialog boxes or their components are unlabeled or have 
labels that change dynamically based on their current context. 
The wording of variable text does not exactly match what you 
see on your screen.

Italic type is also used for emphasis, for new terms, and for titles 
of documents.

UPPERCASE text Indicates Express commands and objects and acronyms.
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Formats for key combinations and sequences
Key combinations and key sequences appear in the following formats.

Documentation Accessibility
Oracle’s goal is to make our products, services, and supporting documentation 
accessible to the disabled community with good usability. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program web site at http://www.oracle.com/accessibility/. 

IF you see the format . . . THEN . . .

Key1+Key2, press and hold down the first key while you press the second 
key. 

Example: “Press Alt+Tab” means to press and hold down the 
Alt key while you press the Tab key.

Key1, Key2, press and release the keys one after the other. 

Example: “Press Alt, F, O” means to press and release the Alt 
key, press and release the F key, then press and release the O 
key.
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1
Introducing Financial Analyzer

Chapter summary
This chapter describes Oracle® Financial Analyzer) workstations and provides 
configuration information.

Who should read this chapter
You need to know the information in this chapter if you are:

■ A system administrator 

■ A Budget or Analyst workstation user who wants to know how their 
workstation fits into the Financial Analyzer environment

List of topics
This chapter includes the following topics:

■ About Financial Analyzer

■ Super Administrator Workstations

■ Administrator Workstations

■ Task Processor Workstation

■ Budget Workstations

■ Analyst Workstations

■ Example: Workstations in a Typical Corporate Environment
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■ Comparison of Workstation Types

■ Typical Financial Analyzer Configurations

■ External Users

About Financial Analyzer

Definition: Financial Analyzer
Financial Analyzer is a distributed software application that you can use to: 

■ Report and analyze corporate financial data and create financial budgets, 
forecasts, and plans

■ Create and run financial models

■ Configure an efficient and convenient financial system for your business

Financial Analyzer runs on a combination of networked personal computers and 
servers. A variety of software modules, known as workstations, are installed on the 
personal computers and servers and are set up to access common databases, called 
shared databases. These shared databases contain data and structures that are used 
throughout the Financial Analyzer system.

If web listener software has been installed and configured on the server, Financial 
Analyzer reports, graphs, and data entry forms can also be accessed through a web 
browser.

Types of workstations
The Financial Analyzer environment includes two basic types of workstations,   
administrator workstations and user workstations. 

The following types of administrator workstations are supported:

■ Super administrator workstation

■ Administrator workstations

■ Task Processor workstations

The following types of user workstations are supported:

■ Budget workstations

■ Analyst workstations
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Types of databases
The following table describes the types of databases that can be associated with 
Financial Analyzer workstations.

Tiered system design
Using the Super administrator workstation as the starting point, you can build a 
tiered architecture by creating subordinate administrator workstations, which can in 
turn be used to create other subordinate administrator workstations.

This tiered approach to system design reduces the size and complexity of the 
top-level structures and permits greater autonomy and control at lower-level and 
remote sites.

Super Administrator Workstations

Definition: Super administrator workstation
A Super administrator workstation enables the administrator at the highest level to 
perform the following functions:

■ Define database structures and documents for system-wide use

■ Control subordinate administrators’ and users’ access to financial data

■ Process tasks submitted by users to update the Super administrator’s shared 
database

Location in a tiered environment
The Super administrator workstation is located at the top level of any Financial 
Analyzer environment. Only one Super administrator workstation can exist in a 
given system.

Database Description

Personal Personal databases are used to store objects, and on some types of 
workstations, financial data. Objects include dimensions, financial data 
items, attributes, and hierarchies, as well as documents such as reports, 
worksheets and graphs.

Shared The shared database contains financial data and objects that are shared 
by all users. Shared databases are maintained by administrators.
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Associated databases
Super administrator workstations are associated with a Super shared database, a 
personal database, and a Task Processor. The following illustration shows how a 
typical Super administrator workstation is configured.

Administrator Workstations

Definition: Administrator workstation
The Administrator workstation is a system management and data access tool that 
enables you to perform the following tasks:

■ Define and maintain users of Budget, Analyst, and subordinate Administrator 
workstations.

■ Specify the default configuration for Budget, Analyst, and subordinate 
Administrator workstations when you create them.

■ Restrict changes to shared data by controlling user access to the financial data in 
the shared database.
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■ Define database structures and distribute them to the shared database, 
subordinate Administrator workstations, Budget workstations, and Analyst 
workstations.

■ Distribute slices of financial data to users and the shared database.

■ Refresh the shared database that you maintain with data distributed from your 
superior administrator.

■ Submit financial data from the shared database that you maintain to your 
superior administrator’s shared database. (Note that super administrators 
cannot perform this task because by definition they are at the highest level in 
the reporting structure.)

Location in a tiered architecture
Multiple Administrator workstations can exist at various levels of an environment 
that is set up in a tiered configuration. Each Administrator workstation is associated 
with its own shared database.
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Associated databases
Administrator workstations are associated with a shared database and a Task 
Processor. The following illustration shows how a typical Administrator 
workstation is configured.

Task Processor Workstation

Definition: Task Processor workstation
A Task Processor workstation is a queue management tool that has the following 
characteristics: 

■ It is associated with each Administrator workstation in an Financial Analyzer 
system

■ It enables administrators to monitor and control the transfer of data between 
user workstations and their associated shared databases

■ It enables administrators to manage distribution of structures to subordinate 
workstations
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Methods of running a Task Processor
Although all tasks are actually processed on the server, a Task Processor can be set 
up: 

■ As a separate software component on the computer where an Administrator 
workstation runs

■ On a separate computer that is dedicated to task processing

■ To run directly on a server as a background task

When the Task Processor workstation is installed as a stand-alone workstation on a 
dedicated PC or server, tasks can be processed without interruption.

Administrator workstation Task Processor
The following illustration shows how a Task Processor workstation can be installed 
on the same PC as an Administrator workstation.
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Stand-alone Task Processor
The following illustration shows a Task Processor workstation that is set up to run 
on a separate computer that is dedicated to task processing.

Related information
For more information about the Task Processor, see Chapter 11.

Budget Workstations

Definition: Budget workstation
A Budget workstation is a data access tool that enables you to perform the 
following tasks:

■ Define and maintain personal database objects such as dimensions, attributes, 
hierarchies, models, solve definitions, and group solve definitions

■ Create and maintain personal reports, graphs, worksheets, and folders 

■ Use administrator defined database objects and documents
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■ Submit financial data from the personal database to the Administrator 
workstation’s shared database

■ Refresh the personal database with data from the Administrator workstation’s 
shared database

Location in a tiered architecture
In a tiered structure, a Budget workstation is located beneath the Administrator 
workstation that created it and is associated with a personal database that contains 
database structures, settings, and financial data. 

Multiple Budget workstations can exist beneath the same Administrator 
workstation. In a tiered configuration, multiple Budget workstations can also exist 
at multiple levels of the configuration.

How Budget workstations communicate with the shared database
The following illustration shows how Budget workstations communicate with the 
shared database through the Task Processor.



Analyst Workstations

1-10 Oracle Financial Analyzer User’s Guide

Analyst Workstations

Definition: Analyst workstation
An Analyst workstation is a data access tool that enables you to perform the 
following tasks:

■ Refresh structures distributed by the Administrator workstation

■ Define and use personal reports, graphs, worksheets, and folders or use 
administrator defined documents

■ Access and manipulate data associated with dimensions, dimension values, 
time, attributes, hierarchies, and models in the shared database

Location in a tiered architecture
In a tiered structure, an Analyst workstation is located beneath the Administrator 
workstation that created it and is associated with a personal database that contains 
database structures and settings but no personal copy of financial data.
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How Analyst workstations communicate with the shared database
The following illustration shows how Analyst workstations communicate with the 
shared database through the Task Processor.

Note that when viewing data, the Analyst workstation communicates directly with 
the shared database, and does not go through the Task Processor.

Example: Workstations in a Typical Corporate Environment

Introduction
In a typical corporation, there are many different ways that Financial Analyzer can 
be configured and utilized. The following sections describe several divisions of a 
fictitious corporation and how they each use Financial Analyzer.
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Consulting division
In the consulting division, regional Consulting Managers use Budget workstations 
that report into the Sub Administrator workstation of the Consulting VP. 
Consulting Managers can: 

■ Edit the expense and revenue line items of their region.

■ View the expense and revenue line items of other regional Consulting 
Managers. This facilitates Consulting Managers inputting their budget and 
forecast numbers based on trends in their particular regions. 

■ Perform what-if analysis to evaluate the potential performance based on the 
probability of the variable environment factors occurring. 

■ Augment their personal database by adding financial and personnel data which 
is not present in the data set distributed to them from the Administrator (which 
is sourced primarily from Oracle General Ledger). 

When budgets or forecasts are completed, Consulting Managers submit their final 
numbers to the Consulting VP who reviews them and requests revisions if 
necessary. The Consulting VP may also make edits to the shared data which become 
the final budget. The lower level Budget workstations Consulting Managers then 
refresh their personal databases to get the finalized figures. The Consulting VP 
submits final summary consulting P&L budgets and forecasts to a Senior Financial 
Analyst in Corporate Finance who runs the Super administrator workstation.
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The following illustration shows the Consulting Division.

Manufacturing
In the manufacturing environment, Product Managers:

■ Follow an organization similar to the Consulting Managers, except that what 
they can view and edit is determined by their product responsibilities rather 
than by their geographic region. 

■ Utilize Financial Analyzer Budget workstations to budget and forecast and 
perform in-depth analyses such as product profitability, customer profitability, 
trend analysis, what-if analysis, and production forecasting. 

■ Submit forecasts and budgets to the Production VP or directly to a Financial 
Analyst in Corporate Finance. 

Some product managers are provided with Analyst workstations to keep current on 
company performance and to support production line decisions. These Analyst 
workstation users view the historic, budget, and current forecast data to properly 
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plan and execute to the budget/forecast. Their view of the data is also very 
product-focused. They do not need to perform analysis or provide budget or 
forecast data. They use the finalized corporate data for ongoing decision making 
and planning; therefore, the functionality of the Analyst workstation suits their 
needs.

The following illustration shows the manufacturing division.

Corporate finance
In general, all Manufacturing and Consulting related workstations report directly to 
the Super administrator workstation in Corporate Finance. Other Financial 
Analyzer users in the Corporate Finance Department are either Budget or Analyst 
workstations, all of which report to the Super administrator workstation.

A Senior Financial Analyst or a number of Senior Financial Analysts are responsible 
for the collection of budget and forecast data throughout the organization. If there 
are a number of these positions, they act as Administrator workstations which then 
report to a Super administrator workstation within the Corporate Finance 
Department. The Senior and Junior Financial Analysts all require analysis and 
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modeling capabilities to review and possibly modify the information coming in 
from other areas of the organization.

Other specialists in the Corporate Finance Department can require either the Budget 
or Analyst workstation functionality: 

■ The CFO normally requires only Analyst workstation functionality

■ Budget or Forecast Analysts who concentrate primarily on forward trends and 
potential changes in the projected performance path require Budget 
workstations

The Super administrator resides in the Corporate Finance Department and the 
number of Sub administrator workstations it supports depends on whether data 
from other areas of the organization is submitted to one or many workstations 
within the Corporate Finance department.
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The following illustration shows Corporate Finance.
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Comparison of Workstation Types

System management tasks
The following table shows the different types of workstations and the system 
management tasks that each can accomplish.

Data management tasks
The following table shows the different types of workstations and the data 
management tasks that each can accomplish.

Task
Super 

Administrator Administrator
Task 

Processor Budget Analyst

Configure 
workstations

X All but Super 
administrator

Control user 
access to 
database 
objects

X X

Define and 
maintain users

X All but Super 
administrator

Monitor and 
control transfer 
of data

X X X

Set fiscal time X

Specify default 
configurations 
for Budget and 
Analyst 
workstations

X X

Task
Super 

Administrator Administrator
Task 

Processor Budget Analyst

Create data 
structures

X X Personal 
only

Create and 
maintain 
personal 
documents

X X X X
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Typical Financial Analyzer Configurations

Simple configuration
The simplest system configuration is made up of the following: 

■ A single Super administrator workstation that includes a super shared database 
and Task Processor

■ One or more user workstations

Distribute 
financial data

X X

Distribute 
structures

X To all but Super 
administrator

Maintain 
personal data

X X X

Submit data to 
shared database 
via the Task 
Processor

X X

N/A

X X

Process tasks in 
the shared 
database

X

View task log X X X X X

Integrate with 
Oracle General 
Ledger

X

Refresh data 
distributed 
from higher 
level 
administrators

X X X

Use the Copy 
Data feature

X X X

Task
Super 

Administrator Administrator
Task 

Processor Budget Analyst
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The following illustration shows an example of a simple system configuration.

Complex configuration
A more complex system configuration can be set up with multiple tiered structures. 
In a structure with multiple tiers, each level, or tier, includes the following: 

■ A single Super administrator workstation, that includes a super shared 
database and Task Processor

■ One or more Administrator workstations that each include a shared database 
and Task Processor

■ One or more user workstations that communicate with the Administrator 
workstation in the tier immediately above them
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The following illustration shows a more complex system configuration.

External Users

About external users
In addition to supporting access through workstations, Financial Analyzer supports 
external users. External users have access to their administrator’s shared database. 
No client software needs to be installed on the local PC. 

There are two types of external users:

■ External web users

■ External Express Spreadsheet Add-In users
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External web users
External web users access Financial Analyzer reports and graphs through a web 
browser. An external web user can also use data entry forms to enter data into the 
shared database. An external web user cannot create or maintain personal 
documents, create or distribute data structures, or distribute data.

External Express Spreadsheet Add-In users
Express Spreadsheet Add-In users fetch data from one or more Financial Analyzer 
databases and work with the data in a spreadsheet environment. An Express 
Spreadsheet Add-In user who is an external user is limited to data manipulation; no 
personal database is available.
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2
Getting Started

Chapter summary
This chapter provides basic information about Financial Analyzer.

Who should read this chapter
All workstation users should read this chapter.

List of topics
This chapter includes the following topics:

■ About Financial Analyzer

■ The Financial Analyzer Window

■ The Financial Analyzer Menu Bar

■ The Financial Analyzer Toolbar

■ The Financial Analyzer Edit Bar

■ Starting Financial Analyzer

■ Working in a Stand-Alone Session

■ Using the Custom Menu Feature

■ Using Online Help
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About Financial Analyzer

Financial Analyzer documents
You can work with four types of documents in Financial Analyzer: 

■ Reports

■ Graphs

■ Worksheets

■ Data entry forms

Reports
You use reports to view your financial data from different perspectives and prepare 
presentations based on your analyses.

 The following illustration shows an example of a Financial Analyzer report.

Graphs
You use graphs to create visual representations of your financial data.
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The following illustration shows an example of a Financial Analyzer graph.

Worksheets
You use worksheets to enter and manipulate financial data. 
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 The following illustration shows an example of a Financial Analyzer worksheet.

Data Entry Forms
You use data entry forms to enter data using the Financial Analyzer web interface.
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The following illustration shows an example of a Financial Analyzer data entry 
form in a web browser. 

Compatibility with other products
You can use Financial Analyzer in conjunction with the following products:

■ Oracle General Ledger – If your site has purchased Oracle General Ledger, you 
can integrate it with Financial Analyzer during installation and setup. 

■ Microsoft® Excel – You can choose to install the Oracle Express Spreadsheet 
Add-In when installing a Financial Analyzer workstation. This enables you to 
fetch data from one or more Financial Analyzer databases and work with 
Financial Analyzer data in a spreadsheet environment. 

■ Oracle Express Objects and Oracle Express Analyzer – If you have purchased 
Oracle Express Objects and Oracle Express Analyzer you can enable your 
Financial Analyzer databases for use with these products. You can then use 
Oracle Express Objects and Oracle Express Analyzer to develop custom 
applications.
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The Financial Analyzer Window 

Financial Analyzer window components
The following illustration shows the components of the Financial Analyzer window.

Description of Financial Analyzer window components
The following table describes the Financial Analyzer window components.

Component Description

Title bar Displays the name of the database or workstation.

Menu bar Contains the names of Financial Analyzer menus. You open menus and 
then choose menu items to perform tasks.

Tool bar Provides you with quick access to commonly used functions through a 
set of buttons. When you start up Financial Analyzer for the first time, 
the toolbar is displayed automatically.

Edit bar Features an area for modifying report, worksheet, and graph components 
such as titles, labels, and footnotes. It can also be used in worksheets to 
edit data, and in reports to enter calculation formulas.
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The Financial Analyzer Menu Bar

Standard control menus
 The Financial Analyzer menu bar always contains the following control menus.

To see a control menu, move the pointer to the item you want to view and choose it. 
The following sections describe the control menus.

Edit bar 
buttons

In reports, the Formula Tools button invokes the Formula Tools dialog box, 
where you can edit formulas to perform report calculations. This button 
is disabled in Worksheets and Graphs.

 The Cancel button clears text or formulas from the edit bar.

The Enter button moves text or formulas from the edit bar into the 
currently selected area.

Application 
window

The area where Financial Analyzer documents, such as reports, graphs, 
and worksheets, appear.

Component Description
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File menu
The following table describes the File menu.

Edit menu
The following table describes the Edit menu.

Menu Item Description

New Creates a new document.

Open Opens an existing document.

Close Closes an open document.

Save Saves an open document under its current name.

Save As Saves an open document under another name.

Rename Renames an existing document.

Delete Deletes an existing document.

Add to Folder Adds a document to a folder.

Print Preview Enables you to view a document before you print it.

Print Prints the current document.

Print Setup Enables you to set up the printing specifications for a document.

Print Multiple Enables you to print multiple documents within one print session.

Export to File Exports data from a document to a file that can be used in another 
application.

Exit Exits Financial Analyzer.

Recently Opened 
Document 
Name(s)

Lists the names of up to five recently opened documents, from which 
you can choose a document to open.

Menu Item Description

Cut Selects a portion of a document and moves it to the Clipboard.

Copy Copies a portion of a document to the Clipboard.

Paste Pastes the contents of the Clipboard into the current document.

Paste Link Links selected tiles between two documents.

Clear Clears the contents of selected cells in a report or worksheet.
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Format menu
The following table describes the Format menu.

Clear Link Clears a link between two documents.

Highlight 
Special

Enables you to highlight labels, data, or both in reports and worksheets 
for formatting purposes.

Insert Opens a cascading menu that contains the following items: 

■ Row/Column — Opens the Insert Rows Dialog Box or the Insert 
Columns Dialog Box, which allow you to insert columns or rows in 
reports and worksheets. 

■ Page break — Enables you to insert page breaks into reports and 
worksheets.

Move Insert For reports that have inserted rows and columns, opens the Move 
Insert dialog box, which enables you to move inserted rows and 
columns in reports.

Delete Opens a cascading menu that contains the following items: 

■ Row/Column — Enables you to delete inserted columns or rows in 
reports and worksheets. 

■ Page break — Enables you to delete inserted page breaks from 
reports and worksheets. 

Menu Item Description

Number Formats numbers in reports, graphs, and worksheets.

Alignment Sets the horizontal and vertical positioning of a selected component in a 
document.

Font Sets the typeface, font style, size, and color of text in a document.

Patterns Sets the pattern and color of data cells and labels.

Axis Options Sets axis options for selected axis in a graph.

Series Options Enables you to modify the manner in which data series are represented 
in a graph.

Border Adds a border to selected parts of a report, and sets width, color, and 
border style.

Row Height Sets the row height in a report, worksheet, or data entry form.

Menu Item Description
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Report menu
The following table describes the Report menu. This menu is accessible when a 
Report document is open.

Column Width Sets the column width in a report, worksheet, or data entry form.

Page Setup Sets page and print options, margins, headers, or footers.

Menu Item Description

Report Options Opens the Report Options dialog box, where you choose elements to 
display in the report.

Dimension 
Labels

Opens the Dimension Label Setup dialog box, where you can specify 
the text that the system will use when it creates row, column, and page 
labels.

Drill When checked, enables drilling in reports.

Auto Redisplay When checked, specifies that reports are to be automatically 
redisplayed when you make changes to them.

Asymmetric 
Format

Opens the Create Asymmetric Combination dialog box, where you can 
join the values of two dimensions and create a custom arrangement of 
their values.

Ranking/
Exception 
Report

Opens the Ranking and Exception Setup dialog box, where you can 
specify the criteria for a ranking and exception report.

Drill to GL Provides detailed information in General Ledger that may not appear 
on a report. This option is accessible only if you are working with a 
report based on data that was loaded from General Ledger and you are 
set up to use the GL Link. 

Menu Item Description
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Graph menu
The following table describes the Graph menu. This menu is accessible when a 
graph document is open.

Worksheet menu
The following table describes the Worksheet menu. This menu is accessible when a 
worksheet document is open.

Menu Item Description

Type Opens the Graph Type dialog box, which enables you to specify the 
type of graph you want to use.

Legend Opens the Legend dialog box, where you can specify whether to 
display a legend for your graph. This dialog box also enables you to 
format the legend.

Pie Options Opens the Pie Options dialog box, where you can specify labels for a 
pie graph and/or its slices and perform other formatting functions.

Grid Opens the Grid dialog box, where you can specify whether to display 
gridlines along the X- and/or Y-axis of a graph.

Graph Options Opens the Graph Options dialog box, where you can specify 
information for graph controls, text, attributes, and axis titles.

Dimension 
Labels

Opens the Dimension Label Setup dialog box, where you can specify 
the text that the system will use when it creates row, column, and page 
labels.

Auto Redisplay When checked, specifies that graphs are to be automatically 
redisplayed when you make changes to them.

Menu Item Description

Worksheet 
Options

Opens the Worksheet Options dialog box, where you can choose 
elements to display in a worksheet.

Dimension 
Labels

Opens the Dimension Label Setup dialog box, where you can specify 
the text that the system will use when it creates row, column, and page 
labels.

Drill When checked, enables drilling in worksheets.

Auto Redisplay When checked, specifies that worksheets are to be automatically 
redisplayed when you make changes to them.
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Drill to GL Provides detailed information in General Ledger that may not appear 
on a worksheet. This option is accessible only if you are working with a 
worksheet based on data that was loaded from General Ledger and you 
are set up to use the GL link.

Worksheet Tools Opens the Worksheet Tools cascading menu which contains the 
following items:

■ Grow Data — Opens the Grow Data dialog box, which enables you 
to grow data by a specified amount or percent across months.

■ Increase Data — Opens the Increase dialog box, where you can 
increase data for selected months by a specified amount or percent.

■ Spread Data — Opens the Spread dialog box, where you can apply 
a value to a parent in a hierarchy and spread that data to its 
descendants in the hierarchy.

■ Recalculate — Enables you to recalculate data after you have 
entered data for dimension values.

■ Recalc Options — Opens the Recalc Options dialog box, enabling 
you to specify options for recalculating data.

■ Save Data — Enables you to save worksheet data without saving 
the current worksheet definition.

■ Reset Data — Returns worksheet data to the values that were 
displayed when the worksheet was last opened or the worksheet 
was last saved.

Menu Item Description
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Data Entry Form menu
The following table describes the Data Entry Form menu. This menu is accessible 
when a data entry form document is open.

The Tools menu
The following table describes the Tools menu.

Menu item Description

Form 
Options

Opens the Data Entry Form Options dialog box, where you can perform the 
following functions: 

■ Show or hide text elements such as titles, subtitles, and footnotes.

■ Enter annotations.

■ Specify how NA values will be displayed.

Data Options The Number Format submenu item opens the Number Format dialog box, 
where you can specify the number format (positive, negative, decimal) for 
a financial data item.

The Calculations submenu item opens the Calculations dialog box, where 
you can associate a solve definition with a financial data item.

Dimension 
Labels

Opens the Dimension Labels dialog box, where you can specify the text 
that the system will use when it creates row, column, and page labels.

Asymmetric 
Format

Opens the Create Asymmetric Combination dialog box, where you can join 
the values of two dimensions and create a custom arrangement of their 
values.

Menu Item Description

Selector Opens the Selector dialog box, which enables you to choose the 
dimension values that appear in a document.

Solve Definition Opens the Solve Definition dialog box, which enables you to create and 
use solve definitions to calculate data.

Group Solve 
Definition

Opens the Group Solve Definition dialog box, which enables you to 
create and use group solve definitions to calculate data.

Copy Data Opens the Copy Data dialog box, which enables you to copy financial 
data between financial data items or set the data in a financial data item 
to NA.

Maintain 
Folders

Opens the Maintain Folders dialog box, which enables you to create, 
add documents to, delete documents from, and order documents in, a 
folder.
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The Maintain menu
The following table describes the Maintain menu.

Custom Colors Opens the Custom Color dialog box, which enables you to customize 
and rename the standard colors that are available to you in Financial 
Analyzer.

Custom Menus Opens the Custom Menus dialog box, which enables you to create 
custom menu items that run Express programs or call other 
applications. 

Options Opens the Options dialog box, which enables you to select optional 
elements to include in the Financial Analyzer window. Administrators 
can also specify the operational mode for their workstation.

Enable database 
DB for Express 
Clients

Enables your Financial Analyzer database to be compatible with 
Express Client software.

Menu Item Description

Dimension Opens the Maintain Dimension dialog box, from which you can define 
and maintain dimensions.

Financial Data 
Item

Opens the Maintain Financial Data Item dialog box, from which you 
can define and maintain financial data items.

Time Opens the Maintain Time dialog box, which enables you to create and 
maintain time dimension values and sets the current time.

Dimension 
Value

Opens the Maintain Dimension Value dialog box, where you can create 
and maintain dimension values.

Attribute Opens the Maintain Attributes dialog box, which enables you to 
associate a characteristic with multiple values.

Hierarchy Opens the Maintain Hierarchy dialog box, which enables you to define 
and maintain the tree structures used to relate dimension values.

Menu Item Description
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The Manage menu
The following table describes the Manage menu.

Model Opens the Maintain Model dialog box, where you can create and 
maintain models.

Data Loaders Opens a cascading menu which contains the following options:

■ Create — Opens the Oracle Express Administrator Browser 
window, where you can create data loader programs.

■ Maintain Groups — Opens the Maintain Data Loader Groups 
dialog box, which enables you to create sets of data loaders that 
you can run as a single process.

■ Run — Opens the Run Data Loaders dialog box, where you can set 
up the data loaders and run them.

Menu Item Description

Distribution Opens a cascading menu, which contains the following menu items:

■ Distribute Structure — Opens the Distribute Structure dialog box, 
which enables administrators to distribute structures, such as 
dimensions or reports, to their users.

■ Distribute Data — Opens the Distribute Data dialog box, which 
enables administrators to distribute data to their users.

Distribution 
Reports 

Opens a cascading menu, which contains menu items that enable you 
to open the Distribution Report dialog box:

■ Based on Distributed Values — Provides information for values of 
a structure that have been distributed to at least one user.

■ Based on All Values — Provides information for all values of a 
structure, whether or not they have been distributed to a user.

Users Opens the Maintain Users dialog box, which enables administrators to 
add and delete users from the system.

Write Access 
Profiles

Provides access to the Write Access Profiles dialog box, which enables 
you to set access restrictions on data. (Available in Super administrator 
and Administrator workstations.)

Submit 
Documents

Provides access to the Submit Documents dialog box, which enables 
you to select documents to submit to the shared database. (Available in 
non-Administrator workstations.) 

Menu Item Description
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Task Processor Opens the Task Processor dialog box, which enables you to process 
tasks submitted by Administrator, Budget, and Analyst workstations. 
(Available in Super administrator and Administrator workstations.)

Task Queue Opens the Task Queue dialog box, where you can view information 
about distribution tasks. (Available in all workstations.)

Refresh 
Structures

Opens the Refresh Preview dialog box, which enables you to view 
which structures will be added, deleted, or overwritten when you 
refresh your database. (Available in Administrator, Budget, and Analyst 
workstations).

Submit Data Sends data to your administrator. In an Administrator workstation, 
sends data to the administrator’s shared database or to the shared 
database maintained by a higher level administrator.

Refresh Data In a Budget workstation, refreshes your database with data retrieved 
from the shared database. In an Administrator workstation, retrieves 
structures from the administrator’s shared database or refreshes the 
administrator’s shared database with structures distributed by a higher 
level administrator. (Available in Super administrator, Administrator, 
and Budget workstations.)

Oracle General 
Ledger Interface

If you have installed Oracle General Ledger, opens a cascading menu, 
which contains the following items:

■ Submit Load from GL — Opens the Submit Load from GL dialog 
box, which enables you to log into your GL Account and load data 
into General Ledger either manually or automatically.

■ Refresh GL — Opens the Refresh GL Structure dialog box, which 
enables you to see which database objects from General Ledger are 
to be added, deleted, or overwritten when you refresh your 
database.

■ Write Budget to GL — Opens the Write Budget to GL dialog box, 
which enables you to specify the data to write back to General 
Ledger.

■ Add GL Dimension Values — Opens the Add GL Dimension 
Values dialog box, which enables you to create dimension values 
for General Ledger segment values that were imported into 
Financial Analyzer but which had no associated balances at the 
time they were loaded.

■ GL Access Settings — Opens the GL Access Settings dialog box, 
which enables you to specify the financial data set to be 
downloaded and the name of the account on the host computer 
where the Oracle General Ledger data reside.

(Available in Super administrator workstations.)

Menu Item Description
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The Window menu
The following table describes the Window menu.

The Help menu
The following table describes the Help menu.

Custom add-in menu
As an administrator, you can add a custom menu to the Financial Analyzer menu 
bar. The custom menu can contain options that invoke Express programs or other 
applications. When you create a custom menu, it appears on the menu bar between 
the Window menu and the Help menu. For more information, see “Using the 
Custom Menu Feature” on page 2-23.

Menu Item Description

Cascade Arranges open document windows in an overlapping fashion so that 
each title bar is visible and accessible.

Tile 
Horizontally

Arranges open document windows so that they share the application 
window equally and align horizontally without overlapping.

Tile Vertically Arranges open document windows so that they share the application 
window equally and align vertically without overlapping.

Arrange Icons Arranges document icons into rows with equal space between them.

Open Document 
Name(s)

Lists the names of currently open documents, from which you can 
choose a document, making it the active document on your screen.

Menu Item Description

Contents Displays a list of topics about which you can view Help information.

Search for Help 
On

Displays the Search dialog box, where you can enter search keywords 
to find topics on which you need help.

How to Use 
Help

Provides further information on how to use Help.

About Financial 
Analyzer

Provides external and internal version numbers for Financial Analyzer.
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The Financial Analyzer Toolbar

Definition: Toolbar
The toolbar provides quick access to frequently used commands. 

Toolbar buttons
The following table shows each button on the toolbar and describes its function.

Button Function

Opens the New dialog box, which enables you to create a new document.

Opens the Open dialog box, from which you can open a saved document.

Enables you to save the active document.

Opens the Selector dialog box, where you can specify the data with which 
you want to work.

Displays the Font dialog box, which enables you to specify font, style, and 
size of text or data in a document.

Opens the Patterns dialog box, which enables you to specify characteristics, 
such as color, pattern, line style, and width, in the current report, graph, or 
worksheet.
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Toolbar display options
You can control the following toolbar display options: 

■ Whether the toolbar is displayed

■ Whether toolbar text is displayed

■ Toolbar style: raised or flat

To specify toolbar options, choose Options from the Toolbar menu. This activates 
the Options dialog box, where you can make your selections. 

Opens the Format Number dialog box, which enables you to change the 
format for numeric values and dates.

The Save Data button saves the data in the current worksheet. 

Opens the Graph Type dialog box, where you can choose the type of graph 
that you want to view.

Opens the Print dialog box, which enables you to print the active document.

Enables you to access online information that explains how to perform a 
task or describes what is currently displayed on your screen.

Button Function
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The Financial Analyzer Edit Bar

Definition: Edit bar
The Edit bar enables you to edit text elements in reports, graphs, worksheets, and 
data entry forms as well as values and text in some dialog boxes. 

Elements that you can edit
The following list describes the elements you can edit in each document type:

■ In graphs you can edit the title, subtitle, X-axis tick label, Y-axis tick label, axis 
title, legend label, or footnote

■ In reports, worksheets, and data entry forms you can edit titles, subtitles, row 
labels, column labels, or footnotes 

■ In worksheets, you can edit data

■ In reports, you can edit calculation formulas

Starting Financial Analyzer

Logging in
You must connect to an Express Server session to start Financial Analyzer. After the 
first time you log in, the system saves the information that you enter in the Connect 
to Express Server dialog box. You only have to enter your password in subsequent 
sessions.

How to log into Express Server
Follow this procedure to log into Express Server.

1. Double-click on the Financial Analyzer icon.

The Connect to Express Session dialog box appears.

2. Complete the fields in the dialog box as follows:

■ In the Username box, enter your username for the system on which the 
Express Server session you are logging into is located.

■ In the Password box, enter your password.
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■ In the Domain box, enter the domain name for your PC, if required. 

■ In the Name box, enter the name of the personal database to which you 
want to connect.

■ In the Path box, enter the full path for the database to which you want to 
connect.

■ If you want to work in a stand-alone session, select Express installed on 
local workstation.

■ In the Server box, enter the name of the server to which you want to 
connect.

■ If multiple instances of Express Server are running on the server, enter the 
unique universal identifier (UUID) for the Express Server instance to which 
you want to connect.

3. Select OK.

The Financial Analyzer main window appears.

Note: Contact your system administrator to obtain the correct login information for 
your system.

Working in a Stand-Alone Session

Definitions: Thick and thin clients

Thick client 
A client is considered thick if the personal database and Personal Express are 
installed on the PC and a majority of processing takes place on the PC.

Thin client
A client is considered thin if the personal database and express server are installed 
on the server and a majority of processing occurs on the server.

About working stand-alone
You can work without being attached to the shared database if your PC is set up as 
a thick client. When you start the software while working on a stand-alone 
workstation, the software warns you that you are not able to connect to the shared 
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database and asks if you want to work unattached. If you choose Yes, you will be 
running in a stand-alone session, where you are unable to receive distributions or 
submit your work. During a subsequent work session when you are attached to the 
shared database, you can submit the data that you worked on during your 
unattached session.

You can specify a setting in the Options dialog box that tells the system to 
automatically ask if you want to work unattached to the shared database. Setting 
this option enables users who are working away from the office to bypass a set of 
message boxes requesting passwords and providing warning messages.

Conditions that must be met
You can work in a stand-alone session unattached to the shared database if the 
following conditions are met: 

■ You are working on a Super administrator, Administrator, or Budget 
workstation.

■ You installed a personal copy of Financial Analyzer code.

■ You are working on a PC that is set up as a thick client.

When you can work stand-alone
Using this feature, you can continue to work productively even if: 

■ You have to be away from your office and do not have the ability to 
communicate with the shared database.

■ You are unable to connect to the shared database because of communications 
problems within your normal working environment.

When you cannot work stand-alone
You cannot work stand-alone if:

■ You are using an Analyst workstation. This is because Analyst workstations 
must always attach directly to the shared database.

■ You are on a workstation that does not have a copy of personal code installed.

■ You are working on a PC that is set up as a thin client.
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Using the Custom Menu Feature

About the Custom Menu feature
As an administrator, you can add a custom menu to the Financial Analyzer menu 
bar. The custom menu can contain menu groups and menu items. 

■ Menu group — Provides access to a submenu of related menu items. You can 
add up to ten menu groups to a custom menu.

■  Menu item — Accesses a single executable or Express program.

The menu structure that you create can include one or more single-level menu 
items, one or more menu groups (each of which branches to multiple menu items), 
or a combination of menu items and menu groups. 

Creating a custom menu
You choose Custom Menus from the Tools menu to create a custom menu. This 
opens the Custom Menus dialog box, where you can perform the following 
functions: 

■ Enter a descriptive name for the custom menu.

■ Insert one or more menu groups and specify the order in which they will 
appear on the menu.

■ Insert one or more menu items under the main menu or a menu group, specify 
the order in which items will appear, and provide information about the custom 
programs that are called by the menu items.

You provide the following information for each menu item:

■ The type of users who will have access to the menu item.

■ The type of program that the menu item will call: Express routine or an 
executable.

■ The name of the program that will run when a user chooses the custom menu 
item.

■ If users will be prompted to provide information in order for the program to 
run, the text that will prompt the user for input.
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■ How the custom program window will appear to the user: Normal, Minimized, 
or Maximized.

■ If a message will be displayed when the program is completed.

Example: Creating a custom menu
The following illustration shows the Custom Menus dialog box for a custom menu 
that includes one group and one item. In this example, the menu name is Custom 
Programs, the menu group is APIs, and the menu item under the menu group is 
API123, an Express program. 

How the custom menu is displayed
The custom menu is displayed on your Financial Analyzer menu bar after you have 
created at least one custom menu group or item. If you do not change the menu 
name, the menu bar displays the default name, “Add-In,”; if you change the menu 
name, the menu bar displays the name that you provide. 
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Distributing the custom menu
You distribute custom menu groups and items to the users who need access to these 
programs. You can give different users access to different options. 

Note: While you can use Financial Analyzer’s distribution feature to propagate the 
custom menu groups and items that you create, you cannot use it to distribute your 
custom programs. You must perform this task manually.

Modifying the Custom menu
You choose Custom Menus from the Tools menu to modify the custom menu. This 
opens the Custom Menus dialog box, where you can change information for menu 
name, menu groups, and menu items. You can also rearrange the order of groups 
and items on the menu and delete a group, an item, or even the entire menu.

Ensure that you distribute custom menu modifications to the appropriate users. 

Related information
For more information about working with a custom menu, see the following topics 
in the Financial Analyzer Help system:

“Creating Custom Menu Groups and Items”
“Deleting Custom Menu Groups and Items”

Using Online Help 

Overview
The online Help system included with the software is comprehensive and easy to 
use. It is your best source of procedural information and is designed to give you 
step-by-step instructions on how to do almost everything in the application.

How to access the Help system
To access the Help system, click on the Help button on the toolbar or select the Help 
menu from the Menu bar. The initial help screen contains a list of underlined topics. 
Choose these topics for more information.
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How to find specific information
Use the following procedure to find information on specific topics in the Help 
System.

1. Choose Search for help on... from the Help menu,

or

Choose Search at the top of the Help screen.

The Help topics dialog box appears.

2. Select the Index tab.

3. In the box at the top of the tab, type the first few letters of the word you are 
looking for. The list of topics below will change to reflect what you have typed.

4. Highlight the appropriate topic and press Enter. 

■ If the topic you selected is related to a single help topic, Financial Analyzer 
displays that help topic. 

■ If the topic you select is related to more than one help topic, Financial 
Analyzer displays the Topics Found dialog box.

5. If the Topics Found dialog box is displayed, highlight the appropriate topic and 
press Enter.

6. To return to the help topic that you last viewed, choose Back.
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3
Dimensions and Dimension Values

Chapter summary
This chapter describes dimensions and dimension values.

Who should read this chapter
You need to know the information in this chapter if you are:

■ An administrator who creates and maintains dimensions and dimension values 
for personal use as well as for distribution to users of the shared database that 
you administer

■ A Budget workstation user who creates dimensions and dimension values for 
personal use and uses dimensions and dimension values that have been 
distributed to you

■ An Analyst workstation user who, although unable to create or maintain them, 
wishes to gain a basic understanding of dimensions and dimension values

List of topics
This chapter includes the following topics:

■ About Dimensions and Dimension Values

■ Creating and Modifying Dimensions

■ Suggested Ways to Set Up Dimensions

■ Creating and Modifying Dimension Values
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About Dimensions and Dimension Values

How data is organized
Data is organized in Financial Analyzer using three kinds of data structures:

■ Dimensions

■ Dimension values

■ Financial data items

Financial data items are made up of dimensions, which in turn are made up of 
dimension values. 

Definition: Dimensions
Dimensions are database objects that perform the following functions:

■ They organize the data contained in financial data items

■ They answer the following questions about data: what, when, and where

■ They enable you to select and work with specific subsets of data

Definition: Dimension values
Dimension values are the elements that make up a dimension. 

Example: Dimensions and dimension values
The report in this example contains the following dimensions and dimension 
values:

Dimension Dimension Values

Line Taxes, Benefits, Office Expenses

Organization Eastern Region, Central Region, West Region

Time January 1996



About Dimensions and Dimension Values

Dimensions and Dimension Values 3-3

The report displays information for a financial data item called Actuals.

The following illustration shows how the intersection of the Taxes, Eastern Region 
and January 1996 dimension values points to the financial data item value 5,565,146 
in the database.
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Who can work with dimensions and dimension values?

Administrators
As an administrator, it is your responsibility to maintain the dimensions and 
dimension values that your users access in the shared database that you administer. 
When you create or modify a dimension or dimension value and want other users 
to be able to access it, you must distribute the dimension or dimension value to the 
shared database and to other users. 

Budget workstation users
As a Budget workstation user, you can create and modify dimensions and 
dimension values for personal use. You can modify dimensions and dimension 
values that your administrator has created for you, but you cannot save the 
modifications unless you assign a new name to the modified dimension or 
dimension value, so that you retain the original. Also note that you cannot submit 
data to the shared database if is associated with a dimension or dimension value 
that you have created in your personal database.

Creating and Modifying Dimensions

Creating dimensions
You choose Dimension from the Maintain menu to create a new dimension. This 
opens the Maintain Dimension dialog box. From this starting point you can perform 
the following functions:

■ Enter a name for the dimension. The name is used in reports, graphs, 
worksheets, and data entry forms.

■ Enter an object name. The object name is the internal identifier by which the 
system references the dimension. 

■ Enter an object prefix. 

■ Choose the dimension type. You can choose Text or Time. 

■ Specify the maximum name length for dimension values that are part of this 
dimension.
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Assigning properties and user privileges to dimensions
Once a dimension has a name, object name, object prefix and type, you can specify 
whether the dimension supports the following types of operations: 

■ Aggregation of financial data over time.

■ Whether the dimension supports best case and worst case variance reporting.

■ Whether values for this dimension should be refreshed in each user’s database 
according to the order specified in your (administrator) database.

■ Whether the user can scale data associated with this dimension.

You can also specify the types of users who can create new hierarchies, models, or 
attributes based on this dimension. You can choose DBA, EveryOne, or NoOne.

Important: Base your selections on how the dimension will be used in the system. 
Refer to “Suggested Ways to Set Up Dimensions” on page 3-7 for an overview of 
typical ways in which dimensions are used in Financial Analyzer. 

Example: Dimension information
The following example shows the Maintain Dimension dialog box with information 
for the Product dimension. 
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In this example:

■ The Product dimension maintains the same sort order as the administrator

■ If scaling is supported by the financial data item that the dimension is part of, 
users will be able to scale date values associated with this dimension in reports 

■ All users can create hierarchies and attributes based on this dimension

■ All users can create models using Product as the base dimension

Modifying dimensions
You choose Dimension from the Maintain menu to modify dimensions in your 
personal database. This opens the Maintain Dimension dialog box, from which you 
can perform the following modifications: 

■ You can give a dimension a new name.

■ You can delete a dimension from your personal database. As an administrator, 
you can also delete a dimension from the shared database by deleting it from 
your personal database, and then distributing this change to the shared 
database and to other users.

■ You can modify the properties that have been assigned to a dimension. For 
more information, see “Assigning properties and user privileges to dimensions” 
on page 3-5.

■ You can move a dimension to a new position in the list of dimensions 
maintained by the system.

■ As an administrator, you can change the types of users who can create objects 
based on the dimension. For more information, see “Assigning properties and 
user privileges to dimensions” on page 3-5.

Distributing a deleted dimension
If you delete a dimension, you must distribute the structure with a Delete from 
System action. This deletes the structure from the shared database and from the 
personal databases of all of your users, including any administrators immediately 
below you in the reporting hierarchy. Administrators below you in the reporting 
hierarchy should propagate this change by distributing the deletion to their shared 
database and to the personal databases of their users, and so on down to the leaf 
nodes. If they choose not to do so, they can retain the structure for their own use, 
but they can never submit data associated with the structure into your shared 
database. 
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If you delete and then redefine a dimension
If you delete a dimension and then attempt to define a dimension with the same 
object name before distributing the deletion, the system prompts you to specify 
whether to process the deletion. 

■ If you indicate that the dimension is a new object that is intended to replace the 
deleted object, the system creates a system deletion task on the distribution list.

■ If you indicate that the deletion was inadvertent, the system removes the 
deletion task from the distribution list, but any dimension values remain 
deleted. If you choose this option, it is your responsibility to redefine the 
dimension exactly as it was prior to the deletion. The system will not check for 
this.

Related information
For more information about working with dimensions, search for the following 
topics in the Financial Analyzer Help system:

“Creating Dimensions”
“Modifying Dimensions”
“Moving Dimensions”
“Renaming Dimensions”
“Deleting Dimensions”

Suggested Ways to Set Up Dimensions

Using dimensions in models
When the data associated with a financial data item needs to be calculated, a model 
is defined using one or more of the dimensions that make up the financial data 
item. For example, models might be based on dimensions such as Line Item and 
Account. Dimensions that are used in models typically aggregate over time and do 
not require hierarchies because Financial Analyzer provides a Time hierarchy.

Using dimensions in hierarchies
When the data associated with a financial data item needs to be aggregated into 
higher and lower levels of detail, a hierarchy is defined using one or more of the 
dimensions that make up the financial data item. For example, hierarchies might be 
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based on dimensions such as Organization and Product. Dimensions that are used 
in hierarchies typically do not aggregate over time and are not used in models.

Using dimensions as attributes
When you need to establish a relationship between two dimensions for the purpose 
of selecting values of one dimension by their association with another dimension, 
an attribute can be defined to link them. Typically, the grouping dimension of an 
attribute is not used to dimension any financial data item, does not aggregate over 
time, is not used in a model, and does not require hierarchies. 

Using custom time dimensions
You can set up time periods using either the Standard Time dimension, or you can 
create a custom time dimension. A custom time dimension requires hierarchies to 
build time relationships. 

Suggested properties to assign when creating dimensions
The following table recommends the properties to assign to dimensions used in 
models, hierarchies, attributes, and custom time dimensions. 

Property
 Dimension used 

in model

Dimension 
used in 

hierarchy

Dimension 
used as 
attribute

Custom time 
dimension

Dimension 
Type

Text Text Text Time

Dimension 
Options

■ Time 
Aggregations

■ B/W Variance 
Indicators

■ Maintain DBA 
Sort Order

■ Control 
Dimension 
Value Scaling

Maintain DBA 
Sort Order

Maintain DBA 
Sort Order

Maintain DBA 
Sort Order

Users Who 
Can Define 
Hierarchies

■ DBA

■ EveryOne

■ NoOne

■ DBA

■ EveryOne

NoOne ■ DBA

■ EveryOne
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Creating and Modifying Dimension Values

Creating dimension values
You choose Dimension Value from the Maintain menu to create a new dimension 
value. This opens the Maintain Dimension Value dialog box, where you choose the 
dimension for which you want to create the dimension value. From this starting 
point you can perform the following functions:

■ Enter a name for the dimension value. 

■ Enter a dimension value name. The dimension value name is the internal 
identifier for by which the system references the dimension value.

■ Specify the text for row and column labels. 

■ For a dimension value in a custom time dimension, select the time period. You 
can choose Month, Quarter, Year, or Year-to-Date. 

■ For a dimension value in a model dimension that supports aggregation, select 
an aggregation type for rolling up the data associated with the dimension value. 
You can choose one of the following:

■ Add month into quarters — Data for each month is added into quarterly 
totals. Used for line items on income statements.

■ First month only into quarter — Only the first month of the quarter is used 
in quarterly totals, or only the first month of the year is used in yearly 
totals. Used for line items on cash flow statements.

■ Last month only into quarter — Only the last month of the quarter is used 
in quarterly totals, or only the last month of the year is used in yearly totals. 
Used for line items on balance sheets.

Users Who 
Can Define 
Models

■ DBA

■ EveryOne

NoOne NoOne NoOne

Users Who 
Can Define 
Attributes

■ DBA

■ EveryOne

■ NoOne

■ DBA

■ EveryOne

■ DBA

■ EveryOne

NoOne

Property
 Dimension used 

in model

Dimension 
used in 

hierarchy

Dimension 
used as 
attribute

Custom time 
dimension
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■ Average months into quarter — Values are averaged over the quarter or 
over the year. Used for line items such as Head Count.

■ Average across time and org — Values are averaged over all organizations 
and over the quarter of the year. Used for line items such as Unit Price.

■ Recalculate quarter — Values are recalculated at the end of the quarter or 
year, using the line item equation. Used for line items such as Return on 
Sales, which represents a ratio.

■ Do not aggregate — Values for or dimension values marked with this 
aggregation type are removed from status before any rollups or worksheet 
spread operations are performed.

■ For a dimension value in a dimension that supports best case and worst case 
variance reporting, specify the variance to use when displaying a financial data 
item involving a variance. You can choose ACT - BUD or BUD - ACT. 

■ For a dimension value in a dimension for which the Control Dimension Value 
Scaling property was selected when the dimension was created, you can disable 
numeric scaling.

Note: If you are creating a new dimension value that is similar to a saved dimension 
value, you can save time by copying information for row and column labels, time 
period, aggregation type, variance, and scaling from the saved value to the new 
value. Choose Copy in the New Dimension Value dialog box to copy dimension 
value information. 
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Example: Dimension value information
The following example shows the Maintain Dimension value dialog box with 
information for a Product dimension value. 

In this example:

■ The dimension name is 110- Sentinel Standard

■ The row label is Sentinel Standard

■ The column label is Sent Std

■ Aggregation Type is not applicable because the Product dimension does not 
aggregate over time

■ Variance Type is not applicable because the Product dimension does not 
support best and worse case variance indicators

■ Users can apply numeric scaling to this dimension value
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Modifying dimension values
You choose Dimension Value from the Maintain menu to modify dimension values. 
This opens the Maintain Dimension Value dialog box, from which you can choose 
the dimension and the dimension value and perform the following modifications: 

■ You can give a dimension value a new name.

■ You can delete a dimension value from your personal database. As an 
administrator, you can also delete a dimension value from the shared database 
by deleting it from your personal database, and then distributing the change to 
the shared database and to other users.

■ Edit row and column labels.

■ You can move a dimension to a new position in the list of dimension values 
maintained by the system.

■ For a dimension value in a custom time dimension, you can change the time 
period. 

■ For a dimension value in a dimension that supports aggregation over time, you 
can change the aggregation type.

■ For a dimension value in a dimension that supports best case and worst case 
variance reporting, you can change the variance type.

■ For a dimension value in a dimension for which the Control Dimension Value 
Scaling option was selected when the dimension was created, you can disable 
numeric scaling.

If you delete and then redefine a dimension value
If you delete a dimension value and then attempt to define a dimension value with 
the same object name before distributing the deletion, the system prompts you to 
specify whether to process the deletion. 

■ If you indicate that the dimension value is a new object that is intended to 
replace the deleted object, the system creates a system deletion task on the 
distribution list.

■ If you indicate that the deletion was inadvertent, the system removes the 
deletion task from the distribution list. If you choose this option, it is your 
responsibility to redefine the dimension value exactly as it was prior to the 
deletion. The system will not check for this.
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Related information
For more information about working with dimension values, search for the 
following topics in the Financial Analyzer Help system:

“Creating Dimension Values”
“Modifying Dimension Values”
“Moving Dimension Values”
“Renaming Dimension Values”
“Deleting Dimension Values”
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4
Financial Data Items

Chapter summary
This chapter describes how to create and maintain financial data items. 

Who should read this chapter
You need to know the information in this chapter if you are one of the following:

■ An administrator who creates financial data items for personal use and for 
distribution to users of the shared database that you administer

■ A Budget workstation user who creates financial data items for personal use 
and uses financial data items that have been distributed to you

■ An Analyst workstation user who, although unable to create or maintain 
financial data items, wishes to gain a basic understanding of financial data 
items

List of topics
This chapter includes the following topics:

■ About Financial Data Items

■ Creating Financial Data Items

■ Specifying How Sparse Data is Handled in Financial Data Items

■ Specifying Dimension Order for Financial Data Items

■ Modifying Financial Data Items

■ Copying Data in Financial Data Items
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About Financial Data Items

Definition: Financial data items
Financial data items are database objects that are used to store or calculate financial 
data values. There are two types of financial data items:

■ Stored financial data items, which are used to store values

■ Formula financial data items, which are used to calculate values

Stored financial data items
A stored financial data item can accept data in the following ways:

■ You can enter the data manually using a worksheet or a data entry form

■ You can enter the data using a data loading program

■ You can copy the data into one financial data item from another financial data 
item

Formula financial data items
A formula financial data item contains a formula that calculates values based on the 
values of one or more stored financial data items. For example, you might create a 
formula financial data item called Budget Variance whose values reflect the 
difference between two stored financial data items, Actuals and Budget. 

The values of a formula financial data item are calculated and displayed in a report 
or graph that includes the financial data item. Because the values are based on 
another financial data item, whose values may change, the values of a formula 
financial data item are not permanently stored in the system. They are calculated 
based on their associated stored financial data items.

Types of formula financial data items 
There are two types of formula financial data items: 

■ Formula Manual — The value of the financial data item is dynamically 
calculated using a formula in which the data’s dimensionality is specified by 
the user
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■ Formula Automatic — The financial data item’s value is dynamically calculated 
using a formula in which the data’s dimensionality is automatically determined 
from a stored financial data item

Who can work with financial data items?

Administrators
As an administrator, it is your responsibility to maintain the financial data items 
that your users access in the shared database that you administer. When you create 
or modify a financial data item and want other users to be able to access it, you 
must distribute the financial data item to the shared database and to other users. 

Budget workstation users
As a Budget workstation user, you can create and modify financial data items for 
personal use. You can modify financial data items that your administrator has 
created for you, but you cannot save the modifications unless you assign a new 
name to the modified financial data item and retain the original. Also note that you 
cannot submit data to the shared database if it is associated with a financial data 
item that you have created in your personal database.

Creating Financial Data Items

Adding financial data items 
You choose Financial Data Item from the Maintain menu to create a new financial 
data item. This opens the Financial Data Item dialog box. From this starting point 
you can perform the following functions:

■ Name the financial data item.

■ Specify the data type for the financial data item. You can choose Integer, 
Shortinteger Decimal, Shortdecimal, or Text.

■ Specify the type of financial data item. You can choose Stored, Formula 
Manual, or Formula Automatic. 

■ For a stored or Formula Manual financial data item, specify the order of the 
dimensions. For more information, see “Specifying Dimension Order for 
Financial Data Items” on page 4-10.



Creating Financial Data Items

4-4 Oracle Financial Analyzer User’s Guide

■ For a formula data item, enter the formula. For more information, see 
“Examples: Formula financial data items” on page 4-5.

■ For a stored financial data item for which data is sparse, you can specify how to 
handle sparse data. For more information, see “Specifying How Sparse Data is 
Handled in Financial Data Items” on page 4-9.

■ Enable or disable numeric scaling.

■ Specify the text for row and column labels.

■ If you are an administrator, you can also perform the following tasks:

■ Specify if the data associated with the financial data item will be available 
for distribution to users.

■ Associate a solve definition or group solve definition with the financial data 
item. For more information, see “Associating solve definitions with 
financial data items” on page 9-9.

Example: Stored financial data item
The following example shows the Maintain Financial Data Item dialog box with 
information for a stored financial data item, Actuals.
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Examples: Formula financial data items

Example 1: Budget variance financial data item
The following example illustrates a formula financial data item that calculates the 
variance between a financial data item called Budget and a financial data item 
called Actuals. Both of these financial data items are dimensioned by Time, Line 
and Organization.

The formula, located in the Formula box, is:

 (act-bud)*line.bw

where:

■ act is the object name of the financial data item Actuals.

■ bud is the object name of the financial data item Budget.

■ line.bw specifies the Line dimension, which includes a B/W Variance 
Indicator. When you create a dimension that includes support for a B/W 
Variance Indicator, a .BW object is created in the database. 
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Using line.bw in the formula allows the signage of the variance to be correctly 
displayed.
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The Budvar financial data item would appear in a report, as shown following. The 
negative variance that results from using line.bw in the formula is displayed in 
parentheses.

Example 2: Calculating line item as a percentage of revenue
The following example illustrates a formula financial data item that calculates every 
Line Item as a percentage of the Revenue Line Item for the financial data item 
Actuals for every Time and Organization.

The formula, located in the Formula box, is:

act/act(line’A4000’)*100

where:

■ act is the object name for the financial data item Actuals

■ line is the internal identifier representing the Line dimension

■ A4000 is the internal identifier representing the Revenue line item
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Thus, act (line’A4000’) represents the Revenue line item for every dimension that 
makes up the Actual financial data item. 
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The following report shows the results of this calculation.

Related information
For more information on creating financial data items, see the following topic in the 
Financial Analyzer Help system: “Creating Financial Data Items.”

Specifying How Sparse Data is Handled in Financial Data Items

Definition: Sparse data
Sparse data occurs when many data cells in a financial data item contain NA values. 
For example, if a financial data item contains information that is dimensioned by 
Product and Market, it is likely that the data will be sparse because not all products 
are sold in all markets.
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Methods for specifying how sparse data is handled
There are two methods for specifying how sparse data is handled in a Financial 
Analyzer database:

■ Sparsity Wizard — An automated utility that leads you through the process of 
defining sparsity according to a predefined set of “best practice” guidelines. 
The Sparsity Wizard is particularly useful if you are working with a composite 
dimension, which combines the values of two or more dimensions. 

■ Advanced method — Displays the dimensions in the financial data item and 
enables you to designate a dimension as sparse. 

When you choose Sparsity in the Maintain Financial Data Item dialog box, you are 
prompted to choose the method that you want to use.

Note: If you are not an experienced user, Oracle Corporation recommends that you 
use the Sparsity Wizard. If you select a dimension for sparse data handling that is 
not actually sparse, you may experience increased data access time and decreased 
data processing performance. 

Specifying Dimension Order for Financial Data Items

Importance of dimension order for financial data items
When you create a stored financial data item, you must pay attention to the order in 
which you select the dimensions that comprise the financial data item. The 
dimension order determines how data is stored in Financial Analyzer, which in turn 
affects performance and storage in the Financial Analyzer database. 

Recommendations for dimension order for financial data items
The order that you specify for the dimensions in your financial data items should 
depend on whether the data in the financial data item is dense or sparse.

Dimension order recommendation for dense data
When data is dense, the Time dimension should be the last dimension in the 
financial data item definition.
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Dimension order recommendations for sparse data
When data is sparse, Oracle Corporation recommends that you follow these 
guidelines:

■ You must have at least one dense dimension.

■ Place dense dimensions first in the financial data item’s definition.

■ The Time dimension should always be a dense dimension.

■ If you have more than one dense dimension (one of them being Time), the Time 
dimension can either be the last of the dense dimensions or the last of all 
dimensions. 

■ If you will be consistently processing one period’s data at a time for a 
financial data item, placing the Time dimension last may improve load and 
solve performance. 

■ If you will be consistently processing a time series, placing the Time 
dimension last of the dense dimensions may improve load and solve 
performance.

■ Dimensions identified as sparse should be ordered according to their number of 
dimension values, with dimensions with more values coming before those with 
less. For example, if a financial data item has four dimensions: Account 
Organization, Product, and Time, and the relationship between Account, 
Organization, and Product is sparse, then the order of the dimensions should 
be:

<Time <Account Organization Product>>

where Account, Organization, and Product are in the composite.

If a financial data item has four dimensions: Account, Organization, Product, 
and Time, and only the relationship between Organization and Product is 
sparse, then the order of the dimensions could be:

<Account Time <Organization Product>>

where Organization and Product are in the composite. Also, one period’s data is 
typically loaded and solved at once.

Alternatively, the order of the dimensions could be

<Account <Organization Product> Time>

where Organization and Product are in the composite. Also, one period’s data is 
typically loaded and solved at once.
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Modifying Financial Data Items

About modifying financial data items
You choose Financial Data Item from the Maintain menu to modify financial data 
items in your personal database. This opens the Maintain Financial Data Item 
dialog box, from which you can perform the following functions: 

■ You can give a financial data item a new name.

■ You can delete a financial data item from your personal database. As an 
administrator, you can also delete a financial data item from the shared 
database by deleting it from your personal database, and then distributing this 
change to the shared database. For more information, see “Distributing a 
deleted financial data item” on page 4-15.

■ You can specify that a financial data item is sparse, or change the way in which 
sparse data is handled for a financial data item. For more information, see 
“Modifying how sparse data is handled in financial data items” on page 4-12.

■ You can modify the formula for a formula financial data item. 

■ As an administrator, you can associate a financial data item in the shared 
database with a solve definition or a group solve definition. This enables the 
solve or group solve to run automatically when users modify data for the 
financial data item in the shared database. For more information, see 
“Associating solve definitions with financial data items” on page 9-9.

■ As an administrator, you can change the setting for distributing data for the 
financial data item.

■ You can move a financial data item to a new position in the list of financial data 
items maintained by the system.

■ Edit row and column labels.

Modifying how sparse data is handled in financial data items

When to modify sparse data handling for financial data items
Changing the way sparse data is handled can have a dramatic impact on the 
performance of your database. Oracle recommends that you modify sparse data 
handling after careful analysis of the dimensions and financial data in your 
database.
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Reasons to change the way sparse data is handled on your system include the 
following:

■ You want to reduce the amount of storage required for your database

■ You want to improve data access time

■ You want to improve data processing performance

Example: When to modify sparse data handling for financial data items
In this example:

■ The financial data item called Budget is dimensioned by Time, Line, Product 
and Organization.

■ All Organizations have non-product specific data, but only the Sales 
Organization has data for every product. Therefore, the data is sparse in the 
Organization and Product dimensions.

The following report shows the Budget financial data item. Note the number of 
NAs, indicating sparse data. 

Note: When you modify sparsity, reports and worksheets do not change; your NA 
values still appear. This report is shown to demonstrate the concept of a sparsely 
populated dimension.
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If the financial data item in this example was created without changing how 
sparsity is handled, all of the NA values would be stored in the database, as shown 
in the following illustration.
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If, however, the dimensions Product and Organization were defined as sparse 
dimensions when the financial data item was created, the NA values would not be 
stored, as shown in the following illustration.

In this example, you would want to modify sparsity handling so that Product and 
Organization are sparse dimensions.

Distributing a financial data item for which sparse data handling has been 
modified
If you distribute a financial data item for which sparse data handling has been 
modified, it may take some time to process because the data within the financial 
data item has to be reassigned in the database.

Distributing a deleted financial data item
If you delete a financial data item, you must distribute the structure with a Delete 
from System action. This deletes the structure from the shared database and from 
the personal databases of all of your users, including any administrators 
immediately below you in the reporting hierarchy. Administrators below you in the 
reporting hierarchy should propagate this change by distributing the deletion to 
their shared database and to the personal databases of their users, and so on down 
to the leaf nodes. If they choose not to do so, they can retain the structure for their 
own use, but they can never submit data associated with the structure into your 
shared database. 
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If you delete and then redefine a financial data item
If you delete a financial data item and then attempt to define a financial data item 
with the same object name before distributing the deletion, the system prompts you 
to specify whether to process the deletion.

■ If you indicate that the dimension is a new object that is intended to replace the 
deleted object, the system creates a system deletion task on the distribution list.

■ If you indicate that the deletion was inadvertent, the system removes the 
deletion task from the distribution list. If you choose this option, it is your 
responsibility to redefine the financial data item exactly as it was prior to the 
deletion. The system will not check for this.

Related information
For more information about maintaining financial data items, search for the 
following topics in the Financial Analyzer Help system:

“Deleting Financial Data Items”
“Deleting Structures from the System”
“Editing Formulas Used to Calculate Financial Data Items”
“Moving Financial Data Items”
“Renaming Financial Data Items”
“Setting Sparsity”

Copying Data in Financial Data Items

About the Copy Data feature
The copy data feature enables you to copy data from one financial data item to 
another. You can use the copy data process as a mechanism for moving data from 
one financial data item to another, or you can make use of a set of options that allow 
you to modify the data in addition to copying it.

You can use Financial Analyzer's copy data feature to perform the following types 
of tasks:

■ Restructuring the data in your database

■ Rolling up data from one time period to another

■ Increasing the values in a slice of data by a percentage or absolute amount

■ Setting a slice of data to NA, thereby effectively deleting it
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■ Creating a new budget based on the previous year’s budget data

■ Updating a budget to reflect a change in allocations

■ Generating multiple what-if scenarios from a single source

Who can use the copy data feature?

Administrators
An administrator can copy data within his or her personal database, or between the 
personal database and the shared database. 

The Operational Mode in the Options dialog box indicates how the data is copied. If 
the Operational Mode is set to Administrator, data is copied within the 
administrator’s personal database. If the Operational Mode is set to Workstation, 
data is submitted to the Task Processor and copied within the administrator’s 
shared database.

Budget workstation users
Users of Budget workstations can copy data only within their personal database. 

Using the Copy Data Feature
You choose Copy Data from the Tools menu to copy data. This opens the Copy Data 
dialog box, where you specify the source financial data item and the target financial 
data item and select the dimension values that you want to copy.

In some cases, the source and target items are different. For example, when you are 
populating a new financial data item with data from an existing item, the source 
and target are different. In other cases, the source and target items are the same, 
such as when you are altering the data within a single financial data item.

Note that you can increase or decrease the data by a specific amount or percentage 
when it is copied from the source to the target. Alternatively (when the source and 
target are the same), you can set the data values to N/A, effectively deleting the 
data from the financial data item.
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Example: Using the copy data feature
The following illustration shows the Copy Data dialog box with specifications to 
copy data from the Budget financial data item for one time period to the Budget 
financial data item for another time period, with an increase of 5%.

Using copy data profiles
If you periodically copy the same data, you can save the information as a copy data 
profile. A copy data profile captures the selection information in the Copy Data 
dialog box and saves it for reuse. You can apply the saved profile at a later time — 
either exactly as is, or as a template for copying similar data. 

To name and save a copy data profile, define the data slice to copy and choose Save 
Profile in the Copy Data dialog box. To retrieve a list of saved profiles, choose 
Profiles.
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Related information
For more information about using the Copy Data feature, search for the following 
topics in the Financial Analyzer Help system:

“Creating a Copy Data Profile”
“Modifying Data in Financial Data Items”
“Setting Data to NA”
“Using a Copy Data Profile”



Copying Data in Financial Data Items

4-20 Oracle Financial Analyzer User’s Guide



Hierarchies 5-1

5
Hierarchies

Chapter summary
This chapter describes how you can create and use hierarchies in the Financial 
Analyzer environment.

Who should read this chapter
You need to know the information in this chapter if you are:

■ An administrator who creates hierarchies for personal use and for distribution 
to users in the shared database that you administer

■ A Budget workstation user who creates hierarchies for personal use and uses 
hierarchies that have been distributed to you 

■ An Analyst workstation user who, although unable to create or maintain them, 
wishes to gain a basic understanding hierarchies

List of topics
This chapter includes the following topics:

■ About Hierarchies

■ Hierarchy Structures

■ Creating and Modifying Hierarchies
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About Hierarchies

Definition: Hierarchies
Hierarchies are tree-like organizational structures that you can use to relate the 
values of dimensions in your database. Hierarchies enable the data associated with 
dimension values to be aggregated at various levels along the structure. Dimensions 
that are associated with hierarchies in this way are called embedded total dimensions 
because the levels of aggregation are embedded in the dimension’s values. 
Typically, these dimensions include Time, Product, and Organization, but you can 
define hierarchies for any dimension in your system.

For more information about dimensions and dimension values, refer to Chapter 3.

Who can work with hierarchies?

Administrators
As an administrator, it is your responsibility to maintain the hierarchies that your 
users access in the shared database that you administer. When you create or modify 
a hierarchy and want other users to be able to access it, you must distribute the 
hierarchy to the shared database and to other users. 

Budget workstation users
As a Budget workstation user, you can create and modify hierarchies for your own 
personal use. You can modify hierarchies that your administrator has created for 
you, but you cannot save the modifications unless you assign a new name to the 
modified hierarchy, retaining the original.

Hierarchy Structures

Typical hierarchy structure
A typical hierarchy is organized in a tree-like structure with one value at the top of 
the tree and multiple values branching out from the top. 
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The following illustration shows a typical hierarchy.

Parent and child values
The relationships between the various values are referred to as though they were 
part of a family tree. Each dimension value in a hierarchy (except the top-most 
value) has a parent value, which is the value directly above it in the structure. The 
dimension values directly below a parent are called its children. 

Sibling values
Each parent value can have any number of children. Dimension values that have 
the same parent are called siblings.
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The following illustration shows siblings in a hierarchy.

Descendant and ancestor values
Each child value can also have children of its own, and so on. Multiple levels of 
dimension values that roll up to a common value are called descendants of that 
value, and the value itself is known as the ancestor of the descendent values.
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Leaf values
In a hierarchy, any dimension value that has no children is called a leaf dimension 
value.

Leaf dimension values are the only dimension values for which you can input data 
for a hierarchy. The data for each non-leaf dimension value is consolidated from its 
children.

Example: Hierarchy structure
This example illustrates a sample hierarchy for the Organization dimension for a 
fictitious company, US Global Computers. In this diagram:

■ All of the divisions (East, Central, West) at the bottom of the hierarchy are leaf 
organizations, as are the values Support and Training.

■ Data for the Support, Consulting and Training divisions will roll up into Sales 
data, and Resource, Manufacturing, Sales, and Finance data will roll up into 
corporate data for US Global Computers.
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The following diagram illustrates a sample hierarchy that is based on the 
Organization dimension.

Using dimension values in multiple hierarchies
Financial Analyzer supports multiple hierarchies. This means that you can specify 
any number of hierarchies for rolling up data. For example, you might want to 
define separate hierarchies for examining management and functional data. 

In most hierarchies, any dimension value that is not the top-most can have only one 
parent. However, if that dimension value belongs to more than one hierarchy, it can 
have a different parent in each hierarchy. 

Example: Using dimension values in multiple hierarchies
In this example, there are two hierarchies, each representing a different type of 
computer system.

■ The Sentinel Standard hierarchy contains the dimension values Monitor and 
System Software
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■ The Sentinel Multimedia hierarchy contains the dimension value Fax/Modem, 
as well as Monitor and System Software

In the Selector, these would appear as separate product hierarchies that you can 
choose from to use in a report or worksheet:

Multiple top-level parents in the same hierarchy
You can create a hierarchy that has more than one top-level parent. Specifying a 
hierarchy with more than one top-level value can be useful when working with 
time-related dimensions. 
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Example: Multiple top-level parents in the same hierarchy
In this example, 1999 and 2000 are top level parents in the Application Time 
hierarchy. 
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In the Selector, 1999 and 2000 appear as top level parents in the Application Time 
hierarchy. Notice that these values are siblings, and there are no higher level values 
in the hierarchy.

Creating and Modifying Hierarchies

Creating hierarchies
You choose Hierarchy from the Maintain menu to create a new hierarchy. This 
opens the Maintain Hierarchy dialog box. From this starting point you can perform 
the following functions:

■ Enter a name for the hierarchy. The name is the external identifier for the 
hierarchy.

■ Enter the base dimension for the hierarchy. The object name is the internal 
identifier for the hierarchy. 

■ Choose the dimension values that comprise the hierarchy.

■ Specify the position of each dimension value within the hierarchy.
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Example: Hierarchy information
The following example shows the Maintain Hierarchy dialog box with information 
for a Product hierarchy.

Modifying hierarchies
You choose Hierarchy from the Maintain menu to modify hierarchies. This opens 
the Maintain Hierarchy dialog box, from which you can perform the following 
maintenance functions: 

■ You can edit a hierarchy by adding dimension values or removing dimension 
values.

■  You can give a hierarchy a new name.

■ You can move a hierarchy to a new position in the list of hierarchies maintained 
by the system.

■ You can delete a hierarchy from your personal database. As an administrator, 
you can also delete a hierarchy from the shared database by deleting it from 
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your personal database, and then distributing this change to the shared 
database.

Related information
For more information about working with hierarchies, refer to the following topics 
in the Financial Analyzer Help system:

“Creating Hierarchies.”
“Deleting Hierarchies”
“Editing Hierarchies”
“Moving Hierarchies”
“Renaming Hierarchies”
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6
Attributes

Chapter summary
This chapter describes how to create and work with attributes.

Who should read this chapter
You need to know the information in this chapter if you are:

■ An Administrator who creates attributes for personal use and for distribution to 
other users of the shared database that you administer

■ A Budget workstation user who creates attributes for personal use and uses 
attributes that have been distributed to you

■ An Analyst workstation user who, although unable to create or maintain them, 
wishes to gain a basic understanding of attributes

List of topics
This chapter includes the following topics:

■ About Attributes

■ Attribute Types

■ Creating and Modifying Attributes
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About Attributes

Definition: Attributes
 Attributes establish relationships between the values of two dimensions in such a 
way that the values of one dimension (a grouping dimension) can be used to group 
multiple values of the other dimension (a base dimension). Each value of the 
grouping dimension serves as a characteristic, or attribute, that applies to multiple 
values of the base dimension. 

Using attributes
Attributes facilitate the process of selecting data for documents. When selecting 
data by attribute, you can choose any number of values of the base dimension by 
specifying a single value of the grouping dimension. This eliminates the need to 
specify each value of the base dimension in a separate operation.

Grouping options 
You can create attributes that group related data in many different ways, such as by 
product type, by time period, or even by user. For example, an administrator could 
create an attribute called BudgetWest that includes all Budget workstation users in 
the West division. The administrator could then distribute data specific to Budget 
Workstation users in the West division, without having to select them all 
individually.

Who can work with attributes?

Administrators
As an administrator, it is your responsibility to maintain the attributes that your 
users access in the shared database that you administer. When you create or modify 
an attribute and want other users to be able to access it, you must distribute the 
attribute to the shared database and to other users. 

Budget workstation users
As a Budget workstation user, you can create and modify attributes for your 
personal use. You can modify attributes that your administrator has created for you, 
but you cannot save the modifications unless you assign a new name to the 
modified attribute, retaining the original.
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Attribute Types

Overview
Financial Analyzer supports two types of attributes:

■ One-to-many — A relationship where multiple values of a base dimension are 
related to a single value of a grouping dimension.

■ Many-to-many — A relationship where multiple values of a base dimension are 
related to multiple values of a grouping dimension.

One-to-many attributes
 One-to-many attributes:

■ Establish a relationship between the values of two dimensions where each value 
of a grouping dimension is related to multiple values of a base dimension.

■ Simplify the process of selecting data by enabling you to specify a single value 
of the grouping dimension to select many values of the base dimension. 

Example: One-to-many attribute
In this example:

■ Products are either workstations or components.

■ The grouping dimension is Unit Type.

■ The grouping dimension value Workstation is related to the base dimension 
values Sentinel Standard and Envoy Standard.

■ The grouping dimension value Component is linked to the base dimension 
values Monitor and Modem/Fax.
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You can select a subset of Product by specifying either Workstation or Component.

Many-to-many attributes
Many-to-many attributes: 

■ Establish a relationship between the values of two dimensions where multiple 
values of a grouping dimension are related to multiple values of a base 
dimension.

■ Simplify the process of selecting data by enabling you to specify a single value 
of the grouping dimension to select many values of the base dimension. 

■ Provide an additional feature for refining your data selection; because the base 
dimension values can be linked to multiple values of the grouping dimension, 
the grouping dimension values provide a context for selecting data.

Example: Many-to-many attribute
In this example:

■ Products are displayed, along with possible types of monitors available for 
each.

■ The grouping dimension is Monitor Type Availability.

■ The grouping dimension value VGA is linked to Sentinel Standard, Sentinel 
Multimedia, and Envoy Standard. 

■ The grouping dimension value Super VGA is linked to Sentinel Financial, 
Sentinel Multimedia, and Envoy Standard.
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■ The Products Sentinel Multimedia and Envoy Standard are related to both types 
of Monitor Availability because they are available with either VGA or Super 
VGA monitors.

You can select the value Sentinel Multimedia in terms of the context in which you 
want to view or analyze it: as part of your VGA workstations, or as part of your 
Super VGA workstations.

Creating and Modifying Attributes

Creating attributes
You choose Attribute from the Maintain menu to create an attribute. This opens the 
Maintain Attribute dialog box. From this starting point, you can perform the 
following functions:

■ Name the attribute.

■ Specify the attribute type. You can choose One-to-Many or Many-to-Many.

■ Select the dimension whose values are to form the basis of the attribute.

■ For a one-to -many attribute, select the grouping dimension for the attribute. 
This is the dimension whose values you want to associate with the base 
dimension. 

■ For a many-to-many attribute, select the second dimension for the attribute.
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When you choose OK, the Edit Attribute dialog box appears. Here, you select 
dimension values for the dimensions in the attribute definition. You also set the 
relationships between the dimension values.

■ For a one-to-many attribute, you set the relationships between the selected 
aggregate and base dimension values.

■ For a many-to-many attribute, you set the relationships between the value of 
the first dimension and the value of the second dimension. 

Example: Relationships for one-to-many attribute
The following illustration shows an example of the Edit Attribute dialog box with 
information for a one-to-many attribute, Product by Unit Type. 
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Example: Relationships for many-to-many attribute
The following illustration shows an example of the Edit Attribute dialog box with 
information for a many-to-many attribute, Product by Monitor Type Availability. 

Modifying attributes
You choose Attributes from the Maintain menu to modify information for 
attributes. This opens the Maintain Attributes dialog box, from which you can 
perform the following functions:

■ You can give an attribute a new name.

■ You can delete an attribute from your personal database. As an administrator, 
you can also delete an attribute from the shared database by deleting it from 
your personal database, and then distributing this change to the shared 
database.

■ You can move an attribute to a new position in the list of attributes maintained 
by the system.

■ You can edit the links between dimension values.
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Related information
For more information about working with attributes, search for the following topics 
in the Financial Analyzer Help system:

“Creating a Many-to-Many Attribute”
“Creating a One-to-Many Attribute”
“Deleting Attributes”
“Editing Many-to-Many Attributes”
“Editing a One-to-Many Attributes”
“Renaming Attributes”
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7
Selecting Data

Chapter summary
This chapter describes how to select dimension values.

Who should read this chapter
All Financial Analyzer users should read this chapter.

List of topics
This chapter includes the following topics:

■ About Data Selection

■ Selecting Values

About Data Selection

Definition: Selector
The ability to select the precise information that you want to work with is a key 
feature of Financial Analyzer. A data selection tool, referred to as the Selector, 
supports the data selection function. The Selector: 

■ Gives you flexible access to your data and to database objects that you use in 
Financial Analyzer.

■ Provides a set of tools that enable you to easily select groups of related data.
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Accessing the Selector 
You can access the Selector from a tile that appears in a document window or dialog 
box. While working in a document, you can also access the Selector from the Tools 
menu or from the toolbar. 

Accessing the Selector from the toolbar
While working in a document, you can choose Selector from the Tools menu or 
choose the Select button from the toolbar.

Accessing the Selector from a tile in a document window
You can access the Selector from a tile in a document window. In the following 
illustration, the report window contains a dimension tile labeled Organization. 
Choosing Organization opens the Selector dialog box, where you can select 
dimension values for Organization as well as for the other dimensions in the report.
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Accessing the Selector from a tile in a dialog box
You can access the Selector from a dimension tile in a dialog box. In the following 
illustration, the Copy Data dialog box includes a dimension tile labeled Time. 
Choosing Time opens the Selector dialog box, where you can select dimension 
values for Time as well as for the other dimensions for which data is to be copied. 

Selecting Values

Selectable objects
Depending on your current context when you access the Selector dialog box, you 
can select:

■ Values for one or more dimensions

■ Dimension values associated with one or more financial data items

■ Dimension values associated with one or more hierarchies
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Moving values to the Selected box
When you work in the Selector dialog box, you place the values that you want to 
work with into the Selected box. 

In the following illustration, three values for the Product dimension have been 
placed in the Selected box.

Methods for selecting values
In the Selector dialog box you can manually select values. You can also access a set 
of selection tools that enable you to do the following: 

■ Select all values of a dimension

■ Select values that match an attribute that you specify

■ Select values based on their hierarchical relationship

■ Select values that match characters that you specify

■ Select values that meet specific numerical exception criteria that you specify

■ Select values that meet specific variable exception criteria that you specify
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■ Select values within a top and bottom range that you specify

■ Select values and then name and save that selection for future use

Selecting hierarchical values
If the dimension for which you are selecting values is part of one or more 
hierarchies and you want to display the values as they relate to a hierarchy, you 
must select the hierarchy from the Hierarchy box before selecting values. Selecting a 
hierarchy enables you to drill through levels of data in reports and worksheets.

Maximum amount of selectable values
When selecting values to include in a document, you cannot select more than 5000 
values for an across or down edge.

Sorting selected values
You can sort the values that you have selected. Depending on the dimension for 
which you are selecting values, the following sort options are available:

■ Alphabet — Sorts values in alphabetical order. You can choose A to Z or Z to A.

■ Database — Sorts values according to the order in which they are stored in the 
database. You can choose standard or reverse.

■ Data Value — Sorts values according to their numeric value. You can choose 
high to low or low to high.

■ Drag and drop — Enables you to manually arrange values in any order.

■ Hierarchy — For a dimension that is organized by a hierarchy, sorts values 
according to their order in the hierarchy. You can choose top to bottom or 
bottom to top.

Related information
For more information about selecting data, search for the following topics in the 
Financial Analyzer Help system: 

“Selecting All Values of a Dimension”
“Selecting Values by Matching Characters”
“Selecting Top and Bottom Values”
“Selecting Values by Attribute”
“Selecting Values by Specifying Numerical Exception Criteria”
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“Selecting Values by Specifying Variable Exception Criteria”
“Selecting Values Manually”
“Sorting Selected Values”
“Sorting Selected Values According to Their Order in the Database”
“Sorting Selected Values Alphabetically”
“Sorting Selected Values Manually”
“Sorting Selected Values Numerically by Data Value”



Modeling Data 8-1

8
Modeling Data

Chapter summary
This chapter describes how to create and use models.

Who should read this chapter
You need to know the information in this chapter if you are:

■ An Administrator who creates and maintains models for personal use and for 
distribution to other users of the shared database that you administer

■ A Budget workstation user who creates and maintains models for personal use 
and uses models that have been distributed to you

■ An Analyst workstation user who needs a basic understanding of models and 
their uses

List of topics
This chapter includes the following topics:

■ About Models

■ Creating and Modifying Models

■ Model Equation Syntax

■ Modeling Functions

■ Examples of Models
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About Models

Definition: Models
Models are sets of up to 8,000 interrelated equations that can be used to calculate 
new data values. They can also be used in worksheets for performing what-if 
analyses. Models are: 

■ Database objects that you create and maintain

■ Separate from the financial data items whose data they calculate

To use a model to calculate new data for a financial data item, you include the 
model in a solve definition, and associate the solve definition with a financial data 
item. You then run the solve definition to calculate the data. The same model can be 
used to calculate data for multiple financial data items, as long as they have the 
same dimensions.

Using models to manage financial data
Financial Analyzer models can be used to manage a wide range of financial data 
issues including:

■ Simple relationships between dimension values

■ Complex reference calls involving data stored in separate data cubes

■ Simultaneous equations where the sequence of multiple calculations is essential 
to deriving the desired results 

Who can work with models?

Administrators
As an administrator, it is your responsibility to maintain the models that your users 
access in the shared database that you administer. When you create or modify a 
model and want other users to be able to access it, you must distribute the model to 
the shared database and to other users. Typically, administrators create and 
distribute the basic line item models for their groups.

Budget workstation users
As a Budget workstation user, you can create and modify models for your own 
personal use. You can modify models that your administrator has created for you, 
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but you cannot save the modifications unless you assign a new name to the 
modified model, retaining the original.

Creating and Modifying Models

Creating models
You choose Model from the Maintain menu to create a new model. This opens the 
Maintain Model dialog box where you can define a model. You can create an 
entirely new model, or you can create a model based on an existing model.

Process for creating models
Follow these general steps to create a model.

1. Create and name the database object that stores the model definition.

2. Specify the financial data item or items whose data the model will calculate.

3. Define equations and associate them with the values of the financial data item’s 
dimensions. For more information, see “Model Equation Syntax” on page 8-5.

4. If necessary, specify model options that determine the processing order for 
simultaneous equations. For more information, see “Specifying how 
simultaneous equations are solved” on page 8-3.

5. Compile and save the model. For more information, see “Compiling and saving 
models” on page 8-4.

Specifying how simultaneous equations are solved
A simultaneous equation occurs when an equation in a model indirectly depends 
on itself as the result of the dependencies among other equations in the model. A 
dependency occurs when the expression on the right-hand side of the equal sign in 
one equation refers to the assignment target of another equation. 

You control how simultaneous equations are solved by selecting options in the 
Model Options dialog box. The model options enable you to specify the following:

■ The solution method to use

■ The factors to use in testing for convergence and divergence
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■ The maximum number of iterations to perform

■ The action to take if an equation diverges or fails to converge

Compiling and saving models
When you have created the model, you must compile and save it. You can then 
include the compiled model as part of solve and group solve definitions and apply 
it to worksheet data.

Modifying models
You choose Model from the Maintain menu to modify a model. This opens the 
Maintain Model dialog box, where you can choose the model that you want to 
modify. From this starting point you can perform the following functions:

■ You can give a model a new name.

■ You can delete a model from your personal database. As an administrator, you 
can also delete a model from the shared database by deleting it from your 
personal database, and then distributing this change to the shared database.

■ You can move a model to a new position in the list of models maintained by the 
system.

■ You can change the equations that are associated with each value of the model’s 
base dimension values. Note that if you modify the equations associated with a 
model, you may need to modify the option selections that govern how 
simultaneous equations are solved.

■ You can view a list of the dependencies between the model’s base dimension 
values and see how dimension values are grouped.

■ You can change model option selections.

Related information
For more information about working with models, search for the following topics in 
the Financial Analyzer Help system:

“Creating Models”
“Defining Equations for Dimension Values”
“Deleting Models”
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“Moving Models”
“Renaming Models”
“Specifying Model Options”

Model Equation Syntax

Overview
Model equations can include operators, numeric constants, and condition 
statements. You can also include functions, which are described in the topic 
“Modeling Functions” on page 8-8.

Operators
Operators include the unary minus symbol (-) and the standard binary operators for 
addition (+), subtraction (-), multiplication (*), and division (/). Conventional rules 
for evaluating algebraic expressions apply.

If a formula contains multiple subexpressions (distinguished from the main 
expression by parentheses), the subexpressions are evaluated first; then the main 
expression is evaluated.

Operators are evaluated from left-to-right using the conventional order of 
precedence: unary operators (negative symbols) are evaluated first, followed by 
multiplicative operators (*,/), followed by additive operators (+,-). 

Numeric Constants
Numeric constants are real numbers (decimal numbers) or integers (non-decimal 
numbers).

Real numbers:

■ Have a decimal point with digits on both sides

■ Can begin with the unary minus symbol (to indicate a negative value) 

■ Can include exponential notation (d, D, e, or E) 
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Integers: 

■ Are whole numbers

■ Can include the unary minus symbol to indicate a negative value

■ Do not include a decimal point or exponential notation

Condition statements

Overview
You can use models to derive data based on certain conditions. You must use the 
condition statements IF, THEN, and ELSE. All three statements are required.

Example: Using condition statements
In this example, the TAX line item is calculated based on SALES - EXPENSE and a 
TAXRATE, where, if the result is negative, the tax is zero.

IF SALES - EXPENSE GT 0 THEN (SALES - EXPENSE) * TAXRATE ELSE 0

Multiple line equations

Overview
When typing a command or equation into a model, you can continue it onto 
another line by ending the partial command with a hyphen and then continuing on 
the next line. 

Note: Financial Analyzer models are limited to one command per If statement.

Example: Multiple line equations
Note in the following model, the hyphens (-) at the end of the 3rd, 8th, and 9th lines. 

if sales - expense gt 0 
   then 
     conssales * -1 -
     sales(line ’advert’) / lastyrsales (line ’advert’) 
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   else 
    if gross.profit gt 100 
      then 
        maint.marg / maint.rev - 
        service.marg / service.rev - 
        .
        .
        .
       else 
    NA

Referring to another financial data item
When referring to another financial data item, you must create an alias financial 
data item. In models, you cannot reference financial data items directly; you must 
always refer to them using their alias. Although the model will compile if a 
financial data item is referenced directly, a solve that is based on the model will not 
run.

Procedure: Creating an alias
Follow this procedure to create an alias for a financial data item.

1. From the Maintain menu, choose Financial Data Item.

2. Choose New.

3. In the New Financial Data Item dialog box, specify the same dimensions as the 
Financial Data Item for which you are creating the alias.

4. Choose Save.

5. Choose Edit Formula.

6. Enter the name of the Financial Data Item for which you are creating the alias.

7. Choose Save.

Example: Referring to another financial data item 
For example, if you have two financial data items called MAYACTL and APRACTL, 
and you want to create a formula to see the variance in their data, you must create 
alias financial data items for them. If the aliases you create are called MMAYACTL 
and MAPRACTL, the formula in the variance financial data item would be:

MMAYACTL - MAPRACTL
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Modeling Functions

Uses for functions
Financial Analyzer has many functions that you can use to make calculations and 
analyze data. You can use functions to perform the following tasks:

■ Calculate totals and moving totals, averages, and moving averages

■ Reference values from different time periods or derive data based on other line 
item values

■ Compute logs, square roots, absolute values, and random numbers

■ Calculate statistical and financial functions

To use a function, you type its name and, in parentheses, some additional 
information. Each piece of information needed by a function is called an argument. 

Types of functions
Financial Analyzer includes the following types of numeric functions.

Advanced mathematical functions
Advanced mathematical functions operate on each dimension in the expression. 
The dimensions of the result are the union of the dimensions of the inputs. The 
following table describes these functions.

Type of Function Description

Advanced Mathematical Functions that perform advanced mathematical calculations

Time-Series Functions that retrieve values from a previous or future time 
period and perform calculations on those values

Financial Functions that perform calculations for financial analysis

Aggregation Functions that return an aggregate value, generally consisting 
of a single value for many values of the input expression

Function Description

ABS Calculates an absolute value

INTPART Calculates the integer part of a value

LOG Calculates the natural logarithm
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Most advanced mathematical functions operate on a single numeric variable, but 
the MAX and MIN functions make comparisons between the values of two 
variables. For dimensioned variables, the MAX and MIN functions compare each 
value of one variable with the corresponding value of the other variable.

Time-series functions
The time-series functions retrieve and perform calculations on values from a 
previous or future time period. The following table describes these functions.

LOG10 Calculates the logarithm base 10

MAX Calculates the maximum between 2 expressions

MIN Calculates the minimum between 2 expressions

RANDOM Calculates a random number

REM Calculates the remainder after a division

SQRT Calculates the square root

Function Description

CUMSUM Calculates cumulative sums over time

LAG Calculates the value for a previous time period

LAGABSPCT Calculates the percent difference between current and previous 
values and indicates the direction of change

LAGDIF Calculates the difference between current and previous values

LAGPCT Calculates the percent difference between current and previous 
values

LEAD Calculates the value for a subsequent time period

MOVINGAVERAGE Calculates a series of averages over time

MOVINGMAX Returns a series of maximum values over time

MOVINGMIN Returns a series of minimum values over time

MOVINGTOTAL Calculates a series of totals over time

Function Description
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The data you retrieve with a time-series function is usually dimensioned by a time 
dimension, such as MONTH, PERIOD, or YEAR. LAG and LEAD actually can 
retrieve data of any type, but the other time–series functions handle numeric data 
only.

The LAG, LAGDIF, LAGPCT, LAGABSPCT, and LEAD functions let you compare 
data for the time dimension values in the current status with data from a previous 
or future time period. You specify the data expression you want to analyze, the 
number of time periods the function should go back or forward for the comparison, 
and the time dimension. LAG and LEAD simply return the past or future value. 

The LAGDIF and LAGPCT functions make the most commonly used types of 
comparisons, that is, the difference and the percent difference, between the current 
data and the comparison value. 

The moving functions (such as MOVINGTOTAL or MOVINGMAX) return a value 
for each time period in the status of a time dimension. The value is based on the 
data for a range of time periods that precede, include, or follow the period for 
which the value is being calculated. The range is always relative to the current 
period, so the range is always moving forward as you process each time value in 
the current status. 

Financial functions
The financial functions provide standard calculations needed for financial analysis. 
The following table describes these functions.

Function Description

DEPRDECL Calculates declining–balance depreciation

DEPRSL Calculates straight-line depreciation

DEPRSOYD Calculates sum-of-year’s-digits depreciation

FINTSCHED Calculates the interest on a series of fixed-rate installment loans

FPMTSCHED Calculates payments for a series of fixed-rate installment loans

IRR Calculates the internal rate of return for a stream of cash flows

NPV Calculates the net present value of a stream of cash flows
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Aggregation functions
Functions that return an aggregate value ordinarily return one value for many 
values of the input expression. The following table describes these functions.

Related information
For complete descriptions of modeling functions, refer to the Oracle Express 
Language Reference Manual or the Oracle Express Language online help.

Examples of Models

Example 1: Generating basic revenue and expense values
Revenue and expense line items which are commonly derived include: 

■ Gross Sales

■ Cost of Goods Sold

■ Gross Profit

Function Description

ANY Tests if any values match a criterion (returns Boolean result)

AVERAGE Calculates an average value

COUNT Counts values that match a criterion

EVERY Tests if every value matches a criterion (returns Boolean result)

LARGEST Calculates the largest value

NONE Tests if no value matches a criterion (returns Boolean result)

SMALLEST Calculates the smallest value

STDDEV Calculates the standard deviation using N–1

TALLY Counts the number of dimension values corresponding to related 
dimension values

TCONVERT Aggregates or allocates data based on time periods

TOTAL Calculates a total value
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Line items not stored in the general ledger or reflected in the standard income 
statement are often used as the basis for some of these calculations and may be 
calculations themselves. The following table shows examples of these calculations.

In this example, Unit Volume, Unit Price, Unit Cost, Sales Discounts and Sales 
Returns are input values. The Unit Volume equation is based on the previous year’s 
Unit Volume value. 

The combination of these and other equations is referred to as a model. By applying 
this model to financial data, these equations are calculated and the resulting figures 
are available for review, publishing, or further analysis.

Example 2: Modeling employee headcount
One use of models within organizations with many employees is the modeling of 
number of employees, or headcount. In organizations where compensation 
expenses account for a large percentage of total operating expenses, effectively 
budgeting and planning the compensation expense line items through headcount 
modeling provides significant level of cost controls. 

IF the line item is... THEN it is derived using the equation...

Cost of Goods Sold Unit Volume * Unit Cost

Gross Sales Unit Volume * Unit Price

Net Sales Revenue Gross Sales - (Sales Discount + Sales Return)

Gross Profit Net Sales Revenue - Total Cost of Goods Sold

Unit Volume LAG (Unit Volume, 12, TIME) * 1.05 * (1 + LAGPCT 
(Advertising Expense, 12, TIME) / 100)

Average Sales Price Gross Sales / Unit Volume

Gross Profit Percentage Gross Profit / Total Revenue * 100
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The following table shows some options for modeling consulting employee 
headcount and related revenue.

In this example, analysts can vary the Billing Rate, Billibility, or number (n) of 
employees (EEs) at each Job Grade (V.P., Director, Senior Consultant, etc.). They can 
then apply the model and see the impact of that change on overall corporate 
Consulting Revenue.

Example 3: Top down expense allocation based on prior year data
This sample model calculates the proportion of Advertising Expenses to Marketing 
Expenses from last year as a means of allocating the targeted, annual budget 
amount that was entered into Marketing Expense on the worksheet. This is an 
example of top/down budgeting with models that spread higher level values to the 
detail based on historical ratios. This same approach will work for Time, Org and all 
other dimensions. In this example, Marketing Expenses (MKTEXP) consists of 
Advertising and Selling Expenses. 

The following table describes the steps taken to create the model.

1. Create a financial data item formula called Budref. Budref will serve as an alias 
for the Budget financial data item.

2. Equate the formula for Budref to the Budget as follows:

Budref = Budget

3. Create a worksheet that allows you to enter into Budget the high level numbers 
you want to spread (for example, Marketing Expenses, Sales, Operating 
Expenses).

4. Enter the numbers you want to budget into that worksheet.

5. Create a model called Allocate Lines Based On Last Year.

IF the line item is... . . . THEN it is derived using the equation... . . .

Monthly Revenue n * Billing Rate * Billability Percentage/100

Monthly Margin Monthly Revenue - (Average Salary / 12)

Consulting Revenue Monthly Revenue at Job Grade A * (Number of EEs at Job 
Grade A + Monthly Revenue at Job Grade B * Number of 
EEs at Job Grade B + ... Monthly Revenue at Job Grade J * 
Number of EEs at Job Grade J)
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6. Write the model equation for the Advertising line item as follows:

lastyear(line ‘Advert’)/lastyear(line ‘MKTEXP’) * 
budref(line ‘MKTEXP’)

Write the model equation for the Selling Expense line item as follows:

lastyear(line ‘Sellexp’)/lastyear(line ‘MKTEXP’) * 
budref(line ‘MKTEXP’)

Note: The item “lastyear” represents a financial data item that contains last 
year’s data.

Example 4: Using the LEAD function
The LEAD function retrieves values from a subsequent time period. A model 
equation can refer to data from a subsequent time period by incorporating the 
LEAD command in the equations. For example, if December’s budgeted Plant & 
Equipment asset balance has been determined, to derive September’s budgeted 
amount based on that year end balance, you could use the following equation.

LEAD(P&E, 3, TIME) * .90

Where: 

■ P&E is the financial data item (Plant & Equipment) dimensioned by TIME

■ 3 is the number of time periods to look ahead (based on 0 being the current 
period)

■ TIME is the dimension along which to lead occurs

Example 5: Using the LAG function
The LAG function retrieves data from a previous time period. A model equation can 
refer to data from a previous time period by incorporating the LAG command in the 
equation. In the equation shown below, a month’s revenue (REVENUE) is derived 
based on the prior month’s estimate. 

LAG(REVENUE, 1, TIME) * 1.05

Where: 

■ REVENUE is the financial data item dimensioned by time

■ 1 is the number of periods to lag (based on 0 being the current period)

■ TIME is the dimension along which the lag occurs
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Example 6: Using the LAGDIF function
The LAGDIF function calculates the difference between current and previous 
values. When the difference between two values is useful in deriving a value, this 
function can be incorporated into the model equation. For instance, in statement of 
cash flow balances, net change in accounts receivable can be quickly calculated 
using the LAGDIF function. In the example below, the end of year balances are 
compared (lag one year time period).

LAGDIF(ACCTS.REC, 1, TIME)

Where: 

■ ACCTS.REC is the financial data item dimensioned by TIME

■ 1 is the number of time periods to lag (based on 0 being the current period)

■ TIME is the dimension along which the lag occurs

Example 7: Using the LAGPCT function
The LAGPCT function calculates the percent difference between current and 
previous values. The percent difference calculation is often referenced in deriving 
budget, forecast and plan data as well as when creating key indicators for tracking 
performance growth. In the example below, Computer Expense (CMPTR) is tied to 
Employee Headcount totals (HEADCOUNT). Here, monthly Computer Expense is 
budgeted based on last month’s Computer Expense, multiplied by the 
increase/decrease in Headcount from the previous month.

LAG(CMPTR, 1, TIME) * (LAGPCT(HEADCOUNT, 1, TIME) + 1)

Where: 

■ HEADCOUNT is the financial data item dimensioned by TIME

■ 1 is the number of time periods to lag (based on 0 being the current period)

■ TIME is the dimension along which the lag occurs

Example 8: Using the MOVINGAVERAGE function
The MOVINGAVERAGE (abbreviated MVAVG) function computes a series of 
averages over time or over another dimension. This function can be used to 
maintain a three-month moving average balance on inventory, as shown in the 
following equation.

MVAVG(INVENTORY, -2, 0, 1, TIME)
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Where: 

■ INVENTORY is the financial data item whose values you want to average.

■ -2 represents the starting point of the range over which you want to average. 
Because 0 represents the current period, -2 represents 2 months prior to the 
current month.

■ 0 represents the ending point of the range over which you want to average 
(with 0 being the current period).

■ 1 specifies whether to average over every period in the range. In this case, 1 
means average every period; a 2 would mean average every other period, TIME 
is the dimension over which the moving average is calculated.

Example 9: Using the MOVINGTOTAL function
The MOVINGTOTAL function (abbreviated MVTOT) computes a series of totals, 
usually over time, but can also be used over another dimension. Asset management 
may require monitoring Property Plant and Equipment (PP&E) in six-month 
moving totals as shown in the following equation.

MVTOT(PP&E, -5, 0, 1, TIME)

Where: 

■ PP&E is the financial data item whose values you want to total.

■ -5 represents the starting point of the range over which you want to average. 
Because 0 represents the current period, -5 represents 5 months prior to the 
current month.

■ 0 represents the ending point of the range over which you want to average 
(with 0 being the current period).

■ 1 specifies whether to average over every period in the range. In this case, 1 
means average every period; a 2 would mean average every other period, TIME 
is the dimension over which the moving total is calculated.
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Solving Data

Chapter summary
This chapter provides information about solve definitions and group solve 
definitions.

Who should read this chapter
You need to know the information in this chapter if you are one of the following:

■ An administrator who creates and maintains solve definitions for personal use 
and for distribution to other users of the shared database that you administer

■ A Budget workstation user who creates and maintains solve definitions for 
personal use and uses solve definitions that have been distributed to you by 
your administrator

■ An Analyst workstation user who, although unable to create, modify, or run 
solve definitions, wishes to gain a basic understanding of solve definitions and 
their uses

List of topics
This chapter includes the following topics:

■ About Solving Data

■ Working with Solve Definitions

■ Working with Group Solve Definitions

■ Automatically Running Solves and Group Solves
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About Solving Data

Definition: Solving data
When changes are made to Financial Analyzer data, the data must be solved to 
ensure that it is current. Solving data can accomplish the following: 

■ Calculate new data values for financial data items

■ Aggregate values along any hierarchies that have been defined for the 
dimensions that make up the financial data item

Definition: Solve definition
A solve definition is an information set for calculating new data for a financial data 
item. The elements that can make up a solve definition are models, hierarchies, and 
financial data items.

You can use a solve definition to:

■ Associate stored financial data items with sets of interrelated equations called 
models, for the purpose of calculating data

■ Associate stored financial data items with dimensional hierarchies for the 
purpose of aggregating data

■ Use both models and hierarchies in combination with the same financial data 
item so that you can calculate new data for that item and aggregate it along a 
hierarchy or hierarchies

Definition: Group solve definition
A group solve definition is a mechanism for solving large quantities of data in 
multiple financial data items by running a single process. A group solve definition 
can combine solve definitions and copy data profiles, and run them in a specific 
order to calculate and aggregate data for any number of financial data items.

You can use group solve definitions to perform complex sets of calculations that 
need to be completed on a periodic basis. For example, you can set up group solve 
definitions to solve all of the financial data items that are affected by a particular 
occurrence in your business cycle.
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Reasons to solve data
You solve the data in a financial data item after you have performed any of the 
following actions:

■ Changing or adding an equation in a model for a line item associated with the 
financial data item

■ Changing the aggregation type of a line item dimension associated with the 
financial data item

■ Changing or adding a hierarchy for a dimension associated with the financial 
data item

■ Adding new time periods to your database

■ Adding new dimensions to your database

■ Adding new financial data items to your database

■ Changing the current time period for your database

■ Refreshing the financial data item after adding new data

■ Entering or changing data for the financial data item through a worksheet, a 
data entry form, or a copy data event

Solve definitions run on stored financial data items
Because solve definitions and group solve definitions perform calculations or 
aggregations on actual stored data values, you can run them only on stored 
financial data items. You cannot run solve definitions or group solve definitions on 
formula financial data items because formula financial data items contain no actual 
data values.

Solving versus recalculating data
Chapter 15 describes how you can recalculate data in worksheets. Solving data 
differs from recalculating data in that solves are performed on models, which are 
defined using specific financial data items. When you run a solve, it is performed 
for all financial data items in the model. 

When you recalculate data, the recalculation is performed only on the dimensions 
currently in status in the worksheet. 
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Who can create solve definitions?

Administrators
As an administrator, it is your responsibility to maintain the solve definitions that 
your users access in the shared database that you administer. When you create or 
modify a solve definition and want other users to be able to access it, you must 
distribute the solve definition to the shared database and to other users. 

Budget workstation users
As a Budget workstation user, you can create and modify solve definitions and 
group solve definitions for personal use. You can modify definitions that your 
administrator has created for you, but you cannot save the modifications unless you 
assign a new name to the modified solve definition, retaining the original.

Working with Solve Definitions

Creating a solve definition
You choose Solve Definition from the Tools menu to create a new solve definition. 
This opens the Solve Definition dialog box where you name the solve definition. 
From this starting point you can do the following:

■ Select the financial data item for the solve definition.

■ If you want to use a model to calculate new values for the financial data item, 
select the model.

■ If you want to use a hierarchy to roll data up, select the hierarchy dimension 
values that you want to include in the rollup.

■ Save the solve definition.

Example: Solve definition
The following example shows the Solve Definition dialog box with a solve 
definition for the Actuals financial data item. The solve definition uses the Profit 
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and Loss model and will aggregate dimensional hierarchies for Organization, 
Product, and Time. 

Note: Dealing with zero values in financial data items
When creating formulas for solve definitions, remember that zero values entered 
into financial data items are stored in the database as NA values. Zero values 
entered into financial data items through a data reader are stored as zeros. This can 
affect the results of calculations that use zero values.

Running solve definitions
Both administrators and Budget workstation users can manually run solve 
definitions from the Solve Definition dialog box.

An administrator can also link a solve definition to a financial data item so that the 
solve definition runs automatically whenever a user submits data associated with a 
financial data item to the shared database. This feature is described in “Associating 
solve definitions with financial data items” on page 9-9.
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Setting the operational mode for running solve definitions
If you are using an Administrator workstation, where a solve is performed depends 
on the Operational Mode setting in the Options dialog box. If the Operational Mode 
is set to Administrator, data models are solved within your personal database. If 
the Operational Mode is set to Workstation, data models are submitted to the Task 
Processor and solved in the local shared database.

Modifying solve definitions
You choose Solve from the Tools menu to modify solve definitions. This opens the 
Solve Definition dialog box, where you can choose the solve definition that you 
want to modify. You can perform the following tasks:

■ You can give a solve definition a new name.

■ You can delete a saved solve definition from your personal database. As an 
administrator, you can also delete a solve definition from the shared database 
by deleting it from your personal database, and then distributing this change to 
the shared database.

■ You can change the information for a solve definition. For example, you can 
change the model. 

■ You can move a solve definition to a new position in the list of solve definitions 
maintained by the system.

Related information
For more information about using solve definitions, search for the following topics 
in the Financial Analyzer Help system:

“Creating Solve Definitions”
“Deleting Solve Definitions”
“Moving Solve Definitions”
“Renaming Solve Definitions”
“Running Solve Definitions to Calculate New Data”
“Specifying the Operational Mode”
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Working with Group Solve Definitions

Creating a group solve definition
You choose Group Solve Definition from the Tools menu to create a new group 
solve definition. This opens the Group Solve dialog box. From this starting point, 
you can name the new group solve definition and use the tabs in the Add to Group 
Solve box to select solve definitions and copy data profiles to include in the group 
solve definition.

Example: Group solve definition
The following example shows the Group Solve Definition Dialog box. In this 
example, the group solve definition includes two solve definitions and a copy data 
profile. 

Running group solve definitions
Both administrators and Budget workstation users can manually run group solve 
definitions from the Group Solve Definition dialog box.

An administrator can also link a group solve definition to a financial data item so 
that the group solve definition runs automatically whenever a user submits data 
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associated with the financial data item to the shared database. This feature is 
described in “Associating solve definitions with financial data items” on page 9-9.

Setting the operational mode for running group solve definitions
If you are using an Administrator workstation, where a group solve is performed 
depends on the Operational Mode setting in the Options dialog box. If the 
Operational Mode is set to Administrator, data models are solved in your personal 
database. If the Operational Mode is set to Workstation, data models are submitted 
to the Task Processor and solved in the local shared database.

Modifying group solve definitions
You choose Group Solve from the Tools menu to maintain group solve definitions. 
This opens the Group Solve dialog box, where you can choose the group solve 
definition that you want to modify. You can perform the following tasks: 

■ You can give a group solve definition a new name.

■ You can delete a group solve definition. As an administrator, you can also 
delete the group solve definition from the shared database by deleting it from 
your personal database and then distributing this change.

■ You can edit the information for a group solve definition. For example, you can 
add a solve definition.

■ You can move a group solve definition to a new position in the list of group 
solve definitions maintained by the system.

Related information
For more information about group solve definitions, search for the following topics 
in the Financial Analyzer Help system:

“Creating Group Solve Definitions”
“Renaming Group Solve Definitions”
“Moving Group Solve Definitions”
“Deleting Group Solve Definitions”
“Running Group Solve Definitions to Calculate New Data”
“Specifying the Operational Mode”
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Automatically Running Solves and Group Solves 

Associating solve definitions with financial data items
As an administrator, you can define a financial data item so that a solve or group 
solve runs whenever a user submits data associated with the financial data item to 
the shared database.

You choose Financial Data Item from the Maintain menu to set up the relationship 
between a financial data item and a solve or group solve. This opens the Maintain 
Financial Data Item dialog box, where you can select a financial data item and 
associate it with a solve definition or group solve definition. After you distribute the 
financial data item to the shared database, the specified solve or group will run 
automatically. 

Example: Associating a solve definition with a financial data item
The following example shows the Financial Data Item dialog box for Actuals. In this 
example, the Profile to Solve box shows that a group solve definition, Actuals, is 
associated with the Actuals financial data item. 
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What happens when data is submitted
Each time a Budget workstation user submits data (or the case of an Analyst 
workstation user, saves data) for the financial data item, the software automatically 
initiates the appropriate solve definition or group solve definition to recalculate the 
data.

The dimension values in status when the solve or group solve takes place is 
determined by the intersection of the submit status and the solve definition status.

IF the solve profile is . . . THEN . . .

a solve definition the status set before the solve is the intersection of the 
status of the submit with the status set in the solve 
definition.

a group solve definition then the status set before each solve definition in the group 
is:

■ The intersection of the status of the submit with the 
status set in the solve definition, if the financial data 
item in the solve definition is one that was used in the 
submit.

■ The status set by the solve definition if the financial 
data item in the solve definition was not used in the 
submit.
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10
Transferring Structures and Data

Chapter summary
This chapter describes how structures and data are transferred throughout Financial 
Analyzer.

Who should read this chapter
Administrators who are responsible for distributing structures, distributing data, 
submitting data, and refreshing data should read this chapter. Other workstation 
users can read those sections of the chapter that apply to their role.

List of topics
This chapter includes the following topics:

■ How Information Flows through Financial Analyzer

■ About Distribution

■ Distributing Structures from Administrator Workstations

■ Distributing Data from Administrator Workstations

■ Submitting Data from Administrator Workstations

■ Submitting Data From Budget Workstations

■ Saving Data from Analyst Workstations

■ Using the Shareable Documents Feature

■ Refreshing Data
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How Information Flows through Financial Analyzer

Data flow
Financial Analyzer has a multi-layered, or tiered, structure that follows the reporting 
structure of the organization or group of organizations that it supports. Data flows 
both upward and downward through this system in a specific controlled manner. 
Administrators can ensure the integrity of the data at each level and enable the 
users that they support to have access to the appropriate data.

When you make data available to users, you must also give the users access to the 
objects in the shared database that structure the data. When you distribute objects, 
you provide read and write access to the data referenced by those objects.

Structure flow
Database structures usually flow downward through the levels of the tiered 
structure. The super administrator, who occupies the top-most level of the structure, 
creates database objects based on the needs of the organization or organizations that 
the system supports and makes them available to users in the next level of the 
structure. Lower level administrators do the same for their organizations.

Administrator as gatekeeper
Data and structure flow is monitored and controlled by the administrator at each 
level, who maintains the shared database for the users at the level below. The 
administrator at each level of the reporting structure acts as a sort of “gatekeeper,” 
allowing the appropriate information to flow upward and downward through the 
system.

Illustration: Information flow in a tiered environment
The following figure shows how information flows in an installation that uses a 
tiered architecture. Financial data, represented by the dotted line, is submitted and 
distributed and thus flows both up and down through the tiered architecture. 
Database structures, represented by the solid line, are distributed from 
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administrators to lower level users. This process allows data that originates at one 
level of the tiered structure to be passed to other tiers.

Methods for transferring information
Financial Analyzer supports the following methods for transferring information.

Method of 
Transfer Description

Distribute 
Structures

Enables administrators (including the system’s super administrator) 
to transfer database objects to their users.

Distribute Data Enables administrators (including the system’s super administrator) 
to transfer data to their users.

Refresh Structures Enables users to incorporate database objects distributed to them by 
their administrators.

Refresh Data Enables users to update the data that they view or use with the most 
current version of that data from the shared database.

Submit Data Enables administrators and Budget workstation users to contribute 
data to the shared database.
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About Distribution

Definition: Distribution
In order to give users access to the shared database that you administer, you must 
provide access to both the data and to the database objects that reference that data. 
The process that you follow to provide access to objects in your shared database is 
called distribution. 

To whom do you distribute?
You can distribute objects and data as follows:

■ To Analyst and Budget workstations in the tier immediately below you in a 
multiple-tier environment

■ To administrator workstations in the tier immediately below you in a 
multiple-tier environment

■ To the shared database

Importance of distribution 
It is important to ensure that users have immediate access to the most current 
versions of objects. If there is a discrepancy between the version of an object that 
users are working with and the version that is in your shared database, the users 
will be unable to contribute data based on that object to the shared database.

Note: Everything that you distribute comes from your personal database. Always 
ensure that an object is current before distributing it to other users.
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Distributing Structures from Administrator Workstations

When to distribute
The following list outlines some of the conditions under which you would need to 
distribute structures to the shared database and to the users that you support:

■ You have created a new database object for one or more of your users.

■ You have modified an existing database object, to which one or more of your 
users currently has access. 

■ You need to delete an object from the shared database and remove access to it 
from one or more users.

■ One or more new users needs access to objects in the shared database.

■ You need to provide one or more users with access to additional objects, to 
which they previously did not have access. 

Selecting structures, actions, and users
You choose Distribution, Data Structure from the Manage menu to distribute 
structures. This opens the Data Structure dialog box, where you fill in a selection 
grid that specifies the structures and their values, the distribution action, and the 
users who will receive the distribution. 

Selecting distribution items
As you complete the Data Structure dialog box, you select the structure items that 
you want to distribute. You can choose one or more of the following:

■ Dimensions

■ Dimension values

■ Financial data items

■ Hierarchies

■ Documents (reports, graphs, worksheets, and data entry forms)

■ Models

■ Attributes

■ Folders



Distributing Structures from Administrator Workstations

10-6 Oracle Financial Analyzer User’s Guide

■ Solves and group solves

■ Profiles for submit, refresh, and copy data

■ Custom (Add-In) Menu

■ Saved selections

Selecting distribution actions
As you complete the Data Structure dialog box, you choose a distribution action for 
each structure. You can choose one of the following:

■ Add — Adds the structure to the personal databases of users specified in the 
Users column.

■ Delete from Users — Deletes the structure from the personal databases of users 
specified in the Users column.

■ Delete from System — Deletes the structure from the shared database and from 
the personal databases of all users in lower levels of the reporting hierarchy. 
This option effectively removes the structure from use, because lower-level 
users can no longer submit data for the deleted structure into the shared 
database.

■ Redistribute — Distributes the values of a structure to each selected user 
according to the values of that structure that are currently resident in each 
user's personal database.

Selecting users
As you complete the Data Structure dialog box, you select the users who will 
receive the distribution. 
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Example: Distributing structures
The following example illustrates a completed Distribute Structures dialog box. In 
this example, the selected structures will be distributed to eight users. 

Limits on document distribution 
Do not distribute more than 3000 documents. Also, bear in mind that distributing 
an extremely large number of documents, such as 1000, might degrade system 
performance.

Using distribution profiles 
You can save the information that you enter in the Distribute Structure dialog box as 
a distribution profile. A distribution profile captures the information in the selection 
grid and saves it for reuse. You can apply the profile at a later time — either exactly 
as is, or as a template for defining similar distributions.

To name and save a distribution profile, complete the grid in the Distribute 
Structure Dialog box and choose Save Profile. 

To retrieve a list of saved profiles, choose Profiles.
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Note: Distributing structures for new dimension values
If you distribute new dimension values to your users, you must also redistribute the 
dimensions with which the values are associated. If you do not redistribute the 
dimensions along with the new dimension values, users may have trouble 
contributing data associated with those values back to the shared database. 

Note: When structures have the same name
If you distribute a structure to a user who has already created a structure with the 
same name in their personal database, the new structure will appear in the “DBA 
Items to Overwrite Personal” column when the user performs a Refresh Preview. 
When the refresh is performed, the current structure in the user’s personal database 
will be overwritten by the newly distributed structure. 

Submitting structure distributions to the Task Processor
After you specify structures for distribution, you must submit the distribution. 
Submitting a distribution sends it to the Task Processor. 

If your system is not set up to continually run the Task Processor as a separate 
workstation or in the background, you must manually start the Task Processor so 
that the task will run. 

Related information
For more information about distributing structures, search for the following topics 
in the Financial Analyzer Help system: 

“Creating a Distribution Profile”
“Distributing Structures”
“Using a Distribution Profile”

Distributing Data from Administrator Workstations

When to distribute data
As an administrator, you can distribute slices of data that you entered into your 
personal database to the shared database that you maintain and to subordinate 
workstations. This feature enables you to control when your users receive specific 
types of data, such as currency translation rates, because users receive notification 
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that they need to refresh their data, and they cannot contribute new data to the 
shared database until they have refreshed their personal databases.

Important: Take care when distributing data
It is important to be careful when distributing data, because the data that you 
distributes overwrites data in the shared database. You can only distribute data for 
financial data items that you specifically marked for this purpose when you created 
them by selecting the Distribute Data option in the Maintain Financial Data Item 
dialog box.

Selecting data for distribution
You choose Distribution, Distribute Data from the Manage menu to distribute 
slices of financial data to users and to the shared database. This opens the Distribute 
Data dialog box, where you can select a financial data item and define an associated 
data slice.
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Example: Distributing data
The following example illustrates the Distribute Data dialog box. In the example, 
one data slice is selected for distribution.

Submitting distributions to the Task Processor
After you specify data for distribution, you must submit the distribution. 
Submitting a distribution sends it to the Task Processor. 

If your system is not set up to continually run the Task Processor as a separate 
workstation or in the background, you must manually start the Task Processor so 
that the task will run. 

Related information
For more information about distributing data, search for the following topics in the 
Financial Analyzer Help system: 

“Creating Financial Data Items”
“Distributing Data”
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Submitting Data from Administrator Workstations

About submitting data
As an administrator, you are responsible for submitting data that your users submit 
to your shared database up to your administrator’s shared database. This 
responsibility applies to all administrators below the super administrator level. 
Because the Super administrator workstation is positioned at the top-most level of 
the tiered structure, the shared database that the super administrator maintains 
contains the highest level of consolidated data.

Operational mode setting for submitting data
The Operational Mode setting in the options dialog box determines how data is 
submitted from an administrator workstation. If the operational mode is set to 
Administrator, data is submitted from your shared database to the shared database 
of the administrator at the next highest reporting level. If the operational mode is 
set to Workstation, data is submitted from your personal database to your shared 
database.

Selecting data for submission
You choose Submit Data from the Manage menu to submit data. This opens the 
Submit Data dialog box, where you specify the slice or slices of data that you want 
to submit. A data slice is defined by a stored financial data item (such as Actuals, 
Budget, or Forecast), which is in turn is defined by a set of dimensions (such as 
Organization, Line, and Time). You must select values for each dimension of the 
financial data item.
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Example: Submitting data
This example shows the Submit Data dialog box. In the example, three data slices 
will be submitted. The Slice Details box displays details for the first slice.

Using data submission profiles
If you periodically submit the same data, you can save the information in the 
Submit Data dialog box as a data submission profile. A data submission profile 
captures the selection information and saves it for reuse. You can apply the profile 
at a later time — either exactly as is, or as a template for defining similar 
submissions.

To name and save a data submission profile, make your selections in the Submit 
Data dialog box and choose Save Profile. This opens the Submit/Refresh Profiles 
dialog box, where you can name the profile.

To retrieve a list of saved profiles, choose Profiles.
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Distributing data submission profiles
As an administrator, you can distribute data submission profiles to your users. For 
example, you might want to distribute a profile to streamline the process of budget 
data collection.

Role of Task Processor 
After you submit data to the shared database, a submission task is sent to the Task 
Processor. The Task Processor must process the queued task in order for your data 
to be incorporated into the shared database. Refer to Chapter 11, “Task Processing” 
for information about setting up and using the Task Processor.

Related information
For more information about submitting data from administrator workstations, 
search for the following topics in the Financial Analyzer Help system:

“Creating a Data Submission Profile”
“Operational Mode”
“Submitting Data from Administrator Workstations”
“Using a Data Submission Profile”

Submitting Data From Budget Workstations

Role of Budget workstation in submitting data
As a Budget workstation user, you can manipulate the data in your personal 
database using a worksheet and save your work without affecting the shared 
database. However, if you want other users to have access to your work, you must 
submit the data from your personal database to the shared database. For example, 
after you use a worksheet to prepare a budget or forecast, you can submit your 
work to the shared database where it can be accessed by other users. 

Selecting data for submission
The process for submitting data from a budget workstation is similar to the process 
for submitting data from an administrator workstation. 

You choose Submit Data from the Manage menu to submit data. This opens the 
Submit Data dialog box, where you specify the slice or slices of data that you want 
to submit. For details, see “Selecting data for submission” on page 10-11.
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Note: Synchronizing your database
Before you submit data, you must refresh your personal database to synchronize it 
with the shared database — that is, your personal database must contain the most 
current set of structures defined for you by your administrator. For information 
about refreshing your personal database to incorporate new structures, see 
“Manually refreshing structures” on page 10-18.

Related information
For more information about submitting data from Budget workstations, search for 
the following topic in the Financial Analyzer Help system: “Submitting Data From 
Budget Workstations.” 

Saving Data from Analyst Workstations

Saving data process
If you are using an Analyst workstation, you do not maintain a personal copy of 
data from the shared database. Rather, you access the shared database directly 
when you open a worksheet. Therefore, you need only save the data in the 
worksheet in order to submit your work to the shared database.

Important: Reverting to saved data
If you attempt to save a worksheet from an Analyst workstation and you receive a 
message that states that the submission failed, you must exit from Financial 
Analyzer if you want to revert to the data in the shared database. For example, a 
submission can fail if you attempt to change the value of a dimension to which you 
do not have write access.

Related information
For more information about saving data, search for the following topic in the 
Financial Analyzer Help system: “Saving Worksheet Data.”
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Using the Shareable Documents Feature

About the shareable documents feature
As an administrator, you can authorize users who are below you in the reporting 
tier to submit documents to the shared database that you maintain. This extends the 
task of creating and maintaining documents to subordinate administrators and to 
Budget and Analyst workstation users.

A shareable document should be based on structures that reside in the shared 
database. Users who receive a shareable document cannot see any personal 
structures.

Process for enabling and using shareable documents
The following steps describe the process for enabling and using shareable 
documents. 

1. You authorize users to create shareable documents.

In the New User or Edit Users dialog box for the user, choose Allow to Create 
Shareable Documents.

2. You run the Task Processor to update the shared database.

3. When an authorized user submits a new document, the document goes to the 
shared database. 

4. You run the Task Processor to update the shared database. You then manually 
refresh the document.

5. You distribute the document using one of the following distribution action 
options: 

■ Add — Makes the document available to the users to whom it is 
distributed. The owner of the document can make modifications and 
submit them. Other users can use the document, but cannot submit 
changes. 

■ Add with Write Access — Makes the document available to the users to 
whom it is distributed. All users can use the document and submit changes.

6. You run the Task Processor to process the distribution.
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Example: Authorizing a user to create shareable documents
The following example shows the Edit User dialog box. The Allow to Create 
Shareable Documents option is enabled, indicating that this user is authorized to 
create shareable documents. 
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Example: Granting write access to shareable document
The following example shows the Distribute Structures dialog box. In the example, 
Add with Write access is selected as the distribution action.

Refreshing Structures

Overview
Super administrators and administrators define structures that are appropriate for 
their users and distribute those structures to the shared database and to their users. 
Users must then refresh structures in their personal databases so that their view of 
the data is consistent with their related shared database. 

When automatic refresh occurs
Budget workstation users can set the Automatic Refresh option in the Options 
dialog box so that a refresh process is automatically initiated if new structures are 
available to be refreshed when they log onto their systems. They can also choose not 
to set this option, which enables them to refresh structures manually. 

Analyst and Administrator workstation users must always refresh newly available 
structures when they log in. For these users, the Automatic Refresh option is always 
on. 
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Previewing refresh information at logon
You can set the Show Refresh Preview option in the Options dialog box so that the 
Refresh Preview dialog box appears when you log onto your system and have 
structures to refresh. You can use this dialog box to view information about the 
structures that are available for refresh before you apply them to your database.

What happens during a refresh
Depending on the type of workstation that you are using, one of the following types 
of refresh processes will take place:

■ Super administrator workstation — The Super administrator creates all new 
structures that exist at the top level of the tiered reporting structure; therefore 
all structures that can be refreshed come from one or more external sources. 
Structures from an external source are loaded directly into the Super 
administrator’s personal database.

■ Administrator workstations — Administrators can receive structures both from 
external sources and from the administrator at the next highest level in the 
tiered reporting structure. If structures have been loaded from an external 
source into the administrator’s shared database, the refresh process brings those 
structures into the administrator’s personal database. If structures have been 
distributed to the administrator, the refresh process brings those structures into 
the administrator’s shared database. 

■ Budget workstations — Budget workstations refresh structures from their 
administrators shared database. The structures are refreshed from the 
administrator’s shared database into the Budget Workstation user’s personal 
database.

Manually refreshing structures
You choose Refresh Structure from the Manage menu to manually refresh data 
structures. If there are new structures to refresh, the Refresh Preview dialog box 
appears. You can use this dialog box to view information about the structures that 
are available for refresh before you apply them to your database. When you choose 
Refresh, the structures are refreshed.

Related information
For more information about refreshing structures, search for the following topic in 
the Financial Analyzer Help system: “Refreshing Structures.” 
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Refreshing Data

Manually refreshing data
As an administrator, you are responsible for refreshing the data in the shared 
database that you maintain with new or modified data from the shared database in 
the tier immediately above you in the reporting structure.

If you are an administrator or super administrator and you work with data in your 
personal database, you can also refresh the data in your personal database from the 
shared database that you maintain.

Operational mode for refreshing data
As an administrator, you can refresh data in your personal database or in the shared 
database that you maintain. You set the Operational Mode in the Options dialog 
box to indicate how you are refreshing data. 

If you set the Operational Mode to Administrator, data in your local shared 
database is refreshed from the shared database of the administrator at the next 
highest reporting level. If you set the Operational Mode is Workstation, data in 
your personal database is refreshed with data from your shared database.

Important: Refresh structures before data
If an administrator has distributed new or updated structures, you must refresh the 
new structures before you can refresh new data associated with those structures.

Selecting data to refresh
You choose Refresh Data from the Manage menu to refresh data. This opens the 
Refresh Data dialog box, where you can specify which slices of data you want to 
refresh. A data slice is defined by a stored financial data item (such as Actuals, 
Budget, or Forecast), which is in turn defined by a set of dimensions (such as 
Organization, Line, and Time). You must select values for each dimension of the 
financial data item.
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Example: Selecting data to refresh
The following example shows the Refresh Data dialog box, with three data slices 
selected for refresh. The Slice details box displays the details for the first slice.

Using data refresh data profiles
If you periodically refresh the same or similar data, you can save the information in 
the Refresh Data dialog box as a data refresh profile. A data refresh profile captures 
the selection information and saves it for reuse. You can apply the saved profile at a 
later time — either exactly as is, or as a template for defining similar data refreshes. 

To name and save a data refresh profile, make your selections in the Refresh Data 
dialog box and choose Save Profile. 

To retrieve a list of saved profiles, choose Profiles.

Distributing a data refresh profile
As an administrator, you can distribute a saved data refresh profile to your users to 
streamline the process of refreshing data.
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Related information
For more information about refreshing data, search for the following topics in the 
Financial Analyzer Help system: 

“Creating a Data Refresh Profile”
“Operational Mode”
“Refreshing Data”
“Using a Data Refresh Profile”
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11
Task Processing

Chapter summary
This chapter describes the features of the Task Processor and Task queue, and 
provides an overview of their use.

Who should read this chapter
You need to know the information in this chapter if you are:

■ An Administrator who is in charge of monitoring and running the Task 
Processor

■ A Budget workstation or Analyst workstation user who wants to know what 
happens to your data after you submit it.

List of topics
This chapter includes the following topics:

■ About Task Processing

■ Using the Task Processor

■ Using the Task Queue

About Task Processing

Task Processor maintains the shared database
The Task Processor enables an administrator to maintain the shared database. All 
administrator distributions, solve definition processes, and data submissions to the 
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shared database are routed to the Task Processor, where they wait in a queue until 
they are processed. This procedure:

■ Enables multiple users to submit tasks simultaneously

■ Gives the administrator the opportunity to monitor the processing events

Task processor configurations
The Task Processor can be set up in the following ways:

■ A Task Processor workstation can be defined as part of the administrator’s 
workstation, which gives the responsibility of updating to the administrator.

■ A Task Processor can be defined as a separate workstation, which allows the 
administrator to continue working without being responsible for processing 
data submitted by users.

■ A Task Processor can be defined directly on a server.

When to run the task processor
The frequency at which data is distributed by administrators and shared among 
users will depend on:

■ The size of the company

■ The number of users within the administrator’s database network

To increase the efficiency of distributing and sharing data, Financial Analyzer 
processes all tasks using the Task Processor and tracks them using the Task queue.

Using the Task Processor

Running the Task Processor
You choose Task Processor from the Manage menu to run the Task Processor. You 
select the mode (background or foreground) and start the processing. 

Note: You can only run the Task Processor in background mode if the Task 
Processor has been configured to run on the server where Express Server is located).
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How tasks are processed
All tasks in the Task Processor are processed chronologically, which means that like 
tasks can overwrite each other, depending on the order in which each task is 
submitted for processing. As the administrator, you can reschedule tasks so that the 
more critical information is not inadvertently overwritten. 

Related information
For more information about using the Task Processor, search for the following topics 
in the Financial Analyzer Help system:

“Running the Task Processor in Background Mode”
“Running the Task Processor in Foreground Mode”
“Stopping the Task Processor”

For information about submitting data to the shared database, refer to Chapter 10 of 
this guide. For information about how to control user access to information in the 
shared database, refer to Chapter 12 of this guide.

Using the Task Queue

Function of Task queue
When tasks are submitted and processed by the Task Processor, they appear in the 
Task queue. 

Information you can obtain from the Task queue
 For each task, the Task queue displays the following information:

■ The user who initiated the task

■ The task type (such as “Distribution”)

■ Whether the task is pending or has been processed

■ When the task was submitted for processing

■ If pending, when the task is scheduled to be processed

■ If pending, the task’s position (priority) in the queue

■ If processed, the elapsed time.

■ If processed, when processing was completed
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Viewing tasks in the Task queue
If you are an administrator, you can view information about tasks in the Task queue 
that you manage. You can view the history of any task and you can view the details 
of Submit Data tasks.

Rescheduling tasks in the Task queue
As part of managing the task queue, you can change the scheduled start time of 
pending tasks. This is useful if, for example, you want to schedule a particularly 
large task to be processed after normal working hours. Note that you cannot 
reschedule Distribute Structure tasks.

Deleting tasks from the Task queue
Administrators can delete tasks from the Task queue.

Related information
For more information about the Task queue, search for the following topics in the 
Financial Analyzer Help system:

“Deleting Tasks from the Task Queue”
“Viewing Task in the Task Queue”
“Rescheduling Tasks in the Task Queue”
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12
Managing User Access

Chapter summary
This chapter describes the functions that administrators perform to manage user 
access. 

Who should read this chapter
Read this chapter if you are an administrator who maintains users and controls 
access to data in the shared database.

List of topics
This chapter includes the following topics:

■ Creating Users

■ Maintaining Users

■ Controlling Access to Shared Data

■ Creating Write Access Profiles
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Creating Users

Who can create users?
As an administrator, you can create users for the shared database that you maintain.

Prerequisites for creating users

Windows client users require installed environment
Before you can create a new Windows client user, you must install the user’s 
environment. This environment, called a component, contains shell databases and 
configuration files. 

For information about installing user environments, see Oracle Financial Analyzer  
Installation and Upgrade Guide.

Determine web sign-on method
Ask your system administrator how web users will access Financial Analyzer. If the 
system has been installed so that users will access Financial Analyzer through 
Oracle Self Service Applications, setting up users will involve importing user names 
from Oracle Applications. You will need an Oracle Applications user ID, password, 
and connection alias to perform this task.

Adding users
Choose Users from the Manage menu to create a new user. This opens the Manage 
Users dialog box, where you choose New to enter information for a new user. 

You provide the following user information:

■ User — Enter a name that identifies the user.

■ User type — Select the type of user. For more information, see “Specifying user 
type” on page 12-3.

■ Usernames — Choose Edit to access the Edit User dialog box where you can 
associate one or more user names with the user and specify whether the user is 
authorized to create shareable documents. For more information, see 
“Specifying user name” on page 12-3 and “Using the Shareable Documents 
Feature” on page 10-15.
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■ Other — Provide information that is specific to the client type. For example, for 
a thin-client workstation, you enter the SHELLS directory of the component 
where you are creating the user and the Express Server instance to which the 
user’s personal database will be connected. 

Adding a new user creates a user task and sends it to the Task Processor. If you are 
not running the Task Processor in the background, you must run it in the 
foreground to process the user task.

Specifying user type
You can create the following type of users:

■ DBA — An administrator who has access to a personal and shared database 
and to the set of features that are available in the Administrator workstation. 
On the web, DBA users access data from the shared database

■ Budget — A user who has access to a personal database and to the set of 
features that are available in the Budget workstation. For a budget user who 
will access Financial Analyzer through the Windows client, you can create a 
budget user as thin- or thick client. On the web, budget users access data from 
the shared database.

■ Analyst — A user who has access to a temporary personal database and to the 
set of features that are available in the Analyst workstation. For a Windows 
client, an analyst user’s personal database must be connected to the same 
instance of Express Server that is connected to the shared database.

■ External — A user who has access to the shared database of his or her 
administrator and to a set of features that are available through the Financial 
Analyzer Web interface, through the Express Spreadsheet Add-In, or through a 
custom application that accesses the Financial Analyzer shared database. 

Specifying user name
You can import user names from one of two sources: 

■ Operating system — Choose this option to select users who will access 
Financial Analyzer through the Windows client. You can also use this option to 
select web users who will not use Oracle Applications to access Financial 
Analyzer. 

■ Oracle Applications — Choose this option to select web users who will use 
Oracle Applications to access Financial Analyzer through a single sign-on.
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For Windows client users and web users who will not use Oracle Applications to 
access Financial Analyzer, you also have the option to manually type in a user 
name. 

Manually entering user names
To enter a user name, type the name into the blank Specify User Name box in the 
New User dialog box or the Edit User dialog box. 

Importing user names from the operating system
To import user names from the operating system, choose Import User in the New 
User dialog box or the Edit User dialog box. Choose the System Users tab, select 
one or more users and choose OK.

Importing user names from Oracle Applications
To import user names from Oracle Applications, choose Import User in the New 
User dialog box or the Edit User dialog box. Choose the Oracle Applications tab, 
log into Oracle Applications, select one or more users, and choose OK.

You only have to log into Oracle Applications once per session. When you log in, 
you are prompted for the following information: 

■ Oracle Applications user ID — Your ID for the Financial Analyzer schema 

■ Oracle Applications password — Your password for the Financial Analyzer 
schema

■ Alias — Alias for the TSNAMES.ORA connection file

Note: Your system administrator can provide this information. 

The system retrieves a list of those users who have been authorized for the user 
type in Oracle Applications. For example, if you are specifying an analyst user, the 
system will display the names of individuals who have been associated with the 
responsibility of Financial Analyzer analyst in Oracle Applications.

Example: Adding a new user
The following illustration shows the New User dialog box with information for an 
Analyst workstation user (Analyst2). In this example, the user is associated with 
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two user names. The (OA) designation appended to the second name indicates that 
the user name has been imported from Oracle Applications.

Related information
For more information about creating users, search for the following topics in the 
Financial Analyzer Help system: Creating Users.

“Creating Users”
“Import Users Dialog Box”
“Oracle Applications Log In Dialog Box”
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Maintaining Users

About maintaining users
You choose Users from the Manage menu to maintain users. This opens the Manage 
Users dialog box, where you can perform the following maintenance functions:

■ Give a user a new name.

■ Delete a user.

■ Choose Edit to access the Edit User dialog box, where you can change 
information that is associated with the user. For example, you can add or 
remove user names associated with the user, specify whether the user is 
authorized to create shareable documents, and change database information.

■ Move a user to a new position in the list of users maintained by the system.

If you remove a user
When you delete a user or remove a user name, that user’s database and icon are 
not automatically deleted. However, if a user that you have deleted attempts to log 
in, that user will receive an error message stating that they are not a valid Financial 
Analyzer user and the login process will be discontinued.

Deleting or removing a user, creates a user task and sends it to the Task Processor. If 
you are not running the Task Processor in the background, you must run it in the 
foreground to process the user task.
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Example: Maintaining users
The following illustrations shows the Manage Users dialog box. 

Related information
For more information about maintaining users, search for the following topics in the 
Financial Analyzer Help system: 

“Deleting Users”
“Moving Users”
“Renaming Users”
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Controlling Access to Shared Data

About data access restrictions
As an administrator, you are responsible for controlling read and write access to the 
shared database on your level in the tiered structure. By default, users have both 
read and write access to data in the shared database. When appropriate, you can 
prevent one or more users from writing to a particular slice of data to which they 
would otherwise have access. 

Role of write access profile
A write access profile enables you to select a slice of data and prevent specific users 
or all users who have access to that data from contributing data to the shared 
database for values of the slice.

When you restrict users’ write access to data, you prevent them from writing new 
data values to the dimensions in the shared database; you do not restrict the users’ 
ability to view that data or to work with it in reports, graphs, worksheets, or data 
entry forms. 

Examples: Restricting data access
Following are some of the ways in which you might want to restrict access to data 
for a financial data item.

Preventing all users from accessing values of one dimension
You can deny access to one or more values of a single dimension. For example, if 
you want to prevent all users from changing Actuals data in the shared database for 
the month of June, you can deny write access to the June value of the Time 
dimension for the financial data item. This action denies all users write access to the 
June Time dimension value and to any Actuals data dimensioned by June.

Preventing all users from accessing a combination of values of two or more 
dimensions
You can deny write access to one or more values of two or more dimensions. For 
example, if you want to prevent all users from changing Actuals data for the 
organizations London, Chicago, and New York for the month of November, you can 
deny write access to the London, Chicago, and New York values of the 
Organization dimension and to the November value of the Time dimension. This 
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action denies all users write access to those dimension values and to any Actuals 
data dimensioned by those values.

Preventing specific users from accessing dimensions
You can deny write access to one or more users. For example, you might deny write 
access to Actuals to users who are entering data into data entry forms over the web. 
This will prevent the users from overwriting data cells for Actuals.

Creating Write Access Profiles

Process for creating a write access profile
Choose Write Access Profiles from the Manage menu to create a new write access 
profile. This opens the Write Access Profiles dialog box. From this starting point, 
you follow these general steps to create a write access profile. 

1. You select the financial data item that contains the data to which you want to 
control write access.

2. You select the set of dimensions that make up the slice of data to which you 
want to deny write access. 

Note: To deny write access to specific users, select the User dimension as part of 
the slice. To deny write access to all users, do not select the User dimension. If 
you do not select the User dimension, the selections that you make to deny 
write access to data values in the slice will apply to all users.

3. You select the values for each dimension that make up the slice of data that you 
want to work with.

4. You deny access to the data slice. 
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Example: Selecting the financial data item for the profile
The following example shows the Write Access Profile dialog box. In this example, 
the user selects Actuals as the financial data item for a new write access profile.
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Example: Selecting dimensions for the profile
The following example shows the New Write Access Profile dialog box. In this 
example, the user selects Organization and Time as the dimensions to limit. 
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Example: Defining the data slice for the profile
This example shows the Edit Write Access Profile dialog box. In this example, the 
user selects dimension values that define a data slice that includes November 2000 
as the Time dimension value and Government as the Organization dimension value. 
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Example: Denying access to the data slice
This example again shows the Edit Write Access Profile dialog box. In this example, 
the user denies access to the data slice. Access is denied to all users since specific 
users have not been selected. 

Related information
For more information about creating write access profiles, search for following topic 
in the Financial Analyzer Help system: “Creating a Write Access Profile.”
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Managing Write Access Profiles

Deleting write access profiles
When a write access profile is no longer appropriate, you can delete it. Deleting a 
write access profile deletes both the write access restriction and the associated data 
slice definition. 

Editing write access profiles
You can modify a write access profile by making new value selections for the data 
slice. For example, you might update a write access profile that restricts write access 
to November Actuals, to restrict write access to December Actuals. 

You can also modify a write access profile by clearing the Deny function. This 
removes the write access restriction, but maintains the data slice definition for 
reuse. 
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13
Reports

Chapter summary
This chapter describes reports and how to create, edit and maintain them. 

Who should read this chapter
You need to know the information in this chapter if you are an administrator, 
Budget workstation, or Analyst workstation user who is responsible for creating, 
editing, or maintaining reports.

List of topics
This chapter includes the following topics:

■ About Reports

■ Creating Reports

■ Creating Asymmetric Reports

■ Creating Ranking and Exception Reports

■ Using Report Calculations

■ Formatting Reports

■ Saving Reports

■ Managing Reports

■ Linking Reports

■ Drilling through Levels of Data in Reports
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About Reports

Definition: Reports
A report is an interactive tool that enables you to view financial data from different 
perspectives and prepare effective presentations based on your analyses. 

Types of reports
Financial Analyzer allows you to design your own reports. In addition, you can 
create two special types of reports: 

■ Asymmetric report — Combines the values of two dimensions, or the values of 
a dimension and a financial data item 

■ Ranking/Exception report — Identifies values meeting specific exception 
criteria, ranking criteria, or both exception and ranking criteria

Report objects
Reports enable you to view and format financial data based on the financial data 
items, dimensions, and dimension values that are defined in your personal 
database. Before you can create a report, your personal database must contain the 
required database objects. Administrators typically define database objects and 
distribute them to users. 
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Report window
The report window contains elements that enable you to manipulate a report’s 
layout and format. The following illustration shows a typical report and its 
elements.
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The following table describes the elements of the report window. 

Element Description

Dimension tiles Enable you to rearrange the layout of a report and access the Selector 
dialog box, where you can choose a different set of values for the 
dimension. There are three types of dimension tiles:

■ Page dimension tiles — Located in the upper-left corner of the 
report window, these tiles represent dimensions in the page 
position

■ Across dimension tiles — Located in the upper-right corner of 
the report window, these tiles represent dimensions in the 
across position

■ Down dimension tiles — Located at the bottom of the report 
window, these tiles represent dimensions in the down position

Edit bar Enables you to edit text, such as titles, footnotes, and dimension 
labels. Select the text or data value you want to edit to make it 
appear in the edit bar.

Edit bar buttons The Formula Tools button opens the Formula Tools dialog box, 
which you can use to edit formulas.

The Cancel button clears text or formulas from the edit bar.

The Enter button moves text or formulas from the edit bar to the 
currently selected area.

Page controls Enables you to move between pages in a multiple-page document. 

Title, subtitle, and 
footnote panes

Enables you to specify a title, subtitle, and footnote for the report.

Row and column 
labels

Identifies currently selected dimension values.

Highlighter buttons Enables you to select data cells for formatting. You can select a single 
row or column, a series of rows or columns, or the entire body of a 
document.

Redisplay button Enables you to refresh a document manually after making format or 
selection changes.
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Report menu
When you create a new report or open an existing report, the Report menu becomes 
available on the menu bar.

The following table describes the items on the Report menu.

Creating Reports

About creating reports
When you create a report, current financial data from your personal database is 
automatically included in the report cells. You can base a report on the default 
report template or on an open report or graph.

Menu Item Description

Report Options Opens the Report Options dialog box, where you can choose elements 
to display in the report.

Dimension 
Labels

Opens the Dimension Label Setup dialog box, where you can specify 
the text that the system will use when it creates row, column, and page 
labels.

Drill When checked, enables drilling in reports.

Auto Redisplay When checked, specifies that reports are to be automatically 
redisplayed when you make changes to them.

Asymmetric 
Format

Opens the Create Asymmetric Combination dialog box, where you can 
join the values of two dimensions and create a custom arrangement of 
their values.

Ranking/
Exception 
Report

Opens the Ranking and Exception Setup dialog box, where you can 
specify the criteria for a ranking and exception report.

Drill to GL Provides detailed information in General Ledger that may not appear 
on a report. This option is accessible only if you are working with a 
report based on data that was loaded from General Ledger and you are 
set up to use the GL Link. 
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Process for creating a report
Follow these general steps to create a report.

1. From the File menu, choose New and then choose Report. 

The menu bar displays the Report menu. The document window displays a 
default report.

2. Select the data that you want to include in the report. For more information, see 
“Selecting data to include in a report” on page 13-6.

3. Adjust the layout of the report to arrange the dimensions according to how you 
want to view the data. For more information, see “Changing the layout of a 
report” on page 13-7.

4. You can include calculations in the report. For more information, see “Using 
Report Calculations” on page 13-15.

5. You can apply asymmetric formatting to the report. For more information, see 
“Creating Asymmetric Reports” on page 13-7.

6. You can apply ranking/exception criteria to the report data. For more 
information, see “Creating Ranking and Exception Reports” on page 13-11.

7. You can apply formatting to the report. For more information, see “Formatting 
Reports” on page 13-23.

Selecting data to include in a report
You use selection tools to specify the slices of data that you want the report to 
include. In the context of a report, a data slice is defined by a financial data item and 
a set of dimension values.

For example, if you wanted to create a report that compares Actuals data with 
Budget data, you would select: 

■ Both the Actuals and Budget financial data items

■ A set of dimension values for each item

If the financial data items are dimensioned by Time, Line Item, and Organization, 
you would select a set of time periods, line items, and organizations for each 
financial data item. 

For more information on the tools and techniques that are available for selecting 
data, see Chapter 7.
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Changing the layout of a report
Once you have created a report and selected the data that you want to work with, 
you can arrange the dimensions according to how you want to view the data. 

You rearrange dimensions in a report by changing the positions of the dimension 
tiles in the report window. You can move dimension tiles to unoccupied locations, 
except when the combination of tiles would result in more than 5,000 dimension 
values along one edge of the report. You can also drop labeled tiles onto other 
labeled tiles to have the dimensions rotate positions.

Related information
For more information about creating reports, search for the following topics in the 
Financial Analyzer Help system:

“Opening Reports”
“Closing Reports”
“Creating Reports”
“Selecting Data”

Creating Asymmetric Reports

Definition: Asymmetric report
An asymmetric report is a report format that combines the values of two 
dimensions, or the values of a dimension and a financial data item. An asymmetric 
combination gives you access to all of the values of both dimensions and provides a 
great deal of flexibility for positioning the values along the rows, columns, or pages 
of the report. 
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Process for creating an asymmetric report
Follow these general steps to create an asymmetric report. 

1. Open or create the report that you want to work with.

2. Place the objects (dimensions or dimensions and financial data items) that you 
want to combine on the same edge of the report.

3. From the Report menu, choose Asymmetric Format. 

The Asymmetric Combination dialog box appears. 

4. In the Asymmetric Combination dialog box select two dimensions that you 
want to combine and choose OK.

The New Tile Name dialog box appears.

5. In the New Tile Name dialog box, enter a name for the new tile that the system 
creates for the asymmetric combination and choose OK. 

The Asymmetric Layout dialog box appears.

6. In the Asymmetric Layout dialog box, use the edit bar and the Insert, Delete, 
and Move buttons to arrange the list of values as you want them to appear in 
the report. When you are satisfied with the arrangement, choose OK. 

Example: Asymmetric report
The report in this example includes data for the Actuals financial data item for three 
months in 1999 and 2000. The asymmetric combination reformats the values so that 
the data is easier to compare by month.
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Standard report
In the standard version of the report, the values are displayed chronologically, as 
shown in the following illustration.
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Asymmetric combination
When an asymmetric combination is applied to the report, the data is displayed as 
shown in the following illustration. You can now easily compare Actuals for each 
month of the quarter.

Using asymmetric reports from which financial data items have been deleted
If you open a previously saved asymmetric report that uses a financial data item 
that you have deleted since the report was saved, you will receive the following 
error message:

An error occurred setting up data for the report. Consider changing the 
definition to access a different selection.

You can fix this error and still use the report by following the procedure described 
in the following Help topic: “Using Asymmetric Reports From Which Financial 
Data Items Have Been Deleted.”
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Removing asymmetric formatting from a report
You can remove the asymmetric formatting from a report at any time.

When you separate the asymmetric combination into its component dimensions, the 
values in status for those dimensions remain the same as for the asymmetric 
combination. If you want to change the status, you must access the Selector and 
select the items you want to include in each dimension. Also note that when you 
remove the formatting, you may need to reposition the dimension tiles to set up the 
report as you want it.

Related information
For more information about asymmetric reports, search for the following topics in 
the Financial Analyzer Help system: 

“Including Asymmetric Formatting in a Report”
“Removing Asymmetric Formatting From a Report”
“Using Asymmetric Reports From Which Financial Data Items Have Been Deleted”

Creating Ranking and Exception Reports

Definition: Ranking and Exception reports
Ranking and Exception reports apply ranking criteria, exception criteria, or both 
ranking and exception criteria to a dimension. The criteria is applied to each page of 
data.

Types of Ranking and Exception reports
There are four types of ranking and exception reports:

■ Ranking report — Displays data in an order that meets a set of criteria that you 
specify. For example, you might rank products by volume within a market area 
and time period.

■ Exception report — Displays data associated with dimension values that meet 
cutoff values within parameters that you specify. For example, you might 
display expense items for which variance is greater than 10% within a cost 
center and time period.

■ Ranking-then-exception report — Displays data in an order that meets a set of 
criteria that you specify, then displays a subset of the ranked data that meet 
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cutoff values within parameters that you specify. For example, you might rank 
the top 100 products by volume for a year in the U.S. and then display a ranked 
subset of those products for which sales exceeded $1.5 million in the U.S. for the 
year.

■ Exception-then-ranking report — Displays data associated with dimension 
values that meet cutoff values within parameters that you specify in an order 
that meets criteria that you specify. For example, you might display products 
for which sales exceeded $1.5 million in the U.S. for the second quarter and 
rank the top five of these products by volume change from year ago in the U.S. 
for the second quarter. 

Process for creating a Ranking/Exception report
Follow these general steps to create a Ranking/Exception report. 

1. Open an existing report or choose New from the Report menu. 

2. From the Report menu, choose Ranking/Exception. 

Note: The Ranking/Exception menu item is not available if the report that you 
create or open has more than one dimension in the down position, or if the 
dimension in the down position is the FinData dimension. 

3. In the Ranking and Exception dialog box, choose the report type. For 
information on report types, see “Types of Ranking and Exception reports” on 
page 13-11.

4. Drag the dimension tiles to the down, page or across positions to determine the 
report layout. For more information, see “Page layout for Ranking and 
Exception reports” on page 13-12.

5. Specify ranking, exception, or ranking and exception criteria.

6. Choose OK.

Page layout for Ranking and Exception reports
The Layout area of the Ranking and Exception dialog box enables you to position 
the dimensions on the page so as to determine the focus of a Ranking and Exception 
report.
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The following list describes the effect of the down, page, and across positions in 
Ranking and Exception reports:

■ Down position — Only one dimension can be in this position, which the system 
uses to rank dimension values or to select a subset of values. Do not put 
Financial Data Item in the down position. Also, if the report is both a ranking 
report and an asymmetric report, the asymmetric edge cannot be on the down 
position. The values of the down dimension populate the row labels of the 
report.

■ Page position — Determines the separate pages of the report. The ranking, 
exception, or ranking and exception criteria are applied to each page.

■ Across position — Determines the criteria for the ranking, exception, or ranking 
and exception criteria. The values of the across dimension populate the column 
labels of the report.

Example: Ranking and Exception report setup
The following illustration shows the Ranking and Exception Setup dialog box. In 
this example, Exception then Ranking is selected as the report type. The selections 
will create a report that displays products for which Actuals exceeded $1 million in 
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the year 2000 for specified organizations. The report will also rank the five top 
products.

Display of ranking numbers in report output
Ranking numbers appear in a ranking report and in an exception-then-ranking 
report next to the values for the down dimension. Ranking numbers are not 
displayed in a ranking-then-exception report.

Related information
For more information about ranking and exception reports, search for the following 
topics in the Financial Analyzer Help system: 

“Dimensions of Ranking/Exception Reports”
“Expanding the Base Selection for Ranking/Exception Reports”
“Using Ranking/Exception Reports”
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Using Report Calculations

About report calculations
When you are working with a Financial Analyzer report, you can define ad hoc 
formulas to calculate figures such as sums, counts, and averages without having to 
define a model or a solve definition. These formulas, called report calculations, 
operate only on the data that is currently included in the report.

When to use report calculations
If you require a temporary formula that you do not need to use in other documents, 
you can use a report calculation. If, however, you require the same formula 
frequently or in multiple documents, you should consider using one of the 
following methods to perform calculations:

■ Create a formula financial data item, as described in Chapter 4.

■ Add a line item to the Line dimension and incorporate its calculation into a 
model, as described in Chapter 8.

Inserting rows and columns for calculations
In order to define a report calculation, you must insert a new row or column in the 
report and then define a formula for that row or column. When you finish defining 
the formula, the system populates the appropriate report cells with data calculated 
using the formula. You can move or delete the column or row as you can any 
inserted column or row. 

If you insert a new report calculation and it conflicts with an existing calculation 
(for example, if you create a column calculation when a row calculation has already 
been defined), the most recently inserted report calculation takes precedence.

Inserted rows or columns, and their associated formulas, exist only in the context of 
the current report. You cannot link inserted rows or columns between reports or 
gain access to them via the Selector. 
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Associating formulas with report cells
You can associate a formula with:

■ All of the cells in the current column or row

■ Just one cell in a column or row

■ Financial data items

You cannot associate a formula with multiple randomly selected cells in a row or 
column. You must select either just one cell or all cells in a column or row related to 
a financial data item. 

How inserted calculations relate to dimension values
Inserted rows and columns and their associated formulas can be linked to the 
dimension to which they are added or to a position in the report. If a row or column 
is inserted in relation to a particular dimension value, that dimension value 
becomes the “owner” of the insert. For example, if you insert a row before the 
dimension value Widgets, Widgets becomes the insert’s owner. If you insert a row 
or column by specifying a position (for example, “after the 2nth FinData”), the 
inserted row or column stays in the same relative position, even if other dimension 
values change status, because it is not associated with a particular dimension value.

How moving dimension values affects calculations
You can move dimension values in reports either by swapping tiles or selecting 
Move Insert from the Edit menu. The following table describes methods of moving 
dimension values and the effect that each method has on inserted calculations.

Method of moving a dimension value Effect on inserted calculations

Moving the dimension value that owns the 
insert to another position in the report

The insert moves with the moved 
dimension

Removing the dimension value that owns the 
insert from the report by using the Selector to 
remove the value from status

The insert and its associated formula are 
deleted from the report

Moving the dimension to the page edge of the 
report

The insert is suppressed, but retained; if 
the dimension is moved to an across or 
down position, the insert reappears

Hiding the dimension value that owns the 
insert from the report using drilling 

The insert is hidden until the dimension 
value is redisplayed
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Methods for creating formulas
You can create formulas by:

■ Selecting the Formula Tools button on the toolbar and selecting values from the 
tabs

■ Entering the formula manually into the Edit bar

■ A combination of entering the formula manually and using the mouse to select 
dimension values

Formula construction
Report formulas are always constructed as follows:

result = expression

where:

■ result is the location in the report of the cell or cells where the result will be 
displayed

■ expression is an algebraic expression made up of the following elements: 
operators, numeric constants, dimension-value pairs, and functions

Note that if you create a formula using Formula Tools, after you exit the Formula 
Tools dialog box, the newly created formula appears in the edit box, but is not 
reflected in the report until you select the Enter button.

Moving the inserted column or row that 
contains the formula relative to another 
dimension value (by selecting Move Insert 
from the Edit menu) 

The insert becomes “owned” by the 
dimension value that you moved it 
relative to

Moving the inserted column or row that 
contains the formula positionally (by selecting 
Move Insert from the Edit menu)

The insert is no longer “owned” by a 
dimension value and will remain in the 
current position in the report until 
moved

Method of moving a dimension value Effect on inserted calculations
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Using dimension values in formulas
You can include dimension values in report formulas. In report formulas, 
dimension values:

■ Can be displayed either by their description name or by their internal identifier. 
How they are displayed depends on the Use Internal IDs in Report Calcs setting 
in the Options dialog box. If Use Internal IDs in Report Calcs is set to Yes, 
dimension values are displayed by their internal identifier. If Use Internal IDs in 
Report Calcs is set to No, dimension values are displayed by their description 
name. Note that internal IDs are always unique, but description names do not 
have to be unique. If you choose to display dimension values as their 
description name, you should ensure that the description name you select for 
inclusion in your formula is unique to avoid unexpected results.

■ Must always be included as part of a dimension-value pair. For example, 
TIME:JAN00, where TIME is the dimension name, and JAN00 is the dimension 
value.

■ Can only be included if they are in status in the current report.

You cannot use the same dimension-value pair in both the result and expression 
side of a formula. 

Using qualified data references in formulas
You can use qualified data references, known as QDRs, to describe specific cells that 
are referenced by one or more dimensions. For example, you can use a QDR to 
reference the cell that represents the Total Assets line item for the year 2000 for the 
East organization.

QDRs have many uses in report formulas. For example, in the expression side, you 
can use a QDR to specify that you want to use data contained in a specific cell in a 
formula. In the results side, you can use a QDR to choose a specific cell into which a 
formula can be inserted. A useful application for this would be to insert an NA 
value at the intersection of an inserted row that contains a formula and a column 
that contains a formula, when neither inserted formula produces an appropriate 
result.

You use the Qualify tab in the Formula Tools dialog box to create qualified data 
references (QDRs) to the data in specific cells in the current report. 
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Example 1: Applying calculations to rows and columns
The report in this example has two inserted columns and one inserted row for 
calculated data. For this report:

■ The formula was created using the mouse to select dimension-value pairs from 
the current report

■ Dimension values are displayed by their description names (as opposed to their 
internal identifiers) 

■ The columns labeled Year to Go and Year to Go % Year, and the Row labeled 
Operating Income % Revenue have been inserted

■ The Year to Go column contains the following formula:

’Time:Year to Go’=’Time:Nov 00’+’Time:Dec 00’

where:

■ The single quotations (‘ ‘) are required delineators

■ Time represents the dimension

■ The colon (:) is a required separator between the dimension and dimension 
value

■ Time:Year to Go represents the inserted column

■ The plus sign (+) is an operand

■ Nov 00 and Dec 00 are the description names of the dimension values

■ The Year to Go % Year column contains the following formula:

’Time:Year to Go % Year’= ’Time:Year to Go’/’Time:Year 00’*100

■ The Operating Income % Revenue row contains the following formula:

’Line:Operating Income % Revenue’= 
‘Line:Operating Income’/’Line:Total Revenue’*100
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After inserting the formulas in the specified cells, the report appears as follows:

Example 2: Applying a calculation to a specific cell
In the previous example, the number 82% (located at the intersection of the two 
inserted formulas) is meaningless. To ensure that this value is not misinterpreted, 
we can replace the incorrect value with an NA value. 

For this report, the formula to do this would be as follows:

’Line:Operating Income % Revenue;Time:Year to Go % Year
’=NAN()

where:

■ The single quotations (‘ ‘) are required delineators

■ Line is the dimension

■ The colon (:) is a required separator between the dimension and dimension 
value

■ Operating Income % Revenue is the inserted row
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■ The semi-colon (;) is a required separator between the two dimension-value 
pairs

■ Time is a dimension

■ Year to Go % Year is the inserted column

■ NAN( ) is the NAN function, which places an NA value in the specified cell.

To avoid typing mistakes in the long QDR, the results side of the expression was 
created using the Qualify tab in the Formula Tools dialog box.

After inserting the above formula in the specified cell, the report appears as follows:

Note that in this example, the NA value appears as a dash (-) because that is how 
NA Spell is specified in report options.
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Report calculation errors
If you enter a formula incorrectly, you will receive an error in the cell into which 
you were attempting to insert a formula. The following table describes these errors 
and their meanings. 

Related information
For more information about using calculations in reports, search for the following 
topics in the Financial Analyzer Help system:

“Defining Formulas for Report Calculations”
“Displaying Internal Identifiers in Report Formulas”
“Defining Formulas for Report Calculations”
“Formula Syntax”
“Inserting Rows or Columns”
“Moving Inserted Rows and Columns”

Error Description

#CIRC! The formula contains a circular reference

#DIV/0 The formula is attempting to divide by zero

#ERROR! This is a generic error

#MISSING! The dimension-value pair used in the formula is not currently in status

#NAME? The formula contains a function name that is not recognized

#NULL! The formula contains dimensions that do not intersect in the report

#NUM! There is a problem with a number

#OVERFLOW! The expression evaluates more values than are specified in the result

#PAGE! The dimension-value pair used in the formula is not in the current 
page

#REF! The formula contains an invalid reference to a cell

#VALUE! The formula contains the wrong type or number of operands
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Formatting Reports

About formatting reports
You can use a variety of formatting tools to make a report attractive and easy to 
read. 

Options for formatting report elements
The following table describes tasks and related Help topics for using Report 
Options to change the look of your report. 

Task Description Related Help Topics

Specify the precedence order in which column, row, and 
page formatting changes will take effect

Specifying a Precedence Order 
for Formatting in Reports

Add a title, subtitle, or footnote ■ Including Titles in Reports

■ Including Subtitles in 
Reports

■ Including Footnotes in 
Reports

Edit the row, column, and page control labels that are 
automatically generated when you create a new report

Editing Dimension Value 
Labels

Change the horizontal and vertical alignment of titles, 
labels, footnotes, and values in data cells

Aligning Text or Numbers in 
Reports

Automatically suppress rows that contain only zeros, 
N/A values, or both

Specifying Row Suppression in 
Reports

Place borders around titles or dimension labels in a report Placing Borders Around Text 
in Reports

Automatically indent row labels to make the structure of 
hierarchies evident

■ Indenting Row Titles by 
Level in Reports

■ Specifying the Amount of 
Indentation for Row Titles 
in Reports
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Changing the look of rows and columns
The following table describes tasks and related Help topics for changing the look of 
rows and columns.

Other formatting options
The following table describes tasks and related Help topics for other formatting 
options.

Task Description Related Help Topics

Insert blank rows to improve readability or 
include report calculations

Inserting Rows or Columns

Insert blank columns to improve readability or 
include report calculations

Inserting Rows or Columns

Move inserted columns or rows Moving Inserted Rows or Columns

Adjust the height of individual rows Adjusting Row Height in Reports

Adjust the width of individual columns Adjusting Column Width in Reports

Description Related Help Topics

Control the way numbers are represented Choosing a Format for Numbers in 
Reports

Choose fonts, font styles, and point sizes for 
titles, labels, footnotes, and values in data cells 

Choosing Fonts for Text or Numbers in 
Reports

Choose colors for text (such as titles, labels, and 
footnotes) and for values in data cells

Choosing Colors for Text or Numbers in 
Reports

Choose background colors for text or data cells, 
and for the report window

Choosing Background Colors in Reports

Specify a style, width, and color for borders Placing Borders Around Text in Reports

Insert page breaks Inserting Page Breaks In Reports And 
Worksheets

Delete page breaks Deleting Page Breaks from Reports and 
Worksheets
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Specifying dimension value labels 
As an alternative to manually editing labels for a series of dimension values, you 
can choose from a set of labels that are already defined for those values. To do this, 
choose Dimension Labels from the Report menu, then select a label type.

Using the Highlight Special feature
You can use the Highlight Special feature to apply formatting characteristics to all 
dimension values associated with a dimension in a report. Formatting 
characteristics applied using Highlight Special: 

■ Are applied to values on other pages as well as the currently displayed page

■ Are applied to dimension values added to a report after the initial formatting 
occurs

■ Can be applied to dimension value labels, data cells, or both

Showing or hiding report components
You choose Report Options from the Report menu to access the Report Options 
dialog box, which enables you to show or hide elements in the report window, and 
add or remove components of the report itself. For example, you can show or hide 
the report title.

Related information
For more information about formatting reports, search for the following topics in 
the Financial Analyzer Help system:

“Displaying Dimension Labels in Reports”
“Using the Highlight Special Feature in Reports.”

Saving Reports

About saving reports
After you create a report, you can save it for use in future work sessions. 

When you save a report, only its shell, or form, is saved to disk. The next time you 
open the report, current data is incorporated into the report’s data cells.
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Saving a new report
When you save a new report, you assign it a unique name and, optionally, one or 
more keywords that can be used to access the document at a later time.

When you save a report under a new name, the system gives you the option of 
saving it as your default report. This enables you to use the saved report as a 
starting point the next time you create a new report.

Saving changes to an existing report
When you save changes to an existing report, you can overwrite the original report 
(if it belongs to your personal library), or you can save the modified report under a 
new name and preserve the original. 

You choose Save to overwrite the original report and Save As to save your changes 
as a new report with a unique name.

Related information
For more information about saving reports, search for the following topics in the 
Financial Analyzer Help system: 

“Saving New Reports”
“Saving Changes to Reports”

Managing Reports

Printing reports
You can print an entire report, the current page, or a set of pages that you specify. 
You can also print multiple reports. 

Choose Print from the File menu to print individual reports or Print Multiple to 
print multiple reports. If you choose to do so, you can sequentially number all the 
pages across all the reports that you print together.

Both Financial Analyzer and Microsoft Windows® provide a wide range of printing 
options that let you adjust margins, create headers and footers, preview a document 
before printing, and so on. 
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Adding reports to folders
You can organize reports within folders so that users can locate them quickly and 
easily. 

Choose Maintain Folders from the Tools menu to add a report to a folder. This 
opens the Maintain Folders dialog box, where you can select a folder and choose 
one or more reports to add.

Deleting reports
You can delete reports from your personal database. 

Choose Delete from the File menu to delete a report. This opens the Delete dialog 
box, where you can select a report to delete.

As an administrator, you can also delete a report from the shared database so that 
users no longer have access to it. You delete the report from your personal database, 
and then distribute the structure with a Delete from System action, which deletes 
the structure from the shared database and from the personal databases of all of 
your users, including any administrators immediately below you in the reporting 
hierarchy.

Modifying reports
You can modify a report by making new selections for financial data items and 
dimension values. You can also add or remove formulas, change the report layout, 
and modify the formatting. 

You can save a modified report under its current name, or under a new name.

Exporting report data to a file
You can extract data from your active report to a file so that you can import the data 
into another application, such as a spreadsheet.

Choose Export to File from the File menu to export report data. This opens the 
Export to File dialog box, where you can specify the file name, path, and export 
format. 

The following formats are available:

■ .txt — Exports the data in text file format, in which labels and data values are 
separated by fixed-width tabs
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■ .csv (Comma delimited) — Exports the data in Comma Separated Value format, 
in which labels and data values are separated by commas

■ .xls (Microsoft Excel 95, 97, or 2000) — Exports the data in the format for the 
specified version of Microsoft Excel

You can also specify whether to export to multiple worksheets or to a single 
worksheet.

Note: For an .xls export, you can select the version of Excel that is currently 
installed on your system or an earlier version. For example, if your current Excel 
installation is Excel ’97, you can specify Excel ’97 or Excel ’95 formats, but you 
cannot specify Excel 2000 format. 

Related information
For more information about managing reports, search for the following topics in the 
Financial Analyzer Help system:

“Adding Documents to Folders”
“Adding the Current Report to a Folder”
“Adding Multiple Documents to Folders”
“Deleting Reports.”
“Deleting Structures from the System”
“Exporting Report Data to Other Applications.”
“Printing Reports.”

Linking Reports

About linking reports
If you need to create a series of reports that are related in some way, you can link 
the reports so that the selections and label formatting changes that you make in one 
document are propagated to all the linked reports.

For example, suppose that you need to prepare a series of reports based on the same 
set of line items. By creating a series of new reports and linking their Line Item 
dimensions, you need to select the set of line items only once; the choices you make 
are automatically applied to all the linked reports. As long as the dimensions are 
linked, any time you add or remove a line item or change a label associated with a 
line item, your changes are applied to all the linked reports.
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Rules for linking reports
When linking reports, the following rules apply:

■ You can link a series of reports. You cannot link reports with graphs or 
worksheets.

■ You can link only dimensions of the same type (for example, Time with Time, 
Line Item with Line Item, and so on).

■ You can link multiple dimensions with their corresponding dimensions. For 
example, you might link the Time, Line Item, and Organization dimensions 
across a series of reports.

■ You can form a link based on any dimension except the FinData dimension.

Links in saved reports
Links that you create in a report are preserved until you overtly remove them. That 
is, you can create a link and save and close the document. When you reopen the 
report, the link remains intact.

Related information
For more information about linking reports, search for the following topic in the 
Financial Analyzer Help system: “Linking Dimensions in Reports.”

Drilling through Levels of Data in Reports

About drilling in reports
The drill feature enables you to view report data at different levels of detail. You can 
use the drill feature on any dimension that uses a hierarchy to structure dimension 
values. 

In order to use the drill feature, you select a hierarchy and place its corresponding 
dimension in the down position of the report. Note that you can only use the drill 
feature when there is no more than one dimension in the down position.
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Example: Drilling in reports
In the report shown in this example, the plus symbol beside each line item indicates 
that drilling is activated, and that the items have descendants.
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When you click on the plus symbol for an item, the dimension value list expands. 
For example, Cost of Sales and Services has four children: Cost of Sales, Cost of 
Services-Support, Cost of Services-Consulting, Cost of Services-Training.

Related information
For more information about drilling, search for the following topic in the Financial 
Analyzer Help system: “Drilling Through Levels of Report Data.”
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14
Graphs

Chapter summary
This chapter describes graphs and how to create, edit and maintain them. 

Who should read this chapter
You need to know the information in this chapter if you are an Administrator, 
Budget, or Analyst workstation user who is responsible for creating or maintaining 
graphs.

List of topics
This chapter includes the following topics:

■ About Graphs

■ Creating Graphs

■ Formatting Graphs

■ Specifying Series Formatting for Graphs

■ Specifying Axis Formatting for Graphs

■ Specifying Formatting for Pie Graphs

■ Saving Graphs

■ Managing Graphs

■ Linking Graphs
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About Graphs

Definition: Graphs
Graphs enable you to create visual representations of your financial data. You can 
use graphs to view your financial data from different perspectives, and you can 
format and print graphs for use in presentations.

Types of graphs
Financial Analyzer provides a variety of graph types that enable you to represent 
data in many different ways. For example, some graphs let you emphasize trends 
over time while other graphs let you show part-to-whole relationships. The 
following list describes and shows samples of Financial Analyzer’s basic graph 
types.

Graph Type Typical Use Sample

Line Graph Shows trends over time and emphasizes rates 
of change

Vertical Bar Graph Like a horizontal bar graph, compares data 
associated with different dimension values

Horizontal Bar Graph Like a vertical bar graph, compares data 
associated with different dimension values
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Graph objects
Graphs enable you view and format financial data based on the financial data items, 
dimensions, and dimension values that are defined in your personal database. 
Before you can create a graph, your personal database must contain the required 
database objects. Administrators typically define database objects and distribute 
them to users. 

Graph window
The graph window contains various elements that enable you to manipulate a 
graph’s layout and format.

Bar-Line Graph Shows relationships between data measured 
in different units

Area Graph Shows trends and emphasizes degrees of 
change

Pie Graph Shows part-to-whole relationships

Scatter Graph Shows the relationship between two variables

Graph Type Typical Use Sample
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The following illustration shows a vertical bar graph with elements of the graph 
window labeled. 
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The following table describes each labeled element.

Element Description

Dimension tiles Enable you rearrange the layout of a graph and access the Selector 
dialog box, where you can choose a different set of values for the 
dimension. There are three types of dimension tiles:

■ Page dimension tiles — Located in the upper-left corner of the 
graph window, these tiles represent dimensions in the page 
position

■ Across dimension tiles — Located in the upper-right corner of 
the graph window, these tiles represent dimensions in the across 
position

■ Down dimension tiles — Located at the bottom of the graph 
window, these tiles represent dimensions in the down position

Edit bar Enables you to edit text such as titles, footnotes, and dimension 
labels. Select the text or data value you want to edit to make it appear 
in the edit bar.

Edit bar buttons The Cancel button clears text from the edit bar.

The Enter button moves text from the edit bar into the currently 
selected area.

Page controls Enables you to move between pages in a multiple-page graph. 

Title, subtitle, and 
footnote panes

Enables you to specify a title, subtitle, and footnote for the graph.

Dimension labels Identifies currently selected dimension values.

Redisplay button Enables you to refresh a document manually after making format or 
selection changes. 

X-axis A graph’s horizontal axis.

Y-axis A graph’s vertical axis. A graph can have either one or two Y-axes.

Data markers Represent the data shown in a graph. Depending on the type of graph 
that you are viewing, data markers are either areas, bars, lines, points, 
or pie slices.

Legend A key to the data represented in a graph.
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Graph menu
When you open a graph in the document window, the Graph menu becomes 
available on the menu bar.

The following table describes each item on the Graph menu.

Creating Graphs

About creating graphs
When you create a graph, current financial data is automatically included in the 
graph. You can base a graph on the default graph template, or on an open graph or 
report. 

Process for creating graphs
Follow these general steps to create a new graph.

1. Choose New from the File menu and then choose Graph. 

2. Select the data that you want to include in the graph. For more information, see 
“Selecting data to include in a graph” on page 14-7.

Menu Item Description

Type Opens the Graph Type dialog box, which enables you to specify the 
type of graph that you want to use.

Legend Opens the Legend dialog box, where you can specify whether to 
display a legend for your graph. This dialog box also enables you to 
format the legend.

Pie Options Opens the Pie Options dialog box, where you can specify labels for a 
pie graph and/or its slices and perform other formatting functions.

Grid Opens the Grid dialog box, where you can specify whether to display 
gridlines along the X- and/or Y-axis of a graph.

Graph Options Opens the Graph Options dialog box, where you can specify 
information for graph controls, text, attributes, and axis titles.

Dimension 
Labels

Opens the Dimension Label Setup dialog box, where you can specify 
the text that the system will use when it creates row, column, and page 
labels.

Auto Redisplay When checked, specifies that graphs are to be automatically 
redisplayed when you make changes to them.t.
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3. You can change the graph type. For more information, see “Types of graphs” on 
page 14-2. 

4. You can adjust the layout of the graph. For more information, see “Changing 
the layout of a graph” on page 14-7.

5. You can apply formatting to the graph. For more information, see “Formatting 
Graphs” on page 14-8.

Selecting data to include in a graph
As part of creating a graph, you must specify which slices of data that you want the 
graph to include A data slice is defined by a financial data item, multiple 
dimensions, and a set of values of those dimensions.

For more information on the tools and techniques that are available for selecting 
data, see Chapter 7.

Example: Selecting data to include in a graph
Suppose you want to create a graph that compares Actuals data with Budget data. 
Using the Selector, you would select: 

■ Both the Actuals and Budget financial data items

■ A set of dimension values for each item

For example, if the financial data items are dimensioned by Time, Line Item, and 
Organization, you would select a set of time periods, line items, and organizations 
for each financial data item.

Changing the layout of a graph
Once you have created a graph and selected the data that you want to work with, 
you can arrange the dimensions according to how you want to view the data. You 
rearrange dimensions in a graph by changing the positions of the dimension tiles in 
the graph window. You can move dimension tiles to unoccupied locations or drop 
labeled tiles onto other labeled tiles to have the dimensions swap positions.
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Related information
For more information about creating graphs, search for the following topics in the 
Financial Analyzer Help system: 

“Choosing Graph Types”
“Creating Graphs”
“Selecting Data”

Formatting Graphs

About formatting graphs
You can use a variety of formatting tools to make a graph attractive and easy to 
read. 

Adding a title, subtitle, or footnote to a graph
As part of formatting a graph, you can add a title, subtitle, or footnote.

Editing dimension value labels in a graph
You can edit certain dimension value labels that the software automatically 
generates when you create a new graph. For example, you can edit X-axis labels and 
legend labels.

Specifying dimension value labels 
As an alternative to manually editing labels for a series of dimension values, you 
can choose from a set of labels that are already defined for those values. To do this, 
choose Dimension Labels from the Graph menu, then select a label type.

Choosing a format for the graph legend
Legends serve as keys to data represented in graphs. If you have several data series 
depicted in a graph, with each series represented by a different marker, a legend 
helps you associate each marker with its corresponding data series.

When you create a new graph, the software includes a legend that is appropriate for 
the data shown in the graph. You can modify the legend’s location, layout, and label 
orientation.
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Removing a legend from a graph
You can remove a legend entirely by choosing Graph Options from the Graph 
menu and deselecting the Show Legend option.

Aligning text in a graph
You can change the alignment of text elements such as titles, labels, or footnotes. 
The alignment options are left, center, and right.

Choosing a format for numbers in a graph
As part of formatting a graph, you can make various choices that control the way 
numbers are represented. You can choose:

■ The number of decimal places

■ To include international currency, scaling, or percent symbols

■ To display decimal separators or thousands separators

Choosing fonts for graph text
You can choose fonts, font styles, and point sizes for titles, labels, and footnotes. You 
can use multiple fonts in the same document to improve readability or to emphasize 
important elements. The fonts that are available depend on the printer you have 
selected.

Choosing colors and patterns for a graph
To help make your graphs attractive and easy to read, you can select colors and 
patterns for the following elements:

■ Titles, axis labels, legend labels, and footnotes

■ Graph area, legend area, and graph window

■ Data markers
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Showing or hiding graph components
You can choose Graph Options from the Graph menu to show or hide elements in 
the graph window, and to add or remove components of the graph itself. For 
example, you can add a Y2-axis to your graph and show or hide its title.

Related information
For more information about formatting graphs, search for the following topics in 
the Financial Analyzer Help system:

“Aligning Text in Graphs”
“Applying Patterns to Legends”
“Choosing Background Colors and Patterns in Graphs”
“Choosing Colors and Patterns for Data Markers in Graphs”
“Choosing Colors for Text or Numbers in Graphs”
“Choosing a Format For Numbers in Graphs”
“Choosing Fonts for Text or Numbers in Graphs”
“Choosing Fonts for Legend Text”
“Creating Dimension Values”
“Editing Dimension Value Labels”
“Including Legends in Graphs”
“Including Titles in Graphs”
“Including Subtitles in Graphs”
“Including Footnotes in Graphs”
“Modifying the Location of a Legend in a Graph”
“Modifying the Orientation of a Legend in a Graph”
“Modifying the Placement of a Legend in a Graph”

Specifying Series Formatting for Graphs

About series options
The Series Options command on the Format menu allows you to emphasize and 
manipulate the data series depicted in your graph. This section explains how to 
perform the following tasks:

■ Change the shapes of data markers

■ Assign a data series to the Y1- or Y2-axis

■ Add or remove fit lines
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Changing the shapes of data markers
When you are working with a bar or line graph, you can emphasize a specific data 
series by changing the shape of its data markers. For example, if you are viewing 
three data series whose data markers are currently shown as bars, you can 
emphasize one of the data series by changing its data markers to lines.

Assigning a data series to the Y1- or Y2-axis
If you are working with a graph that contains both a Y1- and Y2-axis, you can 
assign any data series in the graph to either axis. This is useful if you want to 
compare dissimilar data series using different scales.

Adding and removing fit lines
When you are working with a bar, line, or scatter graph, you can create fit lines to 
emphasize trends. Fit lines represent a new series of data that is statistically based 
on an original series. Fit lines, also called trend lines, illustrate how original data 
series are changed by exponential, linear, or logarithmic calculations.

Related information
For more information about specifying series options for graphs, search for the 
following topic in the Financial Analyzer Help system: 

“Assigning Data to a Graph’s Y-Axis”
“Changing the Shape of Data Markers”
“Including Fit Lines in Graphs”

Specifying Axis Formatting for Graphs

Introduction
You can change the appearance of an axis in a graph by adding or changing the 
format of tick marks and tick labels, or changing the scaling.

Position the mouse on the X, Y1- or Y2-axis on a dual axis graph and click the 
mouse button when the mouse pointer changes shape. Then choose Axis Options 
from the Format menu. This opens the Axis Options dialog box, where you can 
specify how you want to change the format of an axis.
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Including tick marks
When working with bar, line, area, or scatter graphs, you can include tick marks on 
the X- or Y-axis. You can include major tick marks, minor tick marks, or both, and 
you can position them either inside, outside, or across the selected axis.

Changing the scale of the Y1- or Y2-axis
When you are working with a bar, line, area, or scatter graph, you can adjust the 
scale of values on the graph’s Y1- or Y2-axis to accommodate the range of data 
displayed by the graph. You can adjust the scale of each Y-axis independently.

Arranging X-axis labels
When you are working with a bar, line, area, or scatter graph, you can change the 
arrangement of the dimension labels that appear below the graph’s X-axis. You can 
change the number of lines each label occupies, stagger the labels, or show only a 
subset of the labels.

Related information
For more information about specifying axis format options for graphs, search for 
the following topics in the Financial Analyzer Help system: 

“Changing the Placement of Dimension Labels in Graphs”
“Including Tick Marks in Graphs”
“Scaling Y-Axes in Graphs”

Specifying Formatting for Pie Graphs

Introduction
Choose Pie Options from the Graph menu to specify formatting for slices in a pie 
graph.
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Exploding slices in a pie graph
When you set up a pie graph, you can explode one or more slices in the graph for 
emphasis. You can explode pie slices in the following ways:

■ You can explode only the first slice of the pie

■ You can select any slice in the pie and explode it

Labeling each pie in a multiple-pie graph
If you are setting up a pie graph that contains multiple pies, you can include a label 
for each pie to explain what it represents.

Labeling pie slices
When you set up a pie graph, you can label the slices of the pie to show what they 
represent.

Adding pie slice feelers to a pie graph
If you include pie slice labels when you set up a pie graph, you can include pie slice 
feelers to connect the labels to the appropriate slices.

Related information
For more information about format options for pie graphs, search for the following 
topic in the Financial Analyzer Help system: 

“Exploding Slices in Pie Graphs”
“Including Pie Slice Feelers in Pie Graphs”
“Labeling Pie Graphs”
“Labeling Slices in Pie Graphs”

Saving Graphs

About saving graphs
 After you create a graph, you can save it for use in future work sessions.

When you save a graph, only its shell, or form, is saved to disk. The next time you 
open the graph, the most current data from your local database is incorporated into 
the graph’s data cells.
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Saving a new graph
When you save a new graph, you assign it a unique name and, optionally, one or 
more keywords that can be used to access the graph at a later time.

When you save a graph under a new name, the system gives you the option of 
saving it as your default graph. This enables you to use the saved graph as a 
starting point the next time you create a new graph. 

Saving changes to an existing graph
When you save changes to an existing graph, you can overwrite the original version 
(if it belongs to your personal library), or you can save the changed graph under a 
new name, preserving the original version.

Related information
For more information about saving graphs, search for the following topics in the 
Financial Analyzer Help system: 

“Saving New Graphs”
“Saving Changes to Graphs”

Managing Graphs

Opening and closing graphs
You can open any graph you have previously created, or any graph that your 
administrator has defined and distributed to you. After you finish working with a 
graph, you can close it to conserve system resources and save space in the Financial 
Analyzer window. 

Printing graphs
You can print an entire graph, the current page, or a set of pages you specify.

Both Financial Analyzer and Microsoft Windows provide a wide range of printing 
options that let you adjust margins, create headers and footers, preview a document 
before printing, and so on. 
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Adding graphs to folders
You can organize graphs within folders so that you can locate them quickly and 
easily. 

Choose Maintain Folders from the Tools menu to add a graph to a folder. This 
opens the Maintain Folders dialog box, where you can choose a folder and select 
one or more graphs to add.

Deleting graphs
You can delete graphs that you no longer need from your personal database. 

Choose Delete from the File menu to delete a graph. This opens the Delete dialog 
box, where you can select a graph to delete.

As an administrator, you can also delete a graph from the shared database so that 
users no longer have access to it. You delete the graph from your personal database, 
and then distribute the structure with a Delete from System action. This deletes the 
structure from the shared database and from the personal databases of all of your 
users, including any administrators immediately below you in the reporting 
hierarchy.

Modifying graphs
You can modify a graph by making new selections for financial data items and 
dimension values. You can also change the graph type, change the layout, and 
modify the formatting. 

You can save a modified graph under its current name, or under a new name.

Exporting graph data to a file
You can export data from your active graph to a file so that you can import the data 
into another application, such as a spreadsheet.

Choose Export to File from the File menu to export graph data to a bitmap (.BMP 
file). This opens the Export to File dialog box, where you can specify the file name 
and path. 
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Related information
For more information about managing graphs, search for the following topics in the 
Financial Analyzer Help system:

“Adding Documents to Folders”
“Adding the Current Graph to a Folder”
“Adding Multiple Documents to Folders”
“Application Options”
“Closing Graphs”
“Deleting Graphs”
“Exporting Graph Data to Other Applications”
“Opening Graphs”
“Removing Documents From Folders”

Linking Graphs

Introduction
If you need to create a series of graphs that are related in some way, you can link the 
graphs so that selections you make in one document are propagated to all the 
linked documents.

For example, suppose that you need to prepare a series of graphs based on the same 
set of line items. By creating a series of new graphs and linking their Line Item 
dimensions, you need to select the set of line items only once; the choices you make 
are automatically applied to all the linked graphs. As long as the dimensions are 
linked, any time you add or remove a line item or change a label associated with a 
line item, your changes are applied to all the linked graphs.

Rules for linking graphs
When linking graphs, the following rules apply:

■ You can link a series of graphs. You cannot link graphs with reports or 
worksheets.

■ You can link only dimensions of the same type (for example, Time with Time, 
Line Item with Line Item, and so on).
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■ You can link multiple dimensions with their corresponding dimensions. For 
example, you might link the Time, Line Item, and Organization dimensions 
across a series of graphs.

■ You can form a link based on any dimension except the FinData dimension.

Saving links
Links that you create in a graph are preserved until you overtly remove them. That 
is, you can create a link and save and close the graph. When you reopen the 
document, the link remains intact.

Related information
For more information about rules for linking graphs, search for the following topic 
in the Financial Analyzer Help system: “Linking Dimensions in Graphs.”
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15
Worksheets

Chapter summary
This chapter describes how to create and use worksheets.

Who should read this chapter
Read this chapter if you are an Administrator, Budget or Analyst workstation user 
who is responsible for creating or maintaining worksheets.

List of topics
This chapter includes the following topics:

■ About Worksheets

■ Creating Worksheets

■ Formatting Worksheets

■ Entering Data in Worksheets

■ Calculating Data in Worksheets

■ Saving Worksheets

■ Managing Worksheets

■ Linking Worksheets

■ Drilling Through Levels of Data in Worksheets
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About Worksheets

Definition: Worksheet
A worksheet is a tool you can use to: 

■ Enter new financial data into your database

■ Make changes to existing data

■ Drill through levels of data

■ Perform calculations such as growing, spreading, and increasing data

Worksheets allow you to view multiple slices of financial data from different 
perspectives. In addition, they allow you to change the values in data cells. You can 
enter data manually or have the software populate worksheet cells based on 
instructions that you provide.

Since worksheets enable you to enter, drill down, and perform calculations on data, 
they are essential for developing budgets, forecasts, and what-if analyses.

Worksheet objects
Worksheets let you view and manipulate financial data based on the financial data 
items, dimensions, and dimension values that are currently defined in your 
personal database. Administrators typically define these and other database objects 
and distribute them to users. 

Worksheet window
The worksheet window contains various elements that enable you to manipulate a 
worksheet’s layout and format. 
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The following illustration shows a worksheet and its elements.

This table describes the elements of the worksheet window.

Element Description

Dimension tiles Enable you to rearrange the layout of a worksheet and access the 
Selector dialog box, where you can choose a different set of values for 
the dimension. There are three types of dimension tiles:

■ Page dimension tiles — Located in the upper-left corner of the 
worksheet window, these tiles represent dimensions in the page 
position

■ Across dimension tiles — Located in the upper-right corner of the 
worksheet window, these tiles represent dimensions in the across 
position

■ Down dimension tiles — Located at the bottom of the worksheet 
window, these tiles represent dimensions in the down position

Edit bar Enables you to edit text (such as titles, footnotes, and dimension labels) 
and individual data values. Select the text or data value you want to 
edit to make it appear in the edit bar.
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Worksheet menu
When you create a new worksheet or open a worksheet, the Worksheet menu 
becomes available on the menu bar. 

Edit bar buttons The Cancel button clears text from the edit bar.

The Enter button moves text from the edit bar into the currently 
selected area.

Page controls Enable you to move between pages in a multiple-page worksheet. 

Title, subtitle, 
and footnote 
panes

Enable you to specify a title, subtitle, and footnote.

Row and column 
labels

Identifies currently selected dimension values.

Highlighter 
buttons

Enables you to select data cells for performing calculations or 
formatting. You can select a single row or column, a series of rows or 
columns, or the entire body of the worksheet.

Redisplay button Enables you to refresh a worksheet manually after making format or 
selection changes. 

Status bar Displays information about currently selected models or hierarchies.

Element Description
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The following table describes each item on the Worksheet menu.

Menu item Description

Worksheet 
Options

Enables you to perform the following functions:

■ Show or hide worksheet window elements such as page controls, 
highlighter buttons, scroll bars, status bar, and dimension tiles.

■ Show or hide text elements, such as titles, subtitles, and footnotes.

■ Show or hide gridlines.

■ Specify a null value symbol and a precedence order for formatting. 
Also specify whether to display numbers in the edit bar in actual or 
truncated format.

■ Apply a filtering attribute to budget worksheet rows based on the 
dimension value shown in the page.

■ Specify that you want labels to accompany data when you copy data 
values to the clipboard.

Dimension 
Labels

Opens the Dimension Label Setup dialog box, where you can specify the 
text that the system will use when it creates row, column, and page labels.

Drill When checked, enables drilling in worksheets.
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Creating Worksheets

About creating worksheets
When you create a worksheet, current financial data from your personal database is 
automatically included in the worksheet. You can base a worksheet on the default 
worksheet template or on an open worksheet.

Auto 
Redisplay

When checked, specifies that worksheets are to be automatically 
redisplayed when you make changes to them.

Worksheet 
Tools

Displays a cascading menu, from which you can select options that enable 
you to perform calculations on data. You can also access this menu by 
clicking the right mouse button with the cursor positioned anywhere in the 
body of the worksheet.

■ Grow Data — Enables you to “grow” data over a range of cells by an 
amount or percentage you specify. For more information, see 
“Growing data” on page 15-21.

■ Increase Data — Enables you to increase data over a range of cells by a 
constant value. For more information, see “Increasing data” on page 
15-22.

■ Spread Data — Enables you to spread data within a hierarchy from 
parents to children or all descendants. For more information, see 
“Spreading data” on page 15-22.

■ Recalculate — Recalculates worksheet data based on any models or 
hierarchies that are currently selected. 

■ Recalc Options — Enables you to specify parameters for recalculating 
data.

■  Save Data (Administrator and Budget Workstations only) — Saves 
worksheet data to your personal database.

■ Reset Data — Returns worksheet data to the values that were 
displayed when the worksheet was last opened or the worksheet data 
was last saved.

Menu item Description
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Process for creating worksheets
Follow these general steps to create a new worksheet:

1. Choose New from the File menu and then choose Worksheet. 

2. Select the data that you want to include in the worksheet. For more information, 
see “Selecting data to include in a worksheet” on page 15-7.

3. You can adjust the layout of the worksheet. For more information, see 
“Changing the layout of a worksheet” on page 15-8.

4. You can perform calculations such as growing data, increasing data, and 
spreading data. For more information, see “Calculating Data in Worksheets” on 
page 15-21.

5. You can apply formatting to the worksheet. For more information, see 
“Formatting Worksheets” on page 15-11.

Selecting data to include in a worksheet
You specify the slices of data that you want to include in the worksheet. A data slice 
is defined by a financial data item and a set of dimension values.

For more information on the tools and techniques that are available for selecting 
data, see Chapter 7.

Requirements for worksheet data
Unlike reports and graphs, which allow you to include multiple financial data items 
in the same document, worksheets allow you to work with only one financial data 
item at a time. 

Worksheets permit you to work with stored financial data items only. You cannot 
include formula financial data items in worksheets.

Example: Selecting data for a worksheet
Suppose you want to work with Actuals data. Using the Selector, you would: 

■ Select the Actuals financial data item

■ Select a set of dimension values for that item 

For example, if Actuals is dimensioned by Time, Line Item, and Organization, you 
would select a set of time periods, line items, and organizations.
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Changing the layout of a worksheet
Once you have created a worksheet and selected the data that you want to work 
with, you can arrange the dimensions according to how you want to view the data. 
You rearrange dimensions in a worksheet by changing the positions of the 
dimension tiles in the worksheet window.

Example: Changing the layout of a worksheet
In the sample worksheet shown following: 

■ The Commercial Sales and Parent Total: Product dimensions occupy the page 
position.

■ The Financial Data and Time dimensions occupy the across position.

■ The Line dimension occupies the down position. 

Each page of the worksheet displays data associated with multiple line items and 
time periods for a single organization and product line.
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To view data for multiple product lines on the same page, you could drag the 
Product tile and drop it on the Time tile to have the corresponding dimensions 
swap positions, as shown in the following illustration.
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If you wanted to change your view of the data to reflect a single line item and time 
period and multiple products and sales organizations, you could swap the 
Organization and Line tiles. The following illustration shows the results.

You could continue to rearrange tiles to yield as many different views of the data as 
you needed.

Tip: Paging through a worksheet
To quickly page through an open worksheet, select the paging dimension by 
clicking on it and press Alt+Page Up or Alt+Page Down.

Related information
For more information about creating worksheets, search for the following topics in 
the Financial Analyzer Help system: 

“Creating Worksheets”
“Selecting Data”
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Formatting Worksheets

About formatting worksheets
You can use a variety of formatting tools to make a worksheet attractive and easy to 
read. 

Options for formatting worksheet elements
The following table describes tasks and related Help topics for using Worksheet 
Options to change the appearance of a worksheet.

Task Description Related Help Topics

Specify the precedence order in which column, row, and 
page formatting changes will take effect

Specifying a Precedence Order 
for Formatting in Worksheets

Add a title, subtitle, or footnote ■ Including Titles in 
Worksheets

■ Including Subtitles in 
Worksheets

■ Including Footnotes in 
Worksheets

Edit the row, column, and page control labels that are 
automatically generated when you create new 
worksheets

Editing Dimension Value Labels

Change the horizontal and vertical alignment of titles, 
labels, footnotes, and values in data cells

Aligning Text or Numbers in 
Worksheets

Place borders around titles or dimension labels Placing Borders Around Text in 
Worksheets

Automatically indent row labels to make the structure of 
hierarchies evident

■ Indenting Row Titles by 
Level in Worksheets

■ Specifying the Amount of 
Indentation for Row Titles 
in Worksheets
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Changing the look of rows and columns
The following table describes tasks and related Help topics for changing the look of 
rows and columns in a worksheet.

Other formatting tasks
The following table describes other formatting tasks.

Specifying dimension value labels
As an alternative to manually editing labels for a series of dimension values, you 
can choose from a set of labels that are already defined for those values. To do this, 
choose Dimension Labels from the Worksheet menu, then select a label type. 

Task Description Related Help Topics

Insert blank rows to improve readability Inserting Rows or Columns

Insert blank columns to improve readability Inserting Rows or Columns

Adjust the height of individual rows Adjusting Row Height in Worksheets

Adjust the width of individual columns Adjusting Column Width in Worksheets

Task Description Related Help Topics

Control the way numbers are represented Choosing a Format for Numbers in 
Worksheets

Choose fonts, font styles, and point sizes for 
titles, labels, footnotes, and values in data cells 

Choosing Fonts for Text or Numbers in 
Worksheets

Choose colors for text (such as titles, labels, and 
footnotes) and for values in data cells

Choosing Colors for Text or Numbers in 
Worksheets

Choose background colors for text or data cells, 
and for the worksheet window

Choosing Background Colors in 
Worksheets

Specify a style, width, and color for borders Placing Borders Around Text in 
Worksheets

Insert page breaks Inserting Page Breaks In Reports And 
Worksheets

Delete page breaks Deleting Page Breaks from Reports and 
Worksheets
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Using the Highlight Special feature
You can use the Highlight Special feature to apply formatting characteristics to all 
dimension values associated with a dimension in a worksheet. Formatting 
characteristics applied using Highlight Special: 

■ Are applied to values on other pages as well as the currently displayed page

■ Are applied to dimension values added to a worksheet after the initial 
formatting occurs

■ Can be applied to dimension value labels, data cells, or both

Related information
For more information, search for the following topics in the Financial Analyzer 
Help system:

“Displaying Dimension Labels in Worksheets”
“Using the Highlight Special Feature in Worksheets”

Managing Worksheets 

Opening and closing worksheets
You can open any worksheet that you have previously created, or any worksheet 
that your administrator has defined and distributed to you. You can open only one 
worksheet at a time. When you finish using a worksheet, it is best to close it to 
conserve system resources and save space in the Financial Analyzer window.

Printing worksheets
You can print the worksheets that you create. You can print an entire worksheet, the 
current page, or a set of pages you specify. You can also print multiple worksheets.

Choose Print from the File menu to print individual worksheets. Choose Print 
Multiple to print multiple worksheets in a single print session. If you choose to do 
so, you can sequentially number all the pages across all the worksheets that you 
print together.

Both Financial Analyzer and Microsoft Windows provide a wide range of printing 
options that let you adjust margins, create headers and footers, preview a document 
before printing, and so on. 
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Adding worksheets to folders
You can organize worksheets within folders so that users can locate them quickly 
and easily. 

Choose Maintain Folders from the Tools menu to add a worksheet to a folder. This 
opens the Maintain Folders dialog box, where you can choose a folder and select 
one or more worksheets to add.

Deleting worksheets
You can delete worksheets that you have created from your personal database. 

Choose Delete from the File menu to delete a worksheet. This opens the Delete 
dialog box, where you can select a worksheet to delete.

As an administrator, you can also delete a worksheet from the shared database so 
that users no longer have access to it. You delete the worksheet from your personal 
database, and then distribute the structure with a Delete from System action, which 
deletes the structure from the shared database and from the personal databases of 
all of your users, including any administrators immediately below you in the 
reporting hierarchy.

Exporting worksheet data to a file
You can extract data from the active worksheet and save it to a file so that you can 
import the data into another application, such as a spreadsheet.

Choose Export to File from the File menu to export data from a worksheet. This 
opens the Export to File dialog box, where you can specify the file name, path, and 
format. 

The following formats are available:

■ .txt 

■ .csv (comma delimited)

■ .xls (Microsoft Excel 95, 97, or 2000)

You can also specify whether to export to multiple worksheets or to a single 
worksheet.

Note: For an .xls export, you can select the version of Excel that is currently 
installed on your system. Alternatively, you can select an earlier version. 
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Related information
For more information about managing worksheets, search for the following topics 
in the Financial Analyzer Help system:

“Adding Documents to Folders”
“Adding the Current Worksheet to a Folder”
“Adding Multiple Documents to Folders”
“Closing Worksheets”
“Deleting Worksheets”
“Exporting Worksheet Data to Other Applications”
“Opening Worksheets”
“Printing Worksheets”

Saving Worksheets

About saving worksheets
 After you create a worksheet, you can save it for use in future work sessions.

When you save a worksheet, only its shell, or form, is saved to disk. The next time 
you open the worksheet, current data is incorporated into the worksheet’s data 
cells.

Saving a new worksheet
When you save a new worksheet, you assign it a unique name and, optionally, one 
or more keywords that can be used to access the document at a later time.

When you save a worksheet under a new name, the system gives you the option of 
saving it as your default worksheet. This enables you to use the saved worksheet as 
a starting point the next time you create a new worksheet. 

Saving changes to an existing worksheet
When you save changes to an existing worksheet, you can overwrite the original 
worksheet (if it belongs to your personal library), or you can save the modified 
worksheet under a new name and preserve the original. 

You choose Save to overwrite the original worksheet and Save As to save your 
changes as a new worksheet with a unique name.
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Saving worksheet data from a Budget workstation
When you save a worksheet from a Budget workstation, both the worksheet 
specification and any new data that you entered into the worksheet are saved to 
your personal database. If you want to save the data without saving the worksheet 
specification (for example, if the worksheet belongs to the administrator’s library 
and you cannot resave it), from the toolbar choose

Alternatively, you can choose Worksheet Tools from the Worksheet menu and then 
choose Save Data. 

Saving data from an Analyst workstation
When you save a worksheet from an Analyst workstation, Financial Analyzer 
automatically submits any data that you have entered or changed to the shared 
database.

Related information
For more information about saving worksheets, search for the following topics in 
the Financial Analyzer Help system:

“Saving New Worksheets”
“Saving Changes to Worksheets”
“Saving Worksheet Data”

Linking Worksheets

About linking worksheets
If you need to create a series of worksheets that are related in some way (such as 
multiple versions of a budget or forecast), you can link the worksheets so that 
selections and label formatting changes that you make in one worksheet are 
propagated to all the linked worksheets.

For example, suppose that you need to prepare a series of worksheets based on the 
same set of line items. By creating a series of new worksheets and linking their Line 
Item dimensions, you need to select the set of line items only once; the choices that 
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you make are automatically applied to all the linked worksheets. As long as the 
dimensions are linked, any time you add or remove a line item or change a label 
associated with a line item, your changes are applied to all the linked worksheets.

Rules for linking worksheets
When linking worksheets, the following rules apply:

■ You can link a series of worksheets. You cannot link worksheets with graphs or 
reports.

■ You can link only dimensions of the same type (for example, Time with Time, 
Line Item with Line Item, and so on).

■ You can link multiple dimensions with their corresponding dimensions. For 
example, you might link the Time, Line Item, and Organization dimensions 
across a series of worksheets.

■ You can form a link based on any dimension except the FinData dimension.

Links in saved worksheets
Links that you create in a worksheet are preserved until you overtly remove them. 
That is, you can create a link and save and close the worksheet. When you reopen 
the worksheet, the link remains intact.

Related information
For more information about linking worksheets, search for the following topic in 
the Financial Analyzer Help system: “Linking Dimensions in Worksheets.”

Drilling Through Levels of Data in Worksheets

About drilling in worksheets
The drill feature enables you to view worksheet data at different levels of detail. 
You can use the drill feature on any dimension that uses a hierarchy to structure 
dimension values.

In order to use the drill feature, you select a hierarchy and place its corresponding 
dimension in the down position of the worksheet. Note that you can only use the 
drill feature when there is no more than one dimension in the down position.
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Example: Drilling through data in a worksheet
In the following illustration, the plus symbol beside Consulting indicates that 
drilling is activated, and that Consulting has descendants.
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When you click on the plus symbol, the dimension value list expands to show that 
Consulting has three children: Consulting East, Consulting Central, and Consulting 
West. 

Related information
For more information about drilling, search for the following topic in the Financial 
Analyzer Help system: “Drilling Through Levels of Worksheet Data.”

Entering Data in Worksheets

About data entry
You enter financial data by opening a worksheet, inputting individual data values 
into the worksheet’s cells, and saving the data to your personal database. You can 
then submit the data to the shared database, making your work available to other 
users.
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Note: Zero values in worksheets
Zero values entered into budget worksheets are stored in the database as NA 
values. Zero values entered into worksheets through a data reader are stored as 
zeros.

Recalculating data
If you enter new data in a worksheet or change data used to calculate other values, 
you can use the recalculate feature to refresh all the data in the worksheet.

If you are recalculating data along a hierarchy or according to a model, you need to 
specify the appropriate recalculation options before you use the recalculate feature. 
The options that you specify are retained in the worksheet until you change them.

Note: Data affected by recalculating
When you recalculate data in a worksheet, the recalculation affects only the data 
slice that is currently selected for display in the worksheet. To recalculate data 
beyond the boundaries of the worksheet, use a solve definition or a group solve 
definition. For information about solving data, refer to Chapter 9.

Saving data
If you want to save data without saving the worksheet, from the toolbar choose:

or choose Worksheet Tools from the Worksheet menu nd then choose Save Data. 

Resetting data
If you decide not to keep changes that you make to data in a worksheet, but you 
want to continue using the worksheet, you can reset its data. You can only reset 
data that has not been saved. Once data is saved in a worksheet, you cannot reset it.

To reset data, choose Reset Data from the Worksheet Tools menu.
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Related information
For more information about entering data in worksheets, search for the following 
topics in the Financial Analyzer Help system: 

“Calculating Worksheet Data”
“Entering Data into Worksheets”
“Resetting Worksheet Data”
“Saving Worksheet Data”

Calculating Data in Worksheets

About calculations in worksheets
You can use worksheets to perform calculations on data in your database. The 
following sections describe the types of calculations that you can perform.

Growing data
You can grow data in a worksheet by an amount or percentage over a range of cells. 
The first data value in the range remains unchanged and is used as the base value 
upon which the calculation is performed. Each subsequent value in the range grows 
by the specified amount or percentage as compared to the base value.

Example: Growing data
Suppose that in each month of the last quarter of 2000, Volume Sales for Product A 
are reforecast to be 5% higher than the month before. By orienting a worksheet to 
reflect 2000 forecast data with months in the across position, you could select three 
cells representing Product A Volume Sales for October through December. 
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If you grew the data values across columns by 5%: 

■ October’s values would remain unchanged

■ November’s values would be 5% higher than October’s

■ December’s values would be 5% higher than November’s

Increasing data
You can increase data in a worksheet by a constant amount or percentage. You can 
increase values in individual cells or over a range of cells spanning rows, columns, 
or both.

Example: Increasing data
Suppose that, for each month of the fourth quarter of 2000, Volume Sales for 
Product A are reforecast to be 5% higher than the corresponding figures in the 
previous forecast. By orienting a worksheet to reflect 2000 forecast data with 
months in the across position, you could select the three cells representing Volume 
Sales for Product A for November through December. You could then increase each 
of these values by 5%. Each new value would, therefore, be 5% higher than its 
original value.

Spreading data
You can use the Spread Data tool to spread data in a worksheet from a parent value 
in a hierarchy to its descendants. There are three different ways to spread data:

■ Evenly, so that each descendant receives an equivalent amount

■ Proportionally, so the descendants retain their original relationships to the 
parent

■ Based on the proportions in another dimension value

You can spread data either down columns or across rows in a worksheet.

Example 1: Spreading data evenly
Suppose that Expenses for the fourth quarter of 2000 are initially forecast to be 
$60,000 and is then reforecast to be $120,000. Suppose, too, that you want to 
determine the effect of the reforecast on the figures for each month in the quarter, 
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and you want the change to be evenly spread to each month. You could use an even 
spreading method to generate the figures shown in italics.

Example 2: Spreading data proportionally
Suppose that Expenses for the fourth quarter of 2000 are reforecast from $60,000 to 
$120,000. Suppose, too, that you want to determine the effect of the reforecast on the 
figure for each month in the quarter, and that you want each month’s figure to retain 
its original proportion to the total for the quarter. You could use a proportional 
spreading method to generate the figures shown in italics.

Example 3: Spreading data based on another dimension value
Suppose that Expenses for the fourth quarter of 2000 are reforecast to be $120,000 
and that you want to determine the effect of the reforecast on the figures for each 
month in the quarter so that monthly figures adopt the proportions in another 
dimension value (in this case, Sales). You could use the spread data tool to generate 
the figures shown in italics.

Oct 00 Nov 00 Dec 00 Q4 00

Expenses (forecast 1) $10,000 $20,000 $30,000 $60,000

Expenses (forecast 2) $40,000 $40,000 $40,000 $120,000

Oct 00 Nov 00 Dec 00 Q4 00

Expenses (forecast 1) $10,000 $20,000 $30,000 $60,000

Expenses (forecast 2) $20,000 $40,000 $60,000 $120,000

Oct 00 Nov 00 Dec 00 Q4 00

Sales $60,000 $90,000 $30,000 $180,000

Expenses $40,000 $60,000 $20,000 $120,000
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Example: Spreading data to visible elements only
In this example:

■ Expenses for the fourth quarter of 2000 are forecast to be $60,000

■ You want to determine the effect of the forecast on the figures for each month in 
the quarter

■ You want the change to be evenly spread to each month

In the worksheet, the months of Nov 00 and Dec 00 are visible, but Oct 00 is not. In 
the following scenario, there is no value for October, so the $60,000 is distributed 
evenly between Nov 00 and Dec 00.

In the next scenario, Oct 00 has a value of $10,000. Spread deducts this value from 
the $60,000 leaving $50,000 to spread evenly between Nov 00 and Dec 00.

Related information
For more information about calculating data in worksheets, search for the following 
topics in the Financial Analyzer Help system: 

“Growing Worksheet Data”
“Increasing Worksheet Data”
“Spreading Worksheet Data”

Oct 00 Nov 00 Dec 00 Q4 00

Expenses (forecast 1) $30,000 $30,000 $60,000

Oct 00 Nov 00 Dec 00 Q4 00

Expenses (forecast 1) $30,000 $30,000 $60,000

Expenses (forecast 2) $10,000 $25,000 $25,000 $60,000



Data Entry Forms 16-1

16
Data Entry Forms

Chapter summary
This chapter describes how to create and maintain data entry forms.

Who should read this chapter
Read this chapter if you are an administrator who is responsible for creating and 
maintaining data entry forms.

List of topics
This chapter includes the following topics:

■ About Data Entry Forms

■ Creating Data Entry Forms

■ Saving Data Entry Forms

■ Previewing Data Entry Forms

■ Managing Data Entry Forms
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About Data Entry Forms

Definition: Data entry forms
Data entry forms support Web-based data collection. An authorized user who has a 
Web browser can use a data entry form to accomplish the following tasks:

■ Enter new data into the shared database

■ Make changes to existing data in the shared database

■ Calculate summary data based on data that is newly entered

Data entry forms are designed for controlled data collection. Although users can 
enter data and run predefined calculations, they cannot use the forms to develop 
budgets, forecasts, and what-if analyses.

Data entry form workflow
An administrator creates a data entry form on an Administrator workstation in the 
Windows client and distributes the forms to the appropriate users. The 
administrator can distribute data entry forms to any type of user: administrator, 
budget, analyst, and external. 

A user accesses the data entry form through the Web interface. He or she opens the 
form and enters or modifies data. 

When data entry is complete, the user submits the data to the shared database. If a 
solve definition has been associated with one or more financial data items in the 
form, the data is recalculated.

Creating Data Entry Forms

About creating data entry forms
You create data entry forms on an Administrator workstation in the Windows client 
interface. 
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Data entry form content
Data entry forms can include the following:

■ One or more financial data items. Optionally, a solve definition can be 
associated with a financial data item.

■ Stored financial data items and formula financial data items.

■ Numeric financial data items and text financial data items. 

Data Entry Form menu
When you create a new data entry form or open an existing one on an 
Administrator workstation, the Data Entry Form menu becomes available on the 
menu bar. 

The following table describes the options on the Data Entry Form menu.

Process for creating a data entry form
Follow these steps to create a new data entry form.

1. From the File menu, choose New. 

Result: A list of document types appears.

Menu item Function

Form Options Specify elements that will display in a data entry form. You can:

■ Show or hide text elements such as titles, subtitles, and footnotes

■ Enter annotations

■ Specify how NA values will be displayed

Data Options Use the Number Format submenu to specify the number format 
(positive, negative, decimal) for a financial data item.

Use the Calculations submenu to associate a solve definition with a 
financial data item.

Dimension 
Labels

Specify the text that will be used for row, column, and page labels.

Auto 
Redisplay

When this option is turned on, a data entry form is automatically 
redisplayed after a change in layout or dimension selections.

Asymmetric 
Format

Join the values of two objects and create a custom asymmetric 
arrangement of their values.
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2. From the list of document types, choose Data Entry Form and click OK.

3. Using the Selector, select financial data items, dimensions and dimension values 
for the form. For more information about selecting dimension values, see 
Chapter 7.

Note: You can select text financial data items as well as numeric financial data 
items.

4. Arrange the layout of the dimensions by moving and swapping dimension tiles 
in the row, column, or page positions. 

5. You can associate a solve definition with a financial data item in the form. For 
more information, see “Example: Associating a solve definition with a financial 
data item” on page 16-6. 

6. You can apply positive, negative, and decimal formats to a financial data item. 
For more information, see “Example: Specifying data formats for financial data 
items” on page 16-7.

7. You can specify column width, row height, and certain display elements such as 
title, subtitle, and footnote. For a list of options, see “Specifying display 
elements and formatting” on page 16-7.

8. You can combine the values of two dimensions, or the values of a dimension 
and a financial data item to create an asymmetric combination. For more 
information, see “Including asymmetric formatting in a data entry form” on 
page 16-8.

9. You can lock specific data cells so that users cannot overwrite data. For more 
information, see “Preventing users from overwriting data” on page 16-9.
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Example: Data entry form on Administrator workstation
The following illustration shows how a data entry form might look after an 
administrator creates the form on an Administrator workstation. 

Including a solve definition in a data entry form
You can associate a solve definition with a financial data item in a data entry form. 
When a user submits data to the shared database, changes the page, or clicks the 
Recalculate button, the solve definition calculates new data values.

The solve determines the minimum tree need to recalculate the data. Therefore, 
calculations are limited to the data that is included in the form.

Note: If the solve definition has a model, place the model definition in the row or 
column position. Recalculation will not occur if it is in the page position. If the solve 
has a hierarchy, you can place it any position. 
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Procedure: Associating a solve definition with a financial data item
To associate a solve definition with a financial data item in a data entry form, 
choose Data Options from the Data Entry Form menu and then choose 
Calculations from the submenu. This opens the Calculations dialog box, where you 
can select a financial data item and associate it with a solve.

Example: Associating a solve definition with a financial data item
The following example shows the Calculations dialog box. In the example, the 
Actuals solve definition is associated with the Actuals financial data item.

Specifying data formats for financial data items
You can specify numeric formats for financial data items in a data entry form. To do 
this, choose Data Options from the Data Entry Form menu and then choose 
Number Format from the submenu. This opens the Number Format dialog box, 
where you can select a financial data item and specify a format for representing 
positive, negative, and decimal numbers.
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Example: Specifying data formats for financial data items
The following illustration shows the Number format dialog box. In this example, 
format information has been entered for three financial data items.

Specifying display elements and formatting
You can specify elements such as a title, subtitle, footnote and an annotation to 
include in a data entry form. You can also specify the type of row, column, and page 
labels that will appear in the form.

Specifying form options
Choose Form Options from the Data Entry Form menu to specify the following 
types of information: 

■ How NA data is displayed in the form. 

■ Whether the form displays title, subtitle, and footnote.

■ Annotation. You might use this feature to provide instructions for using the 
form. You can enter a text annotation or provide a URL link.
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Specifying label options
Choose Dimension Labels from the Data Entry Form menu to specify the type of 
labels that will display for the dimensions in the form. For each dimension, you can 
choose one of the following label types:

■ Automatic — Displays the most appropriate label, based on the amount of 
space

■ Description — Displays the name of the dimension value

■ Row label — Displays the row label text for the dimension value

■ Column label — Displays the column label text for the dimension value

Other options
In addition to the options that are available from the Data Entry Form menu, you 
can perform other tasks as follows: 

■ You can use the Edit bar to edit the text for the title, the subtitle, and the 
dimension label text.

■ You can choose Column width from the Format menu to modify the width of 
columns in the form. This is for viewing purposes only; the modification will 
not be reflected in the Web interface.

■ You can choose Row height from the Format menu to modify the height of 
rows in the form. This is for viewing purposes only; the modification will not be 
reflected in the Web interface.

Including asymmetric formatting in a data entry form
You can combine the values of two dimensions, or the values of a dimension and a 
financial data item that are part of a data entry form to create an asymmetric 
combination. The asymmetric combination gives you access to all of the values of 
both dimensions and provides flexibility for positioning the values along the rows, 
columns, or pages of the form.

To create an asymmetric data entry form, choose Asymmetric Format from the Data 
Entry Form menu. This opens the Create Asymmetric Combination dialog box, 
where you can set up the asymmetric combination.

Note: You create an asymmetric data entry form in the same way that you create an 
asymmetric report. Refer to the topic “Creating Asymmetric Reports” on page 13-7 
for details on implementing asymmetric formatting.
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Preventing users from overwriting data
Data that is entered into a data entry form and submitted to the shared database can 
overwrite existing data. You can prevent users from overwriting data to which they 
should not have access by locking data at the financial data item level. For example, 
you might want to lock cells that are associated with data from a previous time 
period. 

To lock cells, you must define a write access profile that specifically denies user 
access to the data that is contained in these cells. Refer to the topic “Creating Write 
Access Profiles” on page 12-9 for information about denying write access.

When a user views the data entry form through the Web interface, locked cells will 
be displayed in gray.

Related information
For more information about creating data entry forms on an Administrator 
workstation, search for the following topics in the Financial Analyzer Help system: 

“Creating a Data Entry Form”
“Choosing a Format for Numbers in a Data Entry Form”
“Displaying Dimension Labels in a Data Entry Form”
“Including a Footnote in a Data Entry Form”
“Including a Subtitle in a Data Entry Form”
“Including a Title in a Data Entry Form”
“Including Annotations in a Data Entry Form”
“Including Asymmetric Formatting in a Data Entry Form”
“Including a Solve Definitions in a Data Entry Form”
“Creating a Write Access Profile”

Saving Data Entry Forms

About saving data entry forms
After you create a data entry form, you can save it in your personal database. 

Saving a new data entry form
When you save a new data entry form, you enter a unique name for the form. 
Optionally, you can enter one or more keywords that can be used to access the form 
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in the Windows client environment. You also have the option to replace your 
default data entry form template with the current data entry form. 

Choose Save or Save As from the File menu to save a new data entry form. 

Saving changes to a data entry form
When you save changes to an existing data entry form, you can overwrite the 
original form, or you can save the modified form under a new name and preserve 
the original. 

Choose Save to overwrite the original form and Save As to save your changes as a 
new form with a unique name.

Related information
For more information about saving data entry forms on an Administrator 
workstation, search for the following topics in the Financial Analyzer Help system: 

“Saving a New Data Entry Form”
“Saving Changes to a Data Entry Form”

Previewing Data Entry Forms

Printing a data entry form
You can print a data entry form to preview its contents. Choose Print from the File 
menu to print the form.

Note that certain elements might not appear on the form when you print it. For 
example, if you have entered an annotation, the annotation text will not be 
displayed. Also, you cannot distinguish cells that have been locked from those that 
have not been locked. In order to see exactly how the form will appear to Web users, 
you must distribute the data entry form and view it in the Financial Analyzer Web 
interface. 

When you open the data entry form in the Financial Analyzer Web interface, you 
can see all parts of the form, including annotations and locked cells. Observe how 
the data fits in the columns. If necessary, you might want to go back to the 
workstation and modify the form. 
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Example: Data Entry form in the Web interface
The following illustration shows how a data entry form might appear in the 
Financial Analyzer Web interface. 

Related information
For information about working with data entry forms on the Web, see Chapter 20.

Distributing Data Entry Forms

About distributing data entry forms
You must distribute a data entry form to all users who will use the form to enter 
data. You can distribute data entry forms to any type of user: administrator, budget, 
analyst, or external.
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Distributing associated objects
When you distribute a data entry form, its dimension values, hierarchies, and 
model must also be explicitly distributed. If only a subset of the dimension values 
are distributed, then only that subset will appear when the form is viewed in the 
Web interface. 

If the data entry form includes a solve definition, the solve is automatically 
distributed with the form. However, if the solve includes a model, you must also 
distribute the models or hierarchies associated with the solve. 

If you have added the form to a folder, you must distribute the folder.

Procedure: Distributing a data entry form
To distribute a data entry form, select Distribution, Distribute Structures from the 
Manage menu. Then choose Data Entry Form as the structure to distribute. 

Managing Data Entry Forms

Modifying data entry forms
You can open a saved data entry form and modify the data selections, layout, 
calculations, and formats. You can also choose Delete from the File menu to delete 
the form, and Rename option from the File menu to rename the form. 

Adding data entry forms to folders
You can organize data entry forms within folders so that users can locate them 
quickly and easily. Choose Maintain Folders from the Tools menu to add your data 
entry forms to one or more folders. Alternatively, you can open the data entry form, 
and choose Add to Folder from the File menu. You will be prompted to select a 
folder. 

Distributing modified data entry forms
As you modify data entry forms, you distribute them to your users. 
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Related information
For more information about managing data entry forms on an Administrator 
workstation, search for the following topics in the Financial Analyzer Help system:

“Opening a Data Entry Form”
“Closing a Data Entry Form”
“Deleting a Data Entry Form”
“Renaming a Data Entry Form”
“Adding the Current Data Entry Form to a Folder”
“Removing Asymmetric Formatting from a Data Entry Form”
“Distributing Structures”
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17
Folders

Chapter summary
This chapter describes folders and how to manage them.

Who should read this chapter
You need to know the information in this chapter if you are an Analyst, Budget or 
Administrator workstation user who will be using folders to manage documents.

List of topics
This chapter includes the following topics:

■ About Folders

■ Managing Folders

About Folders

Definition: Folders
You can use folders to organize the documents that you create and save in your 
database. Folders:

■ Are objects that you create and name expressly for the purpose of grouping 
your documents so that you can work with them more efficiently

■ Enable you to organize documents logically, which means that you have 
complete control over the way in which your documents are arranged in each 
folder
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For example, you might always want to print a certain group of documents together 
at the end of the month. You can group these documents together in a folder, so that 
you can print them together whenever you need to. You can also choose the order in 
which the documents in a folder are printed.

Storing folders
Documents are stored independently from folders in the database. This means that 
if you delete a folder with documents in it, only the folder is deleted, not the 
documents that it contains. Note, however, that if you are an administrator and you 
distribute a folder, its contents are distributed along with the folder. You can also 
add documents to more than one folder, so that you have maximum flexibility in 
organizing your documents in the way that makes the most sense for you.

Managing Folders

Creating folders
You can create folders to help you organize your documents. When you create a 
folder it becomes part of your personal database. Only you can delete it.

Adding documents to folders
You can add the document that you are currently working with to a folder. You are 
not required to open the document in order to add it to a folder. Any document in 
your database can be added to any folder in your database. You can also add a 
document to more than one folder.

Viewing the contents of folders
You can see which documents are contained in your folders at any time.

Printing documents from folders
You can group documents together in a folder so that you can print them together 
whenever you need to. You can also choose the order in which the documents are 
printed out. When you print documents from a folder, the documents you select are 
printed in the order in which they are listed in the Print Multiple dialog box.
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Renaming folders
You can change the name of any folder. When you change the name of the folder, 
you do not alter its contents.

Deleting folders
When you no longer need a folder, you can delete it. Note that when you delete a 
folder, the contents of that folder are not deleted from your database. 

Related information
For more information about working with folders, search for the following topics in 
the Financial Analyzer Help system: 

“Adding Documents to Folders”
“Adding Multiple Documents to Folders”
“Creating Folders.”
“Deleting Folders”
“Printing Multiple Documents in One Session”
“Renaming Folders”
“Viewing Folders”
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18
The Financial Analyzer Web Interface

Chapter summary
This chapter describes how to access, navigate, and exit Financial Analyzer in the 
Web environment.

List of topics
This chapter includes the following topics:

■ Accessing Financial Analyzer through the Web Interface

■ Financial Analyzer Page

■ Document Workspace

■ Navigation List

■ Online Help

■ Closing a Financial Analyzer Web Session
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Accessing Financial Analyzer through the Web Interface

Description: Financial Analyzer Web interface
The Financial Analyzer Web interface provides access to reports, graphs, and data 
entry forms through a Web browser. 

System requirements
In addition to the standard Financial Analyzer server components, the following 
server components must be installed: 

■ Express Server, including Oracle Express Web Agent. The following 
configuration options must be selected in Express Configuration Manager: 

■ The Web Authentication Type property on the Web Agent tab must be set to 
BASIC

■ The RequirePasswordEncryption property on the Security tab must be set 
to NO

■ A supported Web server such as Apache

 For more information, refer to the Oracle Financial Analyzer Installation and Upgrade 
Guide. 

Browser requirements
Users must have the appropriate browser installed on the PC. For information 
about Web browser requirements, refer to the release notes for Oracle Express Web 
Agent.

User requirements
To access Financial Analyzer through the Web interface, you must have a valid user 
ID. You must also be set up as a user in Financial Analyzer.
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Methods of access
Financial Analyzer can be configured for direct access, or for access through Oracle 
Applications. You administrator will tell you which method to use and will provide 
the required URL and login information.

Login tips
Following are some guidelines for logging in:

■ If the system prompts you to download certain files to your machine for local 
storage, accept the files. This will enable the browser to load Web files only 
once. 

■ Check that cookies are enabled for your browser. If you do not accept cookies, 
you cannot access the Financial Analyzer database.

■ Ensure that Java and JavaScript are enabled for your browser.

■ If you encounter errors, try clearing your browser’s cache and resetting the 
browser.

■ Bookmark your start page for easy access.

■ Maximize your browser window. This ensures that the application will run at 
full size.

■ If you will be using a language other than English, ensure that your browser is 
set to that language. The browser’s language setting determines the language in 
which the application is displayed.

Note: Login sessions have a maximum idle time. A session will terminate 
automatically if it is idle for this time period.
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Financial Analyzer Page

Description: Financial Analyzer page
The Financial Analyzer page appears when you access Oracle Financial Analyzer 
through the Web interface. The Financial Analyzer page is comprised of two frames: 
the navigation list in the left frame and the document workspace in the right frame.

Example: Financial Analyzer page
The following illustration shows the Financial Analyzer page.
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Document Workspace

Description: Document workspace
An open document is displayed in the document workspace. You can work with the 
following types of Financial Analyzer documents:

■ Reports — Display data in tabular format. For information about working with 
Web reports, see Chapter 19.

■ Graphs — Display data in graphical format. For information about working 
with Web graphs, see Chapter 19.

■ Data Entry forms — Enable users to enter data and submit the data to the 
shared database. For information about working with Web data entry forms, see 
Chapter 20.

Adjusting the document workspace for reports and graphs
By default, when you open a report or graph, the document appears in the right 
frame of the workspace, while the navigation list appears in the left frame. 

You can adjust the size of the document workspace for an open report or graph as 
follows: 

■ Use the minimize button at the top of the navigation list to minimize the 
navigation list. 

The current document expands to full screen size and overlays the navigation 
list.

■ Use the restore button at the top of the navigation list to restore the navigation 
list. 

The current document returns to its default size.
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Example: Document in expanded workspace
The following example illustrates a sample report as it would appear after the 
document workspace has been enlarged. Note how the document overlays the 
navigation list. This contrasts with the default display shown in “Example: 
Financial Analyzer page” on page 18-4.

Data entry forms always display in an expanded workspace
A data entry form always occupies the entire document workspace. You must close 
the form in order to access the navigation list. 

Navigation List

Description: Navigation list
The navigation list, located in the left frame of the Financial Analyzer page, enables 
you to work with Financial Analyzer objects such as reports, graphs, data entry 
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forms, folders, and saved selections that have been distributed to you. If you are an 
analyst user, you can also use the navigation list to create, save, and view personal 
documents, folders, and saved selections.

Example: Navigation list
The following illustration shows how the Financial Analyzer navigation list might 
appear to an analyst user. The Navigation toolbar is at the top; Financial Analyzer 
objects populate the list.
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Navigation tools
The Navigation toolbar appears at the top of the navigation list. The toolbar buttons 
enable you to perform the following tasks.

Navigation list icons
The icons that appear in the navigation list depend on your user privileges and the 
objects that have been distributed to you. The following table illustrates objects that 

Button Name Function

New Create a new report, graph, folder, or saved selection.

Note: Only analyst users have access to this command. 
Administrators and budget users access objects from 
the shared database.

Find Search for documents and saved selections by name. 

Delete Delete a personal report, graph, folder, or saved 
selection. 

Note: Only analyst users have access to this command. 
DBA and budget users access data from the shared 
database.

Refresh View Refresh your view of the shared database. If there are 
pending data submission tasks, you will be warned 
that the associated data will not be visible until these 
tasks have been processed.

View Pending 
Updates

View information about pending submission tasks.

Exit Exit Financial Analyzer.

Help Access Financial Analyzer HTML Help.
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might appear in your navigation list. The table also lists the commands that are 
accessible when you right-click an object. 

Object Description Right-click Commands

Main Documents folder; contains 
documents and document folders

New Report 
New Graph
Paste 
New Folder 
Find Documents

Note: Only analyst users can create 
new reports, graphs, and folders and 
use the Paste command.

Public (shared) documents folder Find Documents
Properties

Report that has been distributed to 
you 

Open
Properties

Graph that has been distributed to 
you 

Open
Properties

User-defined folder

Note: Only analyst users see this 
object. 

Rename
Delete
Paste
Find Documents
Properties

User-defined report 

Note: Only analyst users see this 
object. 

Open
Rename
Delete
Cut
Copy
Paste 
Properties

User-defined graph

Note: Only analyst users see this 
object. 

Open
Rename
Delete
Cut
Copy
Paste 
Properties
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Online Help

Accessing help
Use the Help button, located on the Navigation toolbar to access the Financial 
Analyzer HTML Help system.

When a document is open, you can also click the Help button on the Document 
toolbar to access help.

Displaying Help for a specific task
Each function includes a Help button. Click this button to view instructions for the 
task at hand. 

Printing Help
You can use your browser’s print function to print Help files.

System folder for saved selections New Saved Selection
Find

Note: Only analyst users can create 
new saved selections.

System folder for saved selections 
within a dimension

New Saved Selection 
Find

Note: Only analyst users can create 
new saved selections.

Saved selection that has been 
distributed to you 

View
Properties

User-defined saved selection

Note: Only analyst users see this 
object. 

Edit
Rename
Delete
Properties

Object Description Right-click Commands
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Closing a Financial Analyzer Web Session

Procedure: Closing a Web session
To close Financial Analyzer, click the Close button on the Navigation toolbar. 

Alternatively, you can click the Windows close button (X), located in the upper right 
corner of the screen. This closes the browser as well as the application. 

What happens when you close Financial Analyzer?
Exiting terminates the application immediately. If you are an analyst user and you 
have modified an open document, you will be prompted to save the document. 
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19
Working with Web Reports and Graphs

Chapter summary
This chapter describes how to work with Financial Analyzer reports and graphs in 
the Web environment.

List of topics
This chapter includes the following topics:

■ About Web Reports and Graphs 

■ Creating Web Reports and Graphs

■ Selecting Data for Web Reports and Graphs 

■ Arranging and Viewing Data in Web Reports and Graphs

■ Formatting Web Reports

■ Formatting Web Graphs

■ Printing Web Reports and Graphs

■ Saving Web Reports and Graphs

■ Copying Data from Web Reports

■ Exporting Data from Web Reports and Graphs

■ Using Folders to Manage Web Reports and Graphs

■ Working with Reports and Graphs in the Navigation List
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About Web Reports and Graphs

Description: Web reports
Web reports display multi-dimensional data in tabular format. You can open and 
work with reports that have been distributed to you by your administrator. If you 
are an analyst user, you can also create and save personal reports.

Example: Web report
The following illustration shows a Web report.
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Description: Web graphs
Web graphs display multi-dimensional data in graphical format. You can open and 
work with graphs that have been distributed to you by your administrator. If you 
are an analyst user, you can also create and save personal graphs.

Types of graphs
The following list describes the types of graphs that are available in the Web 
interface.

Graph Type Graph Subtypes Description

Bar Clustered
Clustered Dual-Y
Stacked

Compares data associated with different 
dimension values

Line Absolute
Absolute Dual-Y
Stacked
Stacked Dual-Y
Percentage

Shows trends over time and emphasizes 
rates of change

Area Absolute
Stacked
Percentage

Shows trends and emphasizes the degrees of 
change

3D None Isometric presentation of an area stacked 
graph, representing the same type of data, 
but from a different perspective

Single Pie None Shows part-to-whole relationships

Scatter Dual-Y Shows relationships between two measures
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Example: Web graph
The following illustration shows a Web graph. 

Opening a report or graph
Reports and graphs are displayed as objects in the navigation list, located in the left 
frame of your Web browser. Some reports and graphs might appear within 
individual folders, while others appear in the main Documents folder.

To open a report or graph, double-click its folder. Then double-click the document. 
Alternatively, you can right-click the document and choose Open from the popup 
menu.

Note: To search for a report or graph, right-click the main Documents folder or a 
specific document folder, choose Find Documents, and enter a name or name 
fragment. The search is case insensitive and will be limited to the selected folder.
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Using the Document toolbar to work with reports and graphs
The Document toolbar appears at the top of an open report or graph in the Web 
interface. The toolbar buttons enable you to perform the following tasks: 

Button Name Function

Select Data Select values from a list and access various data 
selection tools. Also sort selections.

Apply Saved 
Selection

Replace the current values in the document with a 
saved selection of values.

Change Layout Change the layout of the report or graph.

Note: Asymmetric reports that join a financial data 
item and a dimension do not support this function.

Change 
Document Type

Change a report to a graph or a graph to a report. For a 
graph, you can also choose the graph type.

Note: Asymmetric reports that join a financial data 
item and a dimension do not support this function.

Export Export data and labels from the report or graph to a 
comma delimited (.csv) or tab delimited (.txt) file.

Format Number For a report, specify number formats.

Format 
Document

Specify title, subtitle, and footnote text for a report or 
graph. For a report, specify formats for data, rows, 
columns, and page labels. For a graph, specify formats 
for tick labels.

Color Coding For a report, define and apply color formats based on 
data conditions. 
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Closing a report or graph
To close a report or graph, click its close button, located in the upper right corner. 

If you are an analyst user, and you have modified the report or graph, you will be 
prompted to specify whether you want to save the document. 

Creating Web Reports and Graphs

Who can create reports and graphs?
If you are an analyst user, you can create personal reports and graphs. 

Save As Save the report or graph.

Note: Only analyst users have access to this command.

Copy to 
Clipboard

Copy selected data to the Windows clipboard.

Print Print the report or graph.

Help Display Financial Analyzer HTML Help.

Button Name Function
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Procedure: Creating a report or graph
To create a report or graph, on the Navigation toolbar, click the New button:

and choose New Report or New Graph. 

Alternatively, you can right-click Documents in the navigation list and choose New 
Report or New Graph from the popup menu.

Result: A default report or graph appears. The title “Untitled Report” or “Untitled 
Graph” appears on the document’s title bar. 

Selecting Data for Web Reports and Graphs

About selecting data
You specify the slice of data that you want to include in a report or graph. In the 
context of a report or graph, a data slice is defined by one or more financial data 
items and a set of dimension values. 

Whether data selections persist beyond your current working session depends on 
the type of user that you are set up to be. 

■ If you are an analyst user and save the report or graph, the data selections are 
saved with the document.

■ If you are not an analyst user, you can select data while the report or graph is 
open in the workspace, but your selections will not be retained when you close 
the document.

Data selection tools and techniques
Use the Select Data button on the Document toolbar to open the Select Data dialog 
box where you can choose a dimension and access tools that enable you to choose 
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values from a list, select data by criteria, order your selections, and apply a saved 
selection of values. 

Data Selection toolbar
The Data Selection toolbar appears at the top of the Select Data dialog box. The 
toolbar buttons enable you to perform the following tasks.

Button Description Function

Save Current 
Selection

Save selected values as a custom saved selection.

Note: Only analyst users have access to this command.

Choose Values by 
Family

Select values based on a specified family relationship. 

Choose Values by 
Attribute

Select values that share a specified attribute. 

Choose Matching 
Values

Select values that match a specified character string. 

Choose Values 
Meeting Value 
Condition

Select values based on the way in which data values 
for a financial data item compare with a value or range 
of values. 

Choose Values 
Meeting 
Financial Data 
Item Condition 

Select values based on the way in which data values in 
one financial data item compare with data values in 
another financial data item. 
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Example: Selecting data
The following illustration shows the Select Data dialog box. In the example, the user 
has selected four values in the Custom Time dimension. 

Choose Top/
Bottom Values

Select the largest and smallest values for a financial 
data item. 

Sort Sort selected values. 

Button Description Function
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Ordering selections
Once you have selected dimension values, you can arrange them in the Selected box 
in the order in which you want them to appear. You can use the following 
techniques to order values:

■ Use the Sort tool on the Data Selection toolbar to specify sorting criteria

■ Drag and drop values to specific positions

■ Use a right-click function to change the relative position of a value or values 

Procedure: Using the Sort tool to sort values
To use the Sort tool to sort values in the Selected box, follow these steps: 

1. Click the Sort button on the Data Selection toolbar. 

2. Select a sort option. Depending on the dimension and whether a hierarchy is in 
use, the following options are available:

■ name — Sorts values in alphabetical order by name. You can choose A to Z 
or Z to A. 

■ data value — Sorts values numerically based on a specified financial data 
item and the qualifying dimension values for that financial data item. You 
can choose high to low or low to high. 

■ hierarchy — Sorts values based on hierarchy. Child values are grouped by 
parent values. You can choose top to bottom or bottom to top. 

■ depth — Sorts values by depth of hierarchical relationship. You can choose 
top to bottom or bottom to top. 

3. You can choose the Preview button to preview the results of the sort. 

4. Choose OK.

Procedure: Using drag and drop to order values
To use drag and drop to order values in the Selected box, click one or more values 
and drag them to a new location. As you move the selection, a black bar appears to 
help you identify the current position. When the black bar is under the desired 
location, release the selection.
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Procedure: Using a right-click function to order values
To use a right-click function to order values in the Selected box, follow these steps:

1. Right-click the value whose position you want to change. 

Result: A popup menu appears, listing options for changing the position of the 
value. The options vary depending on the current position of the selected value.

2. Choose the option that specifies how you want to position the value: 

■ To place the selected value first in the list, choose Move to top.

■ To place the selected value last in the list, choose Move to bottom.

■ To place the selected value below another value in the list, choose Move 
below, choose the target value, and then choose OK.

You can also choose Remove to remove the selected value from the selected list. 

Shortcut: Saving selections
If you are an analyst user, you can save your selections to use again in other 
documents. Saved selections are useful when you want to quickly retrieve a group 
of values without repeating the steps that you followed to select them. 

For example, you might use the Family tool to define a saved selection that selects 
all products that are children of a particular parent. As your administrator adds 
new products and distributes structures, the products will automatically be added 
to your saved selection.

You can define a saved selection directly from the navigation list, or you can define 
it on-the-fly as you select data for a report or graph.

Procedure: Defining a saved selection from the navigation list
To define a saved selection from the navigation list, follow these steps: 

1. On the Navigation toolbar, click the New button. 

and choose New Saved Selection from the popup menu. 
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Alternatively, you can right-click the Saved Selections folder in the navigation 
list or the Saved Selections folder for a specific dimension. Then choose New 
Saved Selection from the menu. 

Result: The New Saved Selection dialog box appears. If you clicked the Saved 
Selections folder, the New Saved Selections dialog box displays a default 
dimension, which you can change. If you clicked a Saved Selections folder for a 
specific dimension, the Saved Selections dialog box displays the selected 
dimension.

2. In the Name box, enter a name for the saved selection (up to 70 characters).

3. The Dimension box displays a default dimension. If this is not the dimension 
for which you want to create the saved selection, select an alternate dimension.

4. Click the Selector button. 

Result: The Select Data dialog box appears.

5. Choose the values that will comprise the saved selection. 

You can select values from a list. You can also use the buttons on the Data 
Selection toolbar to select values by specific criteria and sort your selections. 

6. When your value selections are complete, choose OK. 

Result: The New Saved Selection dialog box displays. The Selections box 
displays the values that you chose.

7. Specify how you want the values to be saved: 

■ Save steps — Saves the steps that you followed to select the values

■ Save members — Saves the actual dimension values

Note: If you used the drag and drop method or a right-click function to sort 
values for the selection, then you will not be able to save steps.

8. In the Description box, you can enter optional text to identify the saved 
selection.

9. Choose OK to save the selection.
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Procedure: Saving a selection from within a document
To save a selection of values as you are selecting data for a document, follow these 
steps:

1. With the document open in the workspace, click the Select Data button on the 
Document toolbar. 

2. From the drop-down list, select a dimension.

Result: The Select Data dialog box appears, displaying values for the 
dimension.

3. Select the values that will comprise the saved selection. 

You can select individual values from a list. You can also use the buttons on the 
Data Selection toolbar to select values by specific criteria and sort your 
selections.

4. When your selections are complete, click the Save Current Selection button on 
the toolbar. 

Result: The Save a Selection for Dimension dialog box appears.

5. In the Save a Selection for Dimension dialog box, enter information for the saved 
selection as follows:

a. In the Save current selection as box, enter a name for the saved selection (up 
to 70 characters).

b. In the Description box, you can enter optional text that describes the saved 
selection.
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c. Specify how you want the values to be saved: 

* Save steps — Saves the steps that you followed to select the values

* Save members — Saves the actual dimension values

Note: If you used the drag and drop method or a right-click function to sort 
values for the selection, you will not be able to save steps.

6. Choose OK to save the selection.

Procedure: Applying a saved selection to a document
To apply a saved selection to a document, follow these steps: 

1. With the document open in the workspace, choose the Apply Saved Selection 
tool on the Document toolbar. 

Result: A pop-up menu appears, listing the dimensions in your database for 
which there are saved selections.

2. Select a dimension.

Result: The Apply Saved Selection dialog box appears, listing saved selections 
for that dimension.

3. Choose a saved selection and choose OK. 

Result: The dimension values in the document change to reflect the saved 
selection.

Arranging and Viewing Data in Web Reports and Graphs

Changing the document layout
You can rearrange the dimensions on the page of a report or graph to view your 
data in various ways. 
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Whether layout selections persist beyond your current working session depends on 
the type of user that you are set up to be. 

■ If you are an analyst user and save the report or graph, the layout is saved with 
the document.

■ If you are not an analyst user, you can change the layout while the report or 
graph is open in the workspace, but the layout will not be retained when you 
close the document.

Using the Change Layout button to change the layout of a report or graph
With the document open in the workspace, click the Change Layout button on the 
Document toolbar. 

This opens the Change Layout dialog box, where you can change the position of 
one or more dimensions as follows: 

■ In a report, you can exchange one dimension with another, position a 
dimension before or after another dimension, or move a dimension to the row, 
column, or page edge.

■ In a graph, you can rotate a specific dimension, the page edge, the group (which 
corresponds to the X-axis), or the series (which corresponds to the legend).

Using drag and drop to change the layout of a report
In a report, you can use the row, column, and page selectors to drag and drop 
dimensions to new positions. These selectors are located beside the row, column, 
and page labels and appear similar to a stoplight, as shown following.

If you drag a row, column, or page selector and drop it on another, or drag it to a 
new position, the dimension moves with the selector. 
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Following are some tips for dragging and dropping dimensions:

■ If you drag a dimension near another dimension and the dimension turns grey, 
this indicates that the two dimensions will exchange (swap) positions. 

■ If you drag a dimension and a black bar appears, this indicates that the 
dimension will be placed on the page edge.

Drilling through levels of data in a report or graph
If a dimension is organized by a hierarchy, you can view data at various levels of 
aggregation in a report or graph by drilling within aggregate dimension values. For 
example, if the document displays a geography that includes lower level values, 
you can “drill down” and expand the display to show component geographies. You 
can then “drill up” to re-aggregate the display. 

In a report, you can drill a dimension value that is in the row or column position if a 
drill icon appears to the left of the dimension value name. The icon shape changes, 
depending on whether you can expand or collapse the value.

In a graph, you can drill a dimension value that is on the X or Y axis if a plus (+) or 
minus (-) symbol and the words “Drill down (or up) from dimension value name” 
appears when you sweep the cursor over the value. 

Whether drill status persists beyond your current working session depends on the 
type of user that you are set up to be. 

■ If you are an analyst user and save the report or graph, the drill status is saved 
with the document.

■ If you are not an analyst user, you can drill data while the report or graph is 
open in the workspace, but selections will not be retained when you close the 
document.

Changing the document type
You can change a report to a graph, or a graph to a report. You can also change the 
type of graph. 

Whether the document type selection persists beyond your current working session 
depends on the type of user that you are set up to be. 

■ If you are an analyst user and save the report or graph, the document type 
selection is saved with the document.
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■ If you are not an analyst user, you can change the document type while the 
report or graph is open in the workspace, but your selections will not be 
retained when you close the document.

Procedure: Changing a report to a graph or a graph to a report
With the document open in the workspace, click the Change View Type button on 
the Document toolbar. 

This opens the Change View Type dialog box, where you can select an alternate 
format. 

Procedure: Changing the type of graph
With the graph open in the workspace, click the Change View Type button on the 
Document toolbar. 

This opens the Change View Type dialog box, where you can select an alternate 
graph type. For information about graph types, see “Types of graphs” on page 19-3.

Paging through a report or graph
Report or graph data is displayed one page at a time. You can use the page control 
to display a page other that the one that is currently in view. For example, the 
current page might show data for Total Product, but you can select another product 
from the list to see its data. 
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Adjusting columns and rows in a report
You can change the size of rows and columns in a report so that the information is 
easier to read. 

Whether row and column sizing persists beyond your current working session 
depends on the type of user that you are set up to be. 

■ If you are an analyst user and save the report, row and column sizing is saved 
with the document.

■ If you are not an analyst user, you can size rows and columns while the report is 
open in the workspace, but your settings will not be retained when you close 
the document.

Procedure: Using drag and drop to adjust columns and rows
With the document open in the workspace, position the cursor on the border of a 
row or column label. When the cursor changes to a double arrow, click and move 
the border. 

Procedure: Using Format options to adjust columns and rows
With the document open in the workspace, click the Format Document tool on the 
Document toolbar.

Result: The Format Document dialog box appears.

Use the Rows tab to specify row sizing and the Columns tab to specify column 
sizing. 

For more information, see “Procedure: Formatting report rows” on page 19-22 and 
“Procedure: Formatting report columns” on page 19-22.
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Formatting Web Reports

Report format options
You can format the following elements in a report:

■ Data — Formats the data

■ Numbers — Formats numeric values 

■ Rows — Formats rows

■ Columns — Formats columns

■ Pages —  Formats page controls

■ Titles — Indicates whether a title, subtitle, and footnote will be displayed and 
provides the text for each element

■ Dimension label type — Specifies the type of dimension labels that will be 
displayed

You can also define special color format conditions that will apply when the data 
values for a financial data item meet specified criteria.

Whether format specifications persist beyond your current working session 
depends on the type of user that you are set up to be. 

■ If you are an analyst user and save the report or graph, your format selections 
are saved with the document.

■ If you are not an analyst user, you can make format selections while the report 
or graph is open in the workspace, but formatting selections will not be retained 
when you close the document.

Procedure: Formatting report data
To format the data in the body of a report, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears.
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2. Select the Data tab. 

3. Choose one or more data format options: 

■ Font properties — Select font name, size, color, bold/italic, background 
color 

■ Alignment — Specify the alignment for numeric values

■ Display Options

* Specify whether to show all rows or suppress rows with zero values, 
NA values, or both NA and zero values

* Specify whether to show or hide horizontal and vertical gridlines

4. Choose OK to apply your selections. 

Procedure: Formatting numbers in a report
To format numeric values in the body of a report, follow these steps:

1. Select the rows or columns for which you want to format numbers.

■ To select a column, click the tile under the column label.

■ To select a row, click the tile next to the row label.

2. Click the Number Formatting button on the Document toolbar.

Result: The Format Number dialog box appears. 

3. Select the desired format options:

Option Description

Number of Decimal Digits Number of decimal places (up to seven)

Positive Values Format for positive numbers

Negative Values Format for negative numbers

Scale Values Down By Scaling for large numbers

Formatting Precedence If there are conflicts in row, column and page 
formats, the precedence order for format options

Thousands Separator Displays thousands separator
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4. Choose OK to apply your selections.

Example: Number formats
The following illustration shows a report that includes number formatting. In this 
example, the first two columns have been formatted to display positive numbers 
with a plus sign (+).

Leading zeros Displays leading zeros

Currency/Percent Formatting Activates current/percent format options:

■ Symbol — Symbol for dollars, yen, pounds, 
francs, or percent

■ Positive Values — Format for positive values

■ Negative Values — Format for negative 
values

Option Description
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Procedure: Formatting report rows
To format the rows in a report, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears. 

2. Select the Rows tab. 

3. Choose one or more row format options: 

■ Font properties — Select font name and size, color, bold/italic, background 
color for row label text

■ Alignment — Specify the alignment for row label text

■ Display Options — Specify whether to indent rows by hierarchical level 
and the number of indent characters to use 

■ Row Sizing — Select Autosizing by Label, Equal Sizing, or None

4. Choose OK to apply your selections. 

Procedure: Formatting report columns
To format the columns in a report, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears. 

2. Select the Columns tab. 
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3. Choose one or more column format options: 

■ Font Properties — Select font name, size, color, bold/italic, background 
color for column label text

■ Alignment — Specify the alignment for column label text

■ Column Sizing — Select an autosizing option, Equal Widths by Character, 
or None

4. Choose OK to apply your selections. 

Note: Applying autosizing to report rows or columns
If you have resized report rows or columns, but want to quickly return to the 
default autosize settings, click the Format Document button on the Document 
toolbar and choose an autosize option. Alternatively, you can right-click in the body 
of the worksheet and select an autosize option from the popup menu.

Autosize options are as follows:

■ Autosize Now — Applies default autosizing to rows or columns. Does not 
override manual resizing (drag and drop). 

■ Autosize All Now — Applies default autosizing to rows or columns. Overrides 
manual resizing (drag and drop). 

Note: If both rows and columns have custom settings, autosize options will not be 
available. 

Procedure: Formatting report page controls
To format the page controls in a report, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears. 

2. Select the Pages tab. 
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3. Choose one or more format options: 

■ Font Properties — Select font name, size, color, bold/italic, background 
color for page label text

■ Alignment — Specify the alignment for page label text

4. Choose OK to apply your selections. 

Procedure: Specifying report title, subtitle, and footnote for a report
To specify a title, subtitle and footnote for a report, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears. 

2. Select the Titles tab. 

3. Choose a text element (Title, Subtitle, or Footnote) and proceed as follows: 

a. Select font properties (name, size, color, bold/italic, background color) for 
the text.

b. Specify the alignment for the text.

c. In the Display Options box, choose Show to display the specified text 
element in the current document.

d. In the Text box, type the text for the title, subtitle, or footnote (498 
characters maximum). 

4. Repeat Step 3 for each text element that you want to include.

5. Choose OK to apply your selections. 
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Procedure: Selecting dimension label type for a report
To select the type of dimension labels to include in a report, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears. 

2. Select the Dimension Labels tab. 

3. In the Labels type box, select the cell next to a dimension whose label you want 
to change. 

4. Click the arrow in the cell to display a list of dimension label types. Choose one 
of the following options: 

■ Automatic — Displays the most appropriate label based on the amount of 
space available.

■ Long — Displays the name of the dimension value. (This is the text that was 
entered in the Name box of the Add a New Dimension Value dialog box 
when the dimension value was created.) 

■ Short — Displays the column label text for the dimension value. (This is the 
text that was entered in the Column Label box of the Maintain Dimension 
Value dialog box when the dimension value was created.) 

■ Medium — Displays the row label text for the dimension value. (This is the 
text that was entered in the Row Label box of the Maintain Dimension 
Value dialog box when the dimension value was created.) 

5. Repeat Step 4 for each dimension label that you want to set.

6. Choose OK to apply your selections. 
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Formatting reports based on data conditions (color coding)
You can create conditional format rules that will apply to a report only when data 
values for a financial data item meet specified criteria. This is referred to as color 
coding. Color coding enables you to highlight exceptions and map trends.

A color coding rule is composed of the following information: 

■ One or more conditions that the data must meet in order to have the selected 
formats. 

■ A set of formatting options that specify how the data that meets the conditions 
will look. 

Types of color coding conditions
Using color coding rules, you can implement conditions such as the following:

■ When data values for a financial data item meet a specified value condition, the 
data will display in a specified format. For example, you might define a rule 
that applies bold text and a green background to cells in which the value for 
Budget is greater than or equal to a specified amount. 

■ When values of a financial data item relate to the values of another financial 
data item in a specified way, the data will display in a specified format. For 
example, you might define a rule that applies italic text and a red background 
to cells in which the value for Budget is 10% greater than Budget a Year Ago. 

You can also combine two conditions within a single rule and specify whether the 
data must meet one or both conditions. For example, you might define a rule that 
applies a green background to cells in which the value for Budget is greater than or 
equal to a specified number and Budget is 10% greater than Sales Year Ago. 

Color coding format options
You can specify the following formats when you define a color coding rule: 

■ Stoplight formatting — Stoplight formatting is a special type of color coding 
that highlights trends. When you apply stoplight formatting, data cells that 
meet the conditions appear as solid blocks of color. The actual value for a cell 
becomes visible only when you select it. 

■ Font — You can specify font name, font size, and indicate whether the font is 
regular, bold or italic. If you selected stoplight formatting, font options are not 
available.
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■ Color —You can specify the font color. If you selected stoplight formatting, font 
color options are not available. 

■ Background color — You can specify the background color for the cell. If you 
selected stoplight formatting, the label for this option is “Cell Color.”

You can also specify that a rule use default formats for font or color. The default 
formats are the formats that have been set up in data formatting. If no formats have 
been specifically set, the formats in the document on which the document is based 
determine the defaults.

Using multiple conditions and rules
You can define one or two conditions for each rule and associate each financial data 
item in a report with a maximum of four rules. If the format associated with one 
rule conflicts with the format associated with another rule, the format that was 
defined last takes precedence.

Tip: Using value ranges rather than absolute values can help to avoid rule conflicts.

Procedure: Defining a color coding rule
To define a color coding rule for a report, follow these steps:

1. With the report open in the workspace, click the Color Coding button on the 
Document toolbar.

Result: If this is the first color coding rule for this report, the Color Coding 
Wizard starts up. If the report has at least one color coding rule, the Color 
Coding dialog box appears, from which you can view the existing rules and 
choose Add to define a new rule.

2. In the Color Coding Wizard -- Specify Financial Data Item dialog box, select the 
financial data item to which the color coding rule will apply. Choose Use 
Stoplight Color Formatting to apply stoplight formatting. 

3. Choose Next to continue.
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4. In the Color Coding Wizard -- Specify Data Condition dialog box, complete the 
Select by box as follows:

■ Choose value to compare the financial data item with a numeric value. 

■ Choose financial data item to compare the financial data item with another 
financial data item.

5. If you selected value in Step 4, proceed as follows:

a. In the where box, select a financial data item on which to base the value 
condition. You can select the default financial data item, or you can select 
an alternate financial data item.

b. In the is box, select an operator that specifies how data values in the 
selected financial data item must compare to the value in the value box. 

c. In the value box, specify a numerical value that the values in the financial 
data item will be compared to. 

6. If you selected financial data item in Step 4, proceed as follows:

a. In the where financial data item box, select the first of the two measures 
that you will compare. You can select the default financial data item, or you 
can select an alternate financial data item.

b. In the is box, choose the operator that specifies how the data values in the 
first financial data item must compare to the data values in the second 
financial data item.

c. In the financial data item box, specify the second financial data item to use 
in the comparison. You can select the default financial data item, or you can 
select an alternate financial data item.

d. You can specify a percentage or numeric value to include in the condition. 
Select percent if the value is a percent.

7. When the condition definition is complete, do one of the following:

■ Choose Next to continue. 

■ Choose Add a Second Data Condition to define a second condition for this 
rule. 
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8. To add a second data condition, define the condition in the Color Coding 
Wizard -- Specify Additional Data Condition dialog box. Then choose one of the 
following options: 

■ Apply when both first and second condition are met

■ Apply when either first or second condition is met

9. Choose Next to continue.

10. In the Color Coding Wizard -- Specify Appearance dialog box, specify the 
formats in which data that meets the condition or conditions will display. You 
can choose font size, font style, font color, and background color or you can 
select Default to use default formats for any element. 

Note: If you selected Stoplight Formatting in Step 2, you can only choose the 
cell background color. 

11. Choose Next to continue.

12. In the Color Coding Wizard -- Specify Name dialog box, review the summary 
description of the data conditions. You can also enter a name for the rule. 

Tip: You might want to use a name that describes the condition or conditions.

13. Choose Finish to continue. 

Result: The Color Coding dialog box appears. It includes information regarding 
the appearance, description, and financial data item for the rule.

14. Choose OK to apply the rule. 

Result: The report displays. If there are cells that meet a condition or conditions 
for a color coding rule, the data in these cells are formatted as specified. 
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Example: Color coded report
The following illustration shows a color-coded report. Data cells that meet the 
conditions “Revenue greater than 500,000” are displayed with a user-specified 
formatting.
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Example: Color coded report with stoplight formatting
The following illustration shows a color coded report with stoplight formatting. 
Data cells are displayed as solid blocks of color. An actual data value only appears 
when you click in a cell. 

Formatting Web Graphs

Graph format options
You can format the following graph elements:

■ Titles — Indicates whether a title, subtitle, and footnote will be displayed and 
provides the text for each element

■ Tick Labels — Sets the position and display of X-axis tick labels 
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Whether graph formats persist beyond your current working session depends on 
the type of user that you are set up to be. 

■ If you are an analyst user and save the graph, formatting is saved with the 
document.

■ If you are not an analyst user, you can format the graph while it is open in the 
workspace, but your settings will not be retained when you close the document.

Procedure: Specifying title, subtitle, and footnote for a graph
To specify title, subtitle and footnote for a graph, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears. 

2. Select the Titles tab. 

3. Choose a text element (Title, Subtitle, or Footnote) and proceed as follows: 

a. Select font properties (name, size, color, bold/italic, background color) for 
the text.

b. Specify the alignment for the text.

c. In the Display Options box, choose Show to display the specified text 
element in the current document.

d. In the Text box, type the text for the title, subtitle, or footnote (498 
characters maximum). 

4. Repeat Step 3 for each text element that you want to include.

5. Choose OK to apply your selections. 
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Procedure: Formatting tick labels for a graph
To format tick labels on the X-axis in a graph, follow these steps:

1. With the document open in the workspace, click the Format Document button 
on the Document toolbar.

Result: The Format Document dialog box appears. 

2. Select the Tick Labels tab. 

3. To offset every other label for readability, choose Staggered.

4. If you want to skip some tick labels, select one of the following options in the 
Skip Mode box: 

■ Automatic — Skips tick labels using a default interval that is set up the 
system 

■ Manual — Skips tick labels using interval settings that you provide 

If you do not want to skip any tick labels, choose None.

5. If you chose Manual in the previous step, in the Skip Amount box specify the 
number of tick labels that should be skipped.

6. Choose OK to apply your selections. 

Printing Web Reports and Graphs

About printing reports and graphs
You can print a report or graph and specify settings that determine how the printed 
pages will look.
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Procedure: Printing a report or graph
To print a report or graph, follow these steps:

1. With the document open in the workspace, click the Print button on the 
Document toolbar. 

Result: The Print dialog box for your browser appears.

2. You can change the print defaults for the browser. For example, you can specify 
new values for printer and number of copies.

3. Choose OK to continue. 

Result: The Print dialog box for Financial Analyzer appears. 

4. In the Print box, specify the pages that you want to print. You can choose one of 
the following options: 

■ Current Page — Prints the current page of data as indicated by the page 
label

■ All n pages — Prints all pages of data, beginning at the first logical page, 
regardless of the current page settings 

Note: If you choose to print all pages, the system prints all data for all 
dimension values that are in the page position in the document. Depending on 
the number of dimensions that are in status in the page position, printing all 
pages might result in many pages of output. 

5. For a report, in the Order box, you can specify the order in which to print the 
pages. You can choose one of the following options: 

■ Across then down — Prints as many rows and columns as will fit on a 
physical page, then moves across the columns (until all are printed) and 
then down the rows (until all are printed)

■ Down then across — Prints as many rows and columns as will fit on a 
physical page, then moves down the rows (until all are printed) and then 
across the columns (until all are printed)
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6. For a graph, you can specify how to scale the graph. Choose one of the 
following options:

■ Fit to Page — Scales the graph to fit the width and height of the physical 
printed page. If you want to maintain the proportions that are presented on 
the screen, also select Maintain Proportions. 

■ Actual Size — Scales the graph to fit the width and height of the physical 
printed page.

7. To indicate how you want the printed pages to look, choose Page Setup. This 
opens the Page Setup dialog box, where you can perform the following 
operations:

■ Specify optional header text (up to 100 characters) for the printed page

■ Specify an optional footer for the printed page

■ For a report, specify whether row, column, and page labels will be repeated 
on each printed page

■ For a report, specify whether a title, subtitle, and footnote will appear on 
the printed pages

■ Specify margin settings for the printed pages

8. If you want to preview the pages before printing them, choose Preview.

9. Click OK to print the document. 

Saving Web Reports and Graphs

Analyst users can save personal reports and graphs
If you are an analyst user, you can save a report or graph that you have created. You 
can also save a report or graph that has been distributed to you by your 
administrator under a new name. 

Saving a document retains the current selections for financial data items and 
dimension values, formatting, and layout. 
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You have the following options when you save a report or graph:

■ You can save the document. The saved report or graph will appear within the 
main Documents folder in the navigation list.

■ You can save the document in a folder that you have previously created. The 
saved report or graph will appear within the specified folder in the navigation 
list. For information about folders, see “Using Folders to Manage Web Reports 
and Graphs” on page 19-39.

■ You can save the document as the default for that document type. When you 
create a new document that is based on the default, the report or graph will 
have the dimension values, layout, and other characteristics of the default.

Procedure: Saving a report or graph
To save a report or graph, follow these steps:

1. With the document open in the workspace, click the Save As button. 

 Result: The Save As dialog box appears. If you are saving a new document, the 
default name of the document, such as “Untitled Report” or “Untitled Graph,” 
appears in the Save Document As box. If you are saving modifications to an 
existing document, its current name appears in the Save Document As box. 

2. Specify the name for the document that you are saving, as follows: 

■ If you are saving a new document, type a name for it in the Save Document 
As box. 

■ If you are saving an existing document under a new name, type that name 
in the Save Document As box. 

■ If you are saving an existing document under its existing name, do nothing 
with the information in the Save Document As box.

3. In the Into Folder box, select the folder into which you want to save the 
document. 

Note: If you want to save the report in the main Documents folder, select None 
in the Into Folder box. 

4. If you want to save the current document as your default document, so that its 
structure will appear whenever you create a new document of that type, select 
the Save As Default option. 

5. Choose OK.
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Copying Data from Web Reports

About copying data 
You can copy data in contiguous cells from a report to the Windows clipboard. You 
can choose to copy data that has not been rounded and has been stripped of special 
formats such as thousands separators, currency signs, and percent symbols or you 
can copy rounded data that includes these elements. You can also copy row and 
column labels.

Procedure: Copying data from a report
To copy data from a report, follows these steps.

1. With the report open in the workspace, select the cell or cells that you want to 
copy. 

You can select cells by using row and column selectors. You can also select cells 
by selecting a cell as a starting point, dragging the mouse pointer, and then 
releasing the mouse button at the end of the block. 

Note: You cannot select cells that are not contiguous.

2. Click the Copy to Clipboard button on the Document toolbar.

Alternatively, you can click the right mouse button and select a copy option 
from the popup menu. 

3. Choose a copy option: 

■ Copy — Copies data that is not rounded and excludes formats such as 
thousands separators, currency signs, and percent symbols.

■ Copy Special — Presents a submenu from which you can select one of the 
following:

* Copy Data with Labels — Copies data that is not rounded and 
excludes formats such as thousands separators, currency signs, and 
percent symbols. Also copies row and column labels.
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* Copy Number Formatted Data — Copies data that is rounded and 
includes formats such as thousands separators, currency signs, and 
percent symbols.

* Copy Number Formatted Data with Labels — Copies data that is 
rounded and includes formats such as thousands separators, currency 
signs, and percent symbols. Also copies the labels.

* Copy Row Labels — Copies the row labels that are associated with the 
selected data. Does not copy the actual data.

* Copy Column Labels — Copies the column labels that are associated 
with the selected data. Does not copy the actual data.

4.  If you see a dialog requesting additional privileges, choose Grant. 

Result: The data is copied to the Windows clipboard.

Exporting Data from Web Reports and Graphs

About exporting data from reports and graphs
You can export dimension labels and data values from an open report or graph to a 
file format that can be used in a spreadsheet. 

Note: If a document contains many pages of data, you might have difficulty 
opening the exported file in certain applications. To avoid this situation, modify the 
data selections to reduce the number of values before exporting the document.

Procedure: Exporting data from a report or graph
To export data from a report or graph, follow these steps: 

1. With the document open in the workspace, click the Export button on the 
Document toolbar. 

Result: The Export dialog box appears.

2. Specify the pages to export: Current or All n pages.

3. Select an export format:
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■ Comma delimited (*.csv) — Exports the data in Comma Separated Value 
format, in which labels and data values are separated by commas

■ Tab delimited (*.txt) — Exports the data in text file format, in which labels 
and data values are separated by tabs

4. Choose OK to export the data.

Result: Depending on your browser configuration, the labels and data from the 
worksheet may be displayed in a spreadsheet, or you may be prompted to 
perform additional tasks, such as saving the file to disk or choosing the 
application in which to display the data.

Using Folders to Manage Web Reports and Graphs

Folders organize personal documents for analyst users
If you are an analyst user, you can create personal folders to organize the reports 
and graphs that you create. You can populate a folder with saved documents. You 
can also add documents to a folder, delete documents from a folder, and copy and 
move documents between folders. 

Procedure: Creating a folder
To create a new folder, follow these steps:

1. On the Navigation toolbar, click the New button, 

and choose New Folder from the popup menu. 

Alternatively, you can right-click Documents in the navigation list and choose 
New Folder from the popup menu. 

Result: The New Folder dialog box appears. 

2. Enter a name for the folder and choose OK. 

Result: The new folder is displayed as a personal object in the navigation list.
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Adding a document to a folder
When you save a personal report or graph, you have the option to add it to a folder 
that you have previously created.

For a Web report or graph, you specify the folder in the Save As dialog box, as 
shown following.

If you choose (none), the document will be saved in the main Documents folder.

Moving or copying documents between folders
If you are an analyst user, you can move a personal report or graph from one folder 
to another in the navigation list. You can also copy a personal report or graph to 
another folder. 

Selecting documents to move or copy
Select documents to move or copy as follows:

■ To select a single document, click the document.

■ To select multiple nonsequential documents, press and hold the Ctrl key 
and click each document.

■ To select multiple sequential documents, click the first document, press and 
hold the Shift key, and then click the last document.
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Moving reports and graphs
You can use the following methods to move personal reports and graphs within the 
navigation list:

■ Drag and drop — Click the selection, drag it to the new location, and release the 
mouse 

■ Popup menu commands — Right-click the selection, choose Cut, click the new 
location, and then choose Paste 

■ Keyboard shortcuts — Highlight the selection, press Ctrl+x, navigate to the new 
location, and press Ctrl+v 

Copying reports and graphs
You can use the following methods to copy reports and graphs within the 
navigation list:

■ Drag and drop — Press the Ctrl key and click the selection, drag it to the new 
location and release the mouse 

■ Popup menu commands — Right-click the selection, choose Copy, navigate to 
the new location, and choose Paste 

■ Keyboard shortcuts — Highlight the selection, press Ctrl+c, navigate to the new 
location, and press Ctrl+v

Removing a document from a folder
If you are an analyst user, you can remove a personal document from a folder in the 
navigation list. 

To remove a document from a folder, open the folder, select the document, and click 
the Delete button on the Navigation toolbar. 

Alternatively, you can right-click the document and choose Delete from the popup 
menu.

In either case, the system will prompt you to confirm the deletion.

Result: The document is removed from the specified folder. If there is a copy of the 
document in another folder, it is not removed.
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Changing the order of documents in a folder
If you are an analyst user, you can change the current order of personal documents 
in a folder by dragging a document from its current position to a new position. 
Proceed as follows:

1. Open the folder.

2. Select one or more documents. 

3. Drag the selection to a new location in the folder. As you move the cursor, a 
black bar appears to help you identify the new position.

4. When the black bar is below the desired position, release the selection.

Note: You cannot change the order of documents in the main Documents folder

Working with Reports and Graphs in the Navigation List

Navigation list functions for reports and graphs
You use the navigation list to open reports and graphs. If you are an analyst user, 
you can also use the navigation list to create and maintain personal reports, graphs, 
and folders.

In addition, you can work with reports and graphs in the navigation list as follows:

■ Delete a personal report or graph (analyst user only)

■ Rename a personal report or graph (analyst user only)

■ View the object properties of a report or graph

Procedure: Deleting a report or graph
To delete a personal report or graph, click the document in the navigation list and 
click the Delete button on the Navigation toolbar. 
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Alternatively, you can right-click the document and choose Delete from the popup 
menu. 

In either case you will be prompted to confirm the deletion.

Note: If the document is in more than one folder, it will be deleted only from the 
specified folder.

Procedure: Renaming a report or graph
To rename a personal report or graph, right-click the document in the navigation list 
and choose Rename from the popup menu. Then type the new name. 

Note: If the document is in more than one folder, it will be renamed in all folders.

Procedure: Viewing the properties of a report or graph
To view the properties for a report or graph, right-click the document in the 
navigation list and choose Properties from the popup menu.

The following information appears: 

■ Name

■ Created

■ Modified

■ Class 
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20
Working with Web Data Entry Forms

Chapter summary
This chapter describes how to work with data entry forms in the Financial Analyzer 
Web interface.

List of topics
This chapter includes the following topics:

■ About Web Data Entry Forms

■ Entering Data into Web Data Entry Forms

■ Submitting Data from Web Data Entry Forms

■ Printing Web Data Entry Forms

■ Copying Data from Web Data Entry Forms

■ Exporting Data from Web Data Entry Forms

About Web Data Entry Forms

Description: Web Data entry forms
An administrator creates data entry forms on an Administrator workstation in the 
Windows client and distributes the forms. You use the Web interface to open a data 
entry form, enter data, and submit data to the shared database. 
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Example: Web data entry form
The following illustration shows an example of a Web data entry form. 

Opening a Web data entry form
Data entry forms are displayed as objects in the navigation list, located in the left 
frame of your Web browser. Some data entry forms might appear within individual 
folders in the navigation list, while others might appear in the main Documents 
folder.

To open a data entry form, double-click its folder. Then double-click the document. 
Alternatively, you can right-click the document and choose Open from the popup 
menu.

Tip: To search for a data entry form, right-click the main Documents folder or a 
specific document folder, choose Find Documents, and enter a name or name 
fragment. The search is case insensitive and will be limited to the selected folder.
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Using the Document toolbar to work with Web data entry forms
The Document toolbar appears at the top of an open data entry form. The buttons 
enable you to perform the following functions: 

Button Name Function

Export Export data and labels from the data entry form to a 
comma delimited (.csv) or text (.txt) file format

Copy to 
Clipboard

Copy selected data and labels from the data entry form 
to the Windows clipboard

Paste Paste data from the Windows clipboard into the data 
entry form

Submit Data Submit data in the data entry form to the shared 
database

Recalculate Data Recalculate the data in the data entry form

Note: This button appears only if a solve has been 
associated with the data entry form

Print Print the data entry form

Help Access Financial Analyzer HTML Help
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Closing a Web data entry form
To close a Web data entry form, click its close button, located in the upper right 
corner of the form. 

If you have entered or modified data in the form, you will be prompted to save 
your changes by submitting the data to the shared database. Changes that are not 
submitted will not be permanently saved.

Entering Data into Web Data Entry Forms

About entering data into Web data entry forms
You can enter numeric or text data into one or more cells of a data entry form by 
typing in the data or by pasting data from the Windows clipboard. You can paste 
data that you have copied from other cells in the form. You can also paste data that 
you have copied from another Windows application, such as a spreadsheet.

As you enter data, you can adjust the size of the columns to better view your work. 
If a solve has been associated with a financial data item in the form, you can 
recalculate the data.

Procedure: Manually entering data into a Web data entry form
Follow these steps to manually enter data into a Web data entry form:

1. With the data entry form open in the workspace, click a cell into which you 
want to enter data.

Note: You cannot enter data into cells that are gray in color. These cells have 
been locked by your administrator.

2. Type a value or text into the cell.

If you are entering multi-line text data, press Alt+Enter to create a new line. 

3. Press Enter or click another cell.

Result: The value or text that you entered appears.

4. Repeat Steps 2 and 3 for each cell in which you want to enter data. 
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5. To display another page of the form, click the arrow on the page label at the top 
of the data entry form and select the page that you want to display. 

Note: Changing the page automatically recalculates the data on the current 
page.

Procedure: Pasting data into a Web data entry form
To paste data from the Windows clipboard into a cell or cells of a Web data entry 
form, follow these steps: 

1. With the data entry form open in the workspace, select the cell or cells into 
which you want to paste data. 

Note: You cannot paste data into cells that are gray in color. These cells have 
been locked by your administrator.

2. Click the Paste button on the Document toolbar.

Alternatively, you can click the right mouse button and choose Paste from the 
popup menu. 

3.  If you see a dialog requesting additional privileges, choose Grant. 

Result: If the target area is verified, data is pasted into the specified cells. However, 
if one or more cells in the target area are locked, not editable, or if the data will not 
fit into the area, a message appears. 

Procedure: Adjusting column width in a Web data entry form
To adjust the column width in a Web data entry form, position the cursor on the 
border of a row or column label. When the cursor changes to a double arrow, click 
and move the border. 
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Procedure: Recalculating data in a Web data entry form
To recalculate the data in a Web data entry form, click the Recalculate button on the 
Document toolbar.

Submitting Data from Web Data Entry Forms

About submitting data to the shared database
When you submit data from a Web data entry form to the shared database, a data 
submission task is created. At any time you can view a list of your pending updates 
that have not yet been processed.

Procedure: Submitting data from a Web data entry form
To submit data to the shared database, click the Submit button on the Data Entry 
toolbar.

Procedure: Viewing pending updates
To view pending updates, click the View Pending Updates button on the 
Navigation toolbar. 
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Printing Web Data Entry Forms

About printing Web data entry forms
You can print a Web data entry form and specify settings that determine how the 
printed pages will look.

Procedure: Printing a Web data entry form
To print a Web data entry form, follow these steps:

1. With the document open in the workspace, click the Print button on the 
Document toolbar. 

Result: The Print dialog box for your browser appears.

2. You can change the print defaults for the browser. For example, you can specify 
new values for printer and number of copies.

3. Choose OK to continue. 

Result: The Print dialog box for Financial Analyzer appears. 

4. In the Print box, specify the pages that you want to print. You can choose one of 
the following options: 

■ Current Page — Prints the current page of data as indicated by the page 
label

■ All n pages — Prints all pages of data, beginning at the first logical page, 
regardless of the current page settings 

Note: If you choose to print all pages, the system prints all data for all 
dimension values that are in the page position in the document. Depending on 
the number of dimensions that are in status in the page position, printing all 
pages might result in many pages of output. 
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5. In the Order box, you can specify the order in which to print the pages. You can 
choose one of the following options: 

■ Across then down — Prints as many rows and columns as will fit on a 
physical page, then moves across the columns (until all are printed) and 
then down the rows (until all are printed)

■ Down then across — Prints as many rows and columns as will fit on a 
physical page, then moves down the rows (until all are printed) and then 
across the columns (until all are printed)

6. To indicate how you want the printed pages to look, choose Page Setup. This 
opens the Page Setup dialog box, where you can perform the following 
operations:

■ Specify optional header text (up to 100 characters) for the printed page

■ Specify an optional footer for the printed page

■ Specify whether row, column, and page labels will be repeated on each 
printed page

■ Specify whether a title, subtitle, and footnote will appear on the printed 
pages

■ Specify margin settings for the printed pages

7. If you want to preview the pages before printing them, choose Preview.

8. Click OK to print the document. 

Copying Data from Web Data Entry Forms

About copying data from Web data entry forms
You can copy data in contiguous cells from a data entry form to the Windows 
clipboard. You can choose to copy data that is not rounded and has been stripped of 
special formats such as thousands separators, currency signs, and percent symbols 
or you can include these elements. You can also copy row and column labels.
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Procedure: Copying data from a Web data entry form
To copy data from a data entry form, follow these steps.

1. With the data entry form open in the workspace, select the cell or cells that you 
want to copy. 

You can select cells by using row and column selectors. You can also select cells 
by selecting a cell as a starting point, dragging the mouse pointer, and then 
releasing the mouse button at the end of the block. 

Note: You cannot select cells that are not contiguous.

2. Click the Copy to Clipboard button on the Document toolbar.

Alternatively, you can click the right mouse button and select a copy option 
from the popup menu. 

3. Choose a copy option: 

■ Copy — Copies data that is not rounded and excludes formats such as 
thousands separators, currency signs, and percent symbols.

■ Copy Special — Presents a submenu from which you can select one of the 
following:

* Copy Data with Labels — Copies data that is not rounded and 
excludes formats such as thousands separators, currency signs, and 
percent symbols. Also copies row and column labels.

* Copy Number Formatted Data — Copies the data and includes formats 
such as thousands separators, currency signs, and percent symbols.

* Copy Number Formatted Data with Labels — Copies the data and 
includes formats such as thousands separators, currency signs, and 
percent symbols. Also copies the labels.

* Copy Row Labels — Copies the row labels that are associated with the 
selected data. Does not copy the actual data.

* Copy Column Labels — Copies the column labels that are associated 
with the selected data. Does not copy the actual data.
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4.  If you see a dialog requesting additional privileges, choose Grant. 

Result: The data is copied to the Windows clipboard.

Exporting Data from Web Data Entry Forms

About exporting data from Web data entry forms
You can export dimension labels and data values from a data entry form to a file 
format that can be used in a spreadsheet. 

Note: If the form contains many pages of data, you might have difficulty opening 
the exported file in certain applications. To avoid this situation, modify the data 
selections to reduce the number of values before exporting the document.

Procedure: Exporting data from a Web data entry form
Follow these steps to export data from a Web data entry form. 

1. With the data entry form open in the workspace, click the Export button on the 
Document toolbar. 

Result: The Export dialog box appears.

2. Specify the pages to export: Current or All n pages.

3. Select an export format:

■ Comma delimited (*.csv) — Exports the data in Comma Separated Value 
format, in which labels and data values are separated by commas

■ Tab delimited (*.txt) — Exports the data in text file format, in which labels 
and data values are separated by tabs

4. Choose OK to export the data.

Result: Depending on your browser configuration, the labels and data from the 
worksheet may be displayed in a spreadsheet, or you may be prompted to 
perform additional tasks, such as saving the file to disk or choosing the 
application in which to display the data.
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21
Express Spreadsheet Add-In

Chapter summary
This chapter provides an overview of how to use the Express Spreadsheet Add-In 
with Financial Analyzer. For information about the latest functions and features, 
refer to the release notes for Express Spreadsheet Add-In.

Who should read this chapter
Read this chapter if you have installed Express Spreadsheet Add-In for use with 
Financial Analyzer. 

List of topics
This chapter includes the following topics:

■ About the Express Spreadsheet Add-In

■ Using Express Spreadsheet Add-In Directly with Financial Analyzer

■ Attaching Financial Analyzer Databases

■ Using the Data Collection Toolkit

■ Implementing the Data Collection Toolkit

■ Data Collection Toolkit Technical Reference
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About the Express Spreadsheet Add-In

Working with Financial Analyzer data in a spreadsheet
Oracle Express Spreadsheet Add-In (hereinafter referred to as “Express Spreadsheet 
Add-In”) is an add-in to Microsoft Excel. The add-in allows you to fetch data from 
one or more Financial Analyzer databases and work with the data in a spreadsheet 
environment.

Methods for using Express Spreadsheet Add-In
You can use the Express Spreadsheet Add-In directly with Financial Analyzer. You 
can also use it to create a spreadsheet data collection template that can serve as a 
lightweight data entry mechanism for infrequent users of Financial Analyzer.

Related information
For up-to-date information about Express Spreadsheet Add-In features and 
functions, see the Express Spreadsheet Add-In release notes.

Using Express Spreadsheet Add-In Directly with Financial Analyzer

Requirements for using Express Spreadsheet Add-In directly
In order to use Express Spreadsheet Add-In directly with Financial Analyzer, the 
Express Spreadsheet Add-In software must be installed on your PC and in Excel. 
You must also have access to a Financial Analyzer database.

Creating a query
Installing the Express Spreadsheet Add-In into Financial Analyzer creates an 
Express item on the Excel menu. From the Express menu, you choose Run Express 
Wizard to create a query. 
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Working with a query
Once you create a query, you can use other Express menu options to perform the 
following functions: 

■ Rotate the data

■ Drill in the data

■ Make new data selections

■ Work with custom measures

■ Save data in the spreadsheet

If you have the proper access, you can also write changes to the database.

Related information
For detailed information about working directly with Financial Analyzer, see the 
Express Spreadsheet Add-In Help system.

Attaching Financial Analyzer Databases

Database attach modes
You attach Financial Analyzer databases in different “modes,” depending on the 
tasks that you want to perform. The mode in which you can attach a database 
depends on three things:

■ Your current default mode for attaching databases

■ Whether you select the Read Only option in the Attach Database dialog box

■ Whether you have write-access to the database file at the operating system level

Attaching personal databases
You can attach to a Financial Analyzer personal database in either read-only or 
read/write mode. Once you attach to a personal database, you can use the Express 
Wizard in Excel to query Financial Analyzer data. 

You can also transfer data from the spreadsheet to the attached personal database if 
you have write-access to the database and you attach the database in an appropriate 
mode.
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Attaching shared databases
You can attach a shared database in read-only mode. 

Financial Analyzer enables you to access data in the shared database based on your 
operating system user name. Therefore, you need the following to gain access.

■ Set your authentication type to Host or Domain in the Express connection file 
that is used to make a connection to Express from the Express Spreadsheet 
Add-In. 

■ Ensure that your operating system user name is associated with a Financial 
Analyzer user. This name determines your access to financial data items and 
dimensions. 

■ If your operating system user name is associated with more than one 
Financial Analyzer user, then your access rights will default to the access 
rights of the first Financial Analyzer user name defined. 

■ If your operating system user name is associated with a Financial Analyzer 
user who is defined as an Administrator then this user will take precedence 
over any other Financial Analyzer user.

Once you attach to a shared database, you can use the Express Wizard in Excel to 
query Financial Analyzer data. You can also transfer data from the spreadsheet to 
the attached shared database but you cannot permanently save changes to the 
shared database.

Important: Attaching multiple databases
Do not attach multiple databases that use the same object names. Doing so can 
produce unpredictable results.

Connecting directly to Financial Analyzer
If Financial Analyzer is running on your desktop, then the Express Spreadsheet 
Add-In will connect directly into your Financial Analyzer session.

■ If you are running an Administrator or Budget workstation, you will be directly 
connected to the Financial Analyzer session with the personal database 
attached read/write. 

Once you attach to a personal database, you can use the Express Wizard in 
Excel to query Financial Analyzer data. You can also transfer data from the 
spreadsheet to the attached personal database.
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■ If you are running an Analyst workstation you will be directly connected into 
the Financial Analyzer session with the shared database attached read only. 

Note: The Express Add-In option, Permanently write changes to databases 
attached read only, does not apply to analyst users and should not be used.

■ Once you attach to a shared database, you can use the Express Wizard in Excel 
to query Financial Analyzer data. You can also temporarily transfer data from 
the spreadsheet to the attached shared database, but you cannot permanently 
save changes to the shared database.

If the Express Spreadsheet Add-In is directly connected to a Financial Analyzer 
session you cannot use the Express Spreadsheet Add-In Rollback feature.

Related information
For more information about attaching databases, see the following topics in the 
Express Spreadsheet Add-In Help system:

“Attaching Databases”
“Attach Database Dialog Box”
“Attach Mode Options”

For information about configuring connections, see the Oracle Express Database 
Administration Guide.

Using the Data Collection Toolkit

Introduction
This section describes the Financial Analyzer data collection toolkit for use with 
Microsoft Excel. This toolkit enables you to create a simple lightweight data entry 
mechanism for infrequent users of Financial Analyzer.

Requirement for using data collection toolkit
In order to use the data collection toolkit, a user must have a thin client setup. A 
thick client cannot make the required connection.
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Toolkit Components
The Excel Data Collection toolkit is made up of the following components:

■ The Express Spreadsheet Add-In

■ Express API callouts to Financial Analyzer functionality

■ Standard Excel formatting features and Excel Visual Basic for Applications 
(VBA)

Toolkit Sample
A sample produced using the toolkit is provided. The sample is composed of the 
following files:

■ SAMPLE.XLS — An Excel workbook containing a sample data collection 
worksheet and a macro module containing routines to control functionality.

■ SAMPLE.INF — A text file containing Express programs for recalculating and 
submitting spreadsheet data. The programs can be incorporated in a Financial 
Analyzer custom database using the Express INFILE command.

These two files are located in the DOC\ADD_IN folder on the Oracle Financial 
Analyzer CD-ROM.

General procedure for data collection
Using this toolkit sample, users can collect data using the following procedure.

1. The user opens the workbook template in Excel. He or she is prompted for user 
id and password to access Financial Analyzer.

2. The user logs in. Financial Analyzer sets the appropriate access to the shared 
database and attaches the shared database as read-only.

3. Once the shared database is attached, the user can:

■ Enter new data into areas of the workbook specified by the template

■ Apply a Financial Analyzer solve definition to recalculate data in the 
workbook

■ Page through the query

■ Submit all changes made to the data in the workbook using the standard 
Financial Analyzer submit process
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Implementing the Data Collection Toolkit

Before you begin
Before you can build a data collection template, make sure of the following:

■ The Express Spreadsheet Add-In software is installed on your PC and in Excel.

■ You have access to an Express Client Connection file to make a connection to 
the instance of Express Server used by the appropriate Financial Analyzer 
shared database. 

Note: The Oracle Express Database Administration Guide describes how to 
configure Express connections.

■ The user id for your operating system is associated with a Financial Analyzer 
user name that has appropriate access to the shared database.

You must also ensure that the following settings on the Database tab are specified in 
the Options dialog box that is accessed from the Express menu in Excel.

You must also ensure that the following settings on the Format tab are specified in 
the Options dialog box that is accessed from the Express menu in Excel.

Implementation process
To implement the toolkit, follow these general steps.

1. Create an Excel workbook template as described in the topic, “Step 1: Creating 
an Excel workbook template” on page 21-8.

Property Setting

Default Attach Mode Read only

Permanently write changes to databases attached read only 
box

Off

Property Setting

Show Page Dimension Controls box On

Preserve Formatting After Drilling/Selection box On

Resize Columns to Fit Data box Off
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2. Define the query or queries using the Express Spreadsheet Add-In as described 
in the topic, “Step 2: Defining queries using the Express Spreadsheet Add-In” 
on page 21-8.

3. Insert an Excel macro module in the workbook as described in the topic, “Step 
3: Inserting an Excel macro module in the workbook” on page 21-9.

4. Define routines in the macro module as described in the topic, “Step 4: Defining 
routines in the macro module” on page 21-9.

5. Create a custom Financial Analyzer database as described in the topic, “Step 5: 
Creating a primary custom Financial Analyzer database” on page 21-13.

6. Define Express programs in the custom database to handle recalculate and 
submit procedures as described in the topic, “Step 6: Defining Express 
programs” on page 21-13.

7. Clear each query in the workbook as described in the topic, “Step 7: Clearing 
the queries” on page 21-15.

8. Install the workbook template on each users’ desktop as described in the topic, 
“Step 8: Installing the template on users’ desktops” on page 21-15.

Step 1: Creating an Excel workbook template
To implement the toolkit, you must create an Excel workbook template to use for 
data collection. By incorporating Excel VBA routines in the workbook, you 
determine what functionality the template makes available to users.

Using the new template, users can directly access their Financial Analyzer shared 
database. The users’ profiles in Financial Analyzer determines the data to which 
they have access. Users cannot use the template if they disconnect from the server 
where the shared database is located.

One workbook can be created for many users. The template workbook can be 
distributed to users through electronic mail or via a network. Oracle Corporation 
recommends that each user have a personal copy of the workbook file. This is 
preferable to a situation in which multiple users access a shared copy.

Step 2: Defining queries using the Express Spreadsheet Add-In
Queries that are defined using the Express Spreadsheet Add-In are bound to the 
database in which they were created. Therefore, you must create the queries using 
the shared database that users will be accessing through the workbook template.
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To define queries, follow these steps.

1. Open a new workbook template in Excel.

2. Connect to the appropriate Financial Analyzer shared database and attach it 
read-only.

3. Run the Express Wizard to define the necessary query or queries.

For instructions on running the Express Wizard, refer to the Express 
Spreadsheet Add-In Help system.

4. Format the query or queries as desired using standard Excel formatting 
features.

Tip: Although editing the query will preserve formatting in most cases, try to 
ensure that the query has all the necessary information before beginning 
formatting.

5. Save the spreadsheet.

Step 3: Inserting an Excel macro module in the workbook
Next, you must create an Excel Macro Module in the workbook. In this module you 
will define a number of macro routines to control functionality within the 
workbook. 

To insert a macro module in Excel, follow these steps.

1. Select a sheet in the workbook. The module will be inserted to the left of the 
sheet you select.

2. From the Insert menu, choose Macro, and then choose Module.

Step 4: Defining routines in the macro module
In the macro module, define a number of macro routines to control functionality 
within the workbook. 

The sample workbook template, SAMPLE.XLS, uses the following macro routines 
to control functionality within the workbook. These routines use Express 
Spreadsheet Add-In API methods that must be defined within the macro module of 
the workbook.

Note: For code listings of the sample macros described here, refer to “Data 
Collection Toolkit Technical Reference” on page 21-16.
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Auto_Open routine
Auto_Open is a predefined Excel procedure that runs whenever a workbook is 
opened. Auto_Open ensures that the configuration for the workbook is always the 
same on startup.

In the sample workbook template, the Auto_Open procedure calls the Startup 
routine. 

Startup Routine
The Startup routine performs the following tasks:

■ Makes a connection into Express Server.

The Startup routine uses the Express Spreadsheet Add-In XPConnect method to 
establish a connection with Express Server. The login routine is based on the 
Express Client Connection file for a user, described in the topic “Before you 
begin” on page 21-7.

If a connection cannot be made, XPConnect returns FALSE and the workbook is 
closed.

■ Sets the Excel environment.

The Startup routine sets the following Excel options and environment variables:

■ Turns screen updating off to improve macro performance

■ Sets the Calculation option to Manual

■ Turns the Recalculate Before Save option off

■ Turns the Express menu off to limit the functionality available to users

■ Runs the Financial Analyzer Startup routine. The Financial Analyzer Startup 
routine is located in the OFASERVE database. This database must be attached 
first.

The Startup routine runs a Financial Analyzer API named OFA.EXT.INIT. The 
Express Spreadsheet Add-In XPExecute method attaches the OFASERVE 
database and executes OFA.EXT.INIT. 

OFA.EXT.INIT performs the following tasks:

■ Attaches all code databases

■ Populates temporary Financial Analyzer catalogs

■ Attaches the shared database
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■ Applies the appropriate access rights to the shared database based on the 
operating system user id entered at login

■ Checks for outstanding data submissions.

Because the user is making changes to a shared database that is attached 
read-only, the changes are permanently written to the shared database only 
when the user’s data submission is processed by the Task Processor.

If the user exits a session where a submission has been made and then creates a 
new session against the same shared database before the earlier submission has 
been processed, then the user will be working with out-of-date data. 

This part of the routine stops the user from entering the workbook if any 
submissions made by that user are waiting in the Task Processor queue.

The Financial Analyzer API, TK.CHK.UNPROC, returns TRUE if any tasks for 
the user are still waiting in the Task Processor queue. 

Note: The internal Financial Analyzer user name is stored in the 
SHR.USR.ROLE variable in Express during a session.

■ Sets Express Spreadsheet Add-In options.

Certain Express Spreadsheet Add-In options should be set in a particular way. 
Others can be varied by implementation. The Express Spreadsheet Add-In 
XPSetOption method can be used to set individual options.

■ Registers the shared database.

Once the shared database has been attached, the Express Spreadsheet Add-In 
XPDatabaseAttach method registers with the defined active query. After the 
registration, the query can be refreshed from the database by using the Express 
Spreadsheet Add-In XPRefresh method.

Note: When running Express Server on NT, XPDatabaseAttach will only accept 
a drive path and not a UNC. All other references to the shared database in 
Financial Analyzer will also need to use a drive path.

Tip: When you call XPRefresh, use coordinates that reference an active cell of 
the query.

■ Disables access to the Selector through the query.

■ Users can access the Selector by double-clicking on a query. If you do not want 
to allow users to change the status of the query then you can disable this option 
by setting the OnDoubleClick property to null. If you have queries defined on 
multiple sheets, you will need to do this for each sheet.
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Calculation Routine
In the sample workbook template, the calculation routine writes back changes made 
to the current page to the shared database and then runs a solve definition in the 
database.

The Express Spreadsheet Add-In XPSetCustomWriteCommand method sets the 
Express program that will handle the writing of the changes to Express. Then the 
Express program RECALC.OFAXSA is called.

The RECALC.OFAXSA program performs the following tasks:

■ Applies the changes to the database

■ Filters out financial data items that should not be updated 

■ Runs a solve definition

The Express Spreadsheet Add-In XPWrite method executes the write for any 
changes made to the page. After the calculation routine has been run, the query 
refreshes to show the results of the solve definition.

Tip: When calling XPWrite, supply coordinates that reference an active cell in the 
query.

To execute the Calculation routine, the user chooses buttons created with Excel VBA 
that have the appropriate macros assigned.

Submit routine
In the sample workbook template, the submit routine takes the data that has been 
changed by the user in the current session and creates a submit data task.

Initially, the Submit routine checks to see if the user has changed any data for the 
current page but has not yet run the calculation routine.

If this is the case, the calculation routine is run before the data submission. The 
Express Spreadsheet Add-In XPGetChangeScript method identifies if a change has 
been made to the current page that has not been written back to Express.

In the sample the data submission is executed by the Express program 
SUBMIT.OFAXSA. This program sets the status of the financial data items to be 
submitted and creates the data submission task. 

Tip: When calling XPGetChangeScript, supply coordinates that reference an active 
cell in the query.

To execute the Submit routine, the user chooses buttons created with Excel VBA that 
have the appropriate macros assigned.
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Auto_Close
Auto_Close is a predefined Excel procedure that is run every time a user closes the 
workbook. In the sample workbook template, Auto_Close uses the Express 
Spreadsheet Add-In XPClose method to close any open connection to Express 
Server. XPClose also calls the Excel Close method that closes the workbook, 
automatically saving any changes that have been made.

Step 5: Creating a primary custom Financial Analyzer database
The Financial Analyzer custom database should be created in the CODE directory 
and its name declared in the OFACDCF.CFG file.

Any custom Express programs or objects defined during a Financial Analyzer 
implementation should be defined in the primary custom database. This database 
should be created in the code directory and its name declared in the OFACDCF.CFG 
file.

For example if you have created a primary custom database called CUSTOM, your 
OFACDCF.CFG file should contain the following information:

 [Primary Custom Database]
OFALCNAME=custom

Step 6: Defining Express programs
You define custom Express programs to handle the recalculate and submit 
procedures.

The sample file, SAMPLE.INF, contains two Express programs that handle the 
recalculate and submit procedures. The programs can be incorporated in a Financial 
Analyzer custom database using the Express INFILE command.

Recalculate Procedure
In the sample workbook template, the recalculate procedure RECALC.OFAXSA is 
defined as a boolean program in the primary custom database.

The RECALC.OFAXSA program performs the following tasks:

1. Applies the changes to the database

2. Filters financial data items that should not be updated

3. Runs a solve definition
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The status of dimensions is tracked through the use of valuesets. Valuesets should 
be defined for all the dimensions of the financial data items being written and 
solved. The status of the valuesets is initially be set to null. In the sample, valuesets 
are defined for the Line, Org, Prod and Time dimensions.

The XPSetCustomWrite method passes to the program a string of qualified data 
references (QDRs) that reference the cells of the query that have been changed. 
RECALC.OFAXSA evaluates each QDR to determine if that financial data item 
should be written to. In the sample, the financial data items to be written to are 
BUDG and BUD.ASMP99. The status of the dimensions of each QDR for these 
financial data items is added to the appropriate valueset and the QDR is executed. 
This routine filters out those financial data items that are present in the query but 
that should not be altered.

In the sample, only the part of the financial data item that has changed will be 
solved. The status of the solve is set by the status of the valuesets. In the sample, the 
only exception to this is the LINE dimension. The solve runs a model on the line 
dimension and status must be set to all.

Also, only the data relating to the pages of the query that have changed will be 
submitted. In the sample, the Prod and Org dimensions are the page dimensions. A 
list of Prod and Org values that have been changed between submissions is kept in 
two temporary variables named OFAXSA.PRD.LIST and OFAXSA.ORG.LIST. These 
are defined as single cell text variables in the primary custom database.

The solve definition is run by the Financial Analyzer API named SO.RUN.DFN. 
SO.RUN.DFN is passed two arguments:

■ The solve definition to be run expressed as a value of SO.ENTRY

■ The list of valuesets that correspond to the dimensions of the financial data item 
being solved

Tip: You can find the value of SO.ENTRY you need to pass by looking at SO.DESC. 

Submit Procedure
In the sample workbook template, the submit procedure SUBMIT.OFAXSA is 
defined as a Boolean program in the primary custom database. 

SUBMIT.OFAXSA sets the status of the financial data items to be submitted and 
creates the data submission task. In the sample, the two temporary page variables 
named OFAXSA.ORG.LIST and OFAXSA.PRD.LIST contain the list of page 
dimension values that have been changed. If either temporary page variable is 
empty then the program exits without submitting.
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The dimension status of the financial data items to be submitted is set through the 
dimension valuesets. In the sample, the status for Line is set to all because a model 
has been solved on that dimension. The status of Org and Prod are set by the 
temporary page variables. The status of Time is set according to the values shown in 
the query.

The submit is run by a Financial Analyzer API named SB.DATA.SHR. 
SB.DATA.SHR is passed the following two arguments:

■ The list of valuesets that correspond to the dimensions of the financial data item 
being submitted

■ The object name of the financial data item to be submitted

Tip: To keep changed data from being submitted more than once, the temporary 
page variables OFAXSA.ORG.LIST and OFAXSA.PRD.LIST are set to NA at the end 
of the procedure.

Step 7: Clearing the queries
Before the workbook is ready for distribution each query should be cleared. 
Clearing the query clears labels and data from the query and prepares it to be 
opened by the users. When the user opens the workbook the labels and data are 
placed into the query according to their dimension access definitions.

To clear a query, follow this procedure.

1. In the Excel workbook, position the cursor in any cell that contains data for the 
query you want to clear.

2. Select Clear Query from the Express menu.

The Express Spreadsheet Add-In displays a confirmation box.

3. Choose Yes in the confirmation box to clear the query.

Step 8: Installing the template on users’ desktops
Before they can use the data collection template, each template user needs the 
following:

■ The Express Spreadsheet Add-In software installed on their PC and in Excel. 
The Oracle Express Spreadsheet Add-In User’s Guide contains information on 
installing the Express Spreadsheet Add-In. It includes a list of supported 
versions of Excel and other software and hardware requirements.
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■ Access to an Express Client Connection file to make a connection into the 
instance of Express Server used by the appropriate Financial Analyzer shared 
database. The Oracle Express Database Administration Guide describes how to 
configure Express connections.

■ A Financial Analyzer user name. 

■ The appropriate dimensions, financial data items, hierarchies, attributes, 
models and solve definitions distributed to them. 

■ Note: Access to the data defined in the template will depend on the structure 
distributed to each Financial Analyzer user name. If more than one Financial 
Analyzer user name is assigned to an operating system userid, then the first 
Financial Analyzer user name defined will be used. The exception to this is if 
the operating system user id is assigned to the Financial Analyzer user name of 
the Administrator. In that case, this profile will be used.

The workbook template can be distributed to users through electronic mail or via a 
network. Oracle Corporation recommends that each user have a personal copy of 
the workbook file. This is preferable to a situation in which multiple users access a 
shared copy.

Data Collection Toolkit Technical Reference

Introduction
This topic describes Financial Analyzer API calls that are used by the routines 
defined in the macro module of the sample workbook template.

Financial Analyzer API calls
The following table describes the API call that attaches the Financial Analyzer code 
and shared databases.

Characteristic Description

Routine name OFA.EXT.INIT

Purpose Runs the Financial Analyzer startup routine. Attaches code 
databases and populated temporary catalogs. Attaches the 
shared databases and establishes permit security based on the 
operating system user id.
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The following table describes the API call that checks the Task Queue for any 
waiting task for a particular user.

The following table describes the API call that runs a solve definition on a particular 
financial data item.

Input Blank

Path to the OFASYSCF.CFG file

Returns

Characteristic Description

Routine name TK.CHK.UNPROC

Description: This routine takes as input an internal Financial Analyzer user 
name and then uses it to limit TK.PROP value USER. It then checks 
the TK.CATALOG for TK.PROP value STATUS of WAITING or IN 
PROGRESS.

Input: Financial Analyzer internal user name (i.e., ’AA’ for super user) 

Returns: YES — Tasks are waiting to be processed for this user

NO — No tasks are waiting

Characteristic Description

Routine name: SO.RUN.DFN

Description: This routine sets the status of a financial data item using user 
defined valuesets and runs a solve definition of that financial data 
item.

Input: Solve definition name (SO.ENTRY)

Multiline text variable containing valueset names with which to 
limit the financial data item’s dimensions

Returns: YES — If successful

NO — If unsuccessful

Characteristic Description
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The following table describes the API call that submits data to the shared database.

Characteristic Description

Routine name: SB.DATA.SHR

Description This routine sets the status of data for the financial data item using 
user defined valuesets. It also submits data for the financial data 
item to the task queue to update the shared database

Input Financial Analyzer financial data item

Multiline text variable containing valueset names with which to 
limit the financial data item’s dimensions

Returns YES — If successful

NO — If unsuccessful
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22
Data Loaders

Chapter summary
This chapter introduces Financial Analyzer’s data loader feature and provides 
reference material and examples to help you create your own data loader programs.

Who should read this chapter
Individuals who create and run a data loader program for loading data into 
Financial Analyzer should read this chapter.

List of topics
This chapter includes the following topics:

■ About the Data Loader Feature

■ Structural Metadata and Express Database Objects

■ Guidelines for Data Files

■ Sample Data Files

About the Data Loader Feature

Definition: Data Loader feature
The data loader feature uses Oracle Express Administrator to create programs that 
load information and data into your personal and shared databases.
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 You can define programs that perform the following tasks:

■ Load values into dimensions and related dimension metadata objects

■ Load information to structure hierarchies and attributes

■ Load data into financial data items

Process for creating a Data Loader program
You follow these general steps to create a data loader program.

1. In Financial Analyzer, from the Maintain menu, choose Data Loaders and then 
choose Create. This opens Oracle Express Administrator.

2. In Oracle Express Administrator, from the File menu, you choose Import. This 
opens the Import Text Data dialog box.

3. You specify the path and file name of the data file that the data loader program 
will access.

4. You specify whether the data file uses character delimited fields or fixed length 
fields.

5. You specify the Express database or metadata object into which the information 
in each field will be loaded.

6. You specify the appropriate settings for each dimension, variable, or relation 
information that you will load.

7. You specify a name for the data loader program that you are creating.

8. When you have created all the data loader programs that you need, you exit 
Oracle Express Administrator.

9. You run the data loader that you created.

Related information
For more information about creating data loader programs, search for the following 
topic in the Financial Analyzer Help system: “Creating a Data Loader.”
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Structural Metadata and Express Database Objects

Introduction
When you create a data loader program to load values into dimensions, hierarchies, 
attributes, or financial data items, your program must populate the Express 
database and metadata objects that are related to each type of Financial Analyzer 
structure.

Note: All dimensions, hierarchies, attributes, and financial data items must be 
defined using the Financial Analyzer user interface. You cannot use the data loader 
feature to create these structures.

Express database objects associated with Financial Analyzer structures
When you create Financial Analyzer dimensions, attributes, and financial data 
items, they are stored in your database as Express objects. When you create a data 
loader program, you must specify the Express object or objects that will store the 
information you are loading. The Oracle Express Administrator Database Browser 
displays the Express database and metadata objects that are related to the Financial 
Analyzer structures in your personal database.

The following topics provide information about the Express objects that are 
associated with each type of Financial Analyzer structure and show an example of 
how each would appear in the Database Browser.

Dimensions 
A Financial Analyzer dimension is stored as an Express dimension. This object 
stores values that you load into the dimension.

You can view a list of all of the dimensions in your personal database by clicking on 
the Expand icon next to the Dimension label in the Database Browser. The object 
name and description for each dimension appear in the Browser window.

Example: The Express dimension object for a sample dimension called Example 
would appear as follows.

Note: When you create a dimension in Financial Analyzer, a set of Express 
metadata objects is defined in addition to the Express dimension object. These 
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metadata objects must also be populated when you load dimension values into a 
dimension. If you fail to populate the dimension metadata objects, you will not be 
able to appropriately work with or view data associated with the dimension’s 
values. The metadata objects that you must populate are discussed later in this 
topic.

Attributes
A Financial Analyzer attribute is stored as an Express relation. 

You can view a list of all of the relations in your personal database by clicking on 
the Expand icon next to the Relation label in the Database Browser. The object name 
(which is created by the system) and description for each relation appear in the 
Browser window.

Example: The Express relation for a sample attribute called Example Attribute 1 
would appear as follows.

Note: You can load information into one-to-many attributes only. You cannot use 
the data loader feature to load information into many-to-many attributes.

Financial data items
A Financial Analyzer financial data item is stored as either an Express variable or 
formula. 

Note: You can load data into an Express variable but you cannot load data into a 
formula.

You can view a list of all of the variables in your personal database by clicking on 
the Expand icon next to the Variable label in the Database Browser. The object name 
and description for each variable appear in the Browser window.

Example: The Express variable for a sample financial data item called Example FDI 
1 would appear as follows.
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Express metadata objects associated with Financial Analyzer dimensions
When you create a dimension, a set of dimension metadata objects is also created. 
These objects are displayed when you click on the Expand icon next to a dimension 
in the Express Administrator Database Browser. They store information related to 
the dimension’s values.

Example
For a sample dimension called Example, the Oracle Express Administrator 
Database Browser would display the complete set of metadata objects as follows.

The following topics provide information about each dimension metadata object.

Dimension value name variable
Dimension value names that you load are stored in an Express variable. The 
variable name is composed of the dimension’s object prefix followed by the suffix 
.desc.

Example: The dimension value name variable for the Example dimension would be 
called Example.desc.

Row label variable
Row labels for the dimension values that you load are stored in an Express variable. 
The variable name is composed of the dimension’s object prefix followed by the 
suffix .lbl.row.

Example: The row label variable for the Example dimension would be called 
Example.lbl.row.
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Column label variable
Column labels for the dimension values that you load are stored in an Express 
variable. The variable name is composed of the dimension’s object prefix followed 
by the suffix .lbl.col.

Example: The column label variable for the Example dimension would be called 
Example.lbl.col.

Hierarchy relation
The dimension value relationships that make up a hierarchy are stored in a type of 
Express relation, called a self-relation. In a self-relation the values of a dimension 
are related to other values of the same dimension. The relation name is composed of 
a prefix of Fmshrel followed by the dimension’s object prefix.

Example: The self-relation for a hierarchy based on the Example dimension would 
be called Fmshrel.example.

Hierarchy dimension
When you create the first hierarchy based on a particular dimension, an Express 
hierarchy dimension is defined for the dimension. The values of the hierarchy 
dimension are the internal system names of all hierarchies that are based on the 
dimension. The dimension name is composed of a prefix of Fmshdim followed by 
the dimension’s object prefix.

Note: This object is not used in the creation of data loader programs.

Example: The hierarchy dimension associated with the Example dimension would 
be called Fmshdim.example.

Guidelines for Data Files

Introduction
It is important that you check your data files to be sure that they adhere to the 
following guidelines. These guidelines ensure that you will be able to appropriately 
view and work with your financial data after you have loaded it. 

■ The first character in a dimension value must be an alpha character.

Note: You can use the Replace option in the Field Modifications box of the 
appropriate Properties dialog box to replace non-alpha characters that are 
present in your data files.
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■ Do not include any of the following characters as part of a dimension value.

Note: You can use the Replace option in the Field Modifications box of the 
appropriate Properties dialog box to replace illegal characters that are present in 
your data files with legal ones.

‘    (single quotation mark)
~   (tilde)
! (exclamation point)
@   (“at” sign)
#   (pound sign)
$   (dollar sign)
%   (percent sign)
^   (caret)
&   (ampersand)
*   (asterisk)
      (blank space)
(   (left parenthesis)
)   (right parenthesis)
-   (dash)
=   (equal sign)
+   (plus sign)
\   (back slash)
|   (vertical bar)
[   (left bracket)
]   (right bracket)
{   (left brace)
}   (right brace)
;   (semicolon)
:   (colon)
"   (double quotation marks)
,   (comma)
<   (left angle bracket)
>   (right angle bracket)
/   (forward slash)
? (question mark)

■ The length of a dimension value cannot exceed the column width specified in 
the dimension’s definition. If the value exceeds the specified width, the value is 
truncated.

Note: In order to fix this type of problem, you must edit the data file and 
modify any dimension values that exceed the specified length, or you must 
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delete the dimension and redefine it with a column width that will 
accommodate the length of your dimension values.

■ A dimension value cannot contain any lowercase letters. All letters must be in 
uppercase.

Note: The Uppercase option is preselected in the Field Modifications box in the 
appropriate dialog boxes so that you always load dimension values in 
uppercase letters.

■ Do not add dimension values to the Time or Yr dimensions using a data loader 
program; only add values to these dimensions through the Time maintenance 
feature of the Financial Analyzer user interface.

Note: If your data file references values of the Time or Yr dimensions, be sure 
that you select the Match the dimension value option in the Dimension 
Properties dialog box so that you do not overwrite any values of those 
dimensions.

■ No value in a hierarchy can be designated as its own parent.

Note: You must manually edit the data file to correct this type of problem.

Correcting file problems
In some cases you have to edit your data file to correct problems; in other cases you 
can set up your data loader program to correct problems as you load the data in the 
file.

Sample Data Files

About the sample data files
This topic contains two sample data files, one that loads information into Express 
database and metadata objects, and one that loads financial data into a financial 
data item. Both files have fixed-length fields.

FIle to load information into Express database and metadata objects
In this example, the data file loads values into the Express database and metadata 
objects associated with the Organization dimension. The Oracle Express 
Administrator Database Browser displays information for the Express dimension 
objects and for the Express variable that stores the Actual financial data item. 
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Note: These are the objects that you drag from the Database Browser window to the 
Express Object column in the Import Text Dialog box when you create the data 
loader program for this sample data file.

Dimension name and description
The following is the name and description of the dimension into which dimension 
values will be loaded.

Dimension value name variable
The following is the dimension value name variable into which dimension value 
names will be loaded.

Row label variable
The following is the row label variable into which dimension value row labels will 
be loaded.

Column label variable
The following is the column label variable into which dimension value column 
labels will be loaded.
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Self-relation
The following is the self-relation into which the parent and child relationships 
between values of the Org dimension, which create the structure of a hierarchy, will 
be loaded.

One-to-many relation
The following is the name and description of the relation into which the 
one-to-many relationships between values of the Org dimension and another 
Financial Analyzer dimension, which create the structure of an attribute, will be 
loaded.

Sample data file
The following is the sample data file.

Dimension 
Value

Dimension Value 
Name

Dimension 
Value Row 

Label

Dimension 
Value 

Column 
Label

Hierarchy 
Relation

Attribute 
Relation

C01100 01100-Resource 
Rollup

Resource 
Rollup

Resource 
Rollup

C01PT NA

C01110 01110-Facilities 
Resources

Facilities 
Resources

Facilities C01100 GANDA

C01120 01120-Machine 
Resources

Machine 
Resources

Machine C01100 GANDA

C01130 01130-Comp and 
Comm Resources

Comp and 
Comm 
Resources

Comp & 
Comm

C01400 GANDA

C01400 01400-Sales Rollup Sales Rollup Sales Rollup C01PT NA
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File to load financial data into a financial data item
In this example, the data file references the values in the Express database 
associated with the Organization, Line, Product, and Time dimensions. It then loads 
financial data into a financial data item called Actuals.

Note: These are the objects that you drag from the Database Browser window to the 
Express Object column in the Import Text dialog box when you create the data 
loader program for this sample data file.

The Oracle Express Administrator Database Browser displays information for the 
Express dimension objects and for the Express variable that stores the Actuals 
financial data item. 

Object name and description: Organization dimension
The following is the object name and description of the Organization dimension, 
which is referenced when data is loaded into the Actuals financial data item.

Object name and description: Line dimension
The following is the object name and description of the Line dimension, which is 
referenced when data is loaded into the Actuals financial data item.

Object name and description: Product dimension
The following is the object name and description of the Product dimension, which is 
referenced when data is loaded into the Actuals financial data item.



Sample Data Files

22-12 Oracle Financial Analyzer User’s Guide

Object name and description: Time dimension
The following is the object name and description of the Time dimension, which is 
referenced when data is loaded into the Actuals financial data item.

Object name and description: Actuals variable
The following is the object name and description of the Actuals variable, into which 
financial data for the Actuals financial data item will be loaded.

Sample data file
The following is the sample data file.

Organization 
Dimension 

Values
Line Dimension 

Values
Product 

Dimension Values

Time 
Dimension 

Values
Actuals 

Data Values

C01100 A6100 PPT JAN00 2207272.65

C01100 A6100 PPT FEB00 2382589.36

C01100 A6100 PPT JAN00 502889.92

C01100 A6100 PPT FEB00 542832.88
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ACT–BUD variance

In formulas, ACT–BUD variance means the positive variance is displayed when 
actual is greater than budget. Typically, if you are defining a revenue line item, you 
should select the calculation ACT–BUD so that a positive number is displayed if 
actual data is greater than budget data.

Add button

Button appearing on the Selector dialog box that enables you to add selected items 
to the Selected box. 

aggregation types

The following aggregation types are supported:

■ add month into quarters — Data for each month is added into quarterly totals. 
Used for line items on income statements.

■ first month only into quarter — Only the first month of the quarter is used in 
quarterly totals, or only the first month of the year is used in yearly totals. Used 
for line items on cash flow statements.

■ last month only into quarter — Only the last month of the quarter is used in 
quarterly totals, or only the last month of the year is used in yearly totals. Used 
for line items on balance sheets.

■ average months into quarter — Values are averaged over the quarter or over 
the year. Used for line items such as Head Count.
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■ average across time and org — Values are averaged over all organizations and 
over the quarter of the year. Used for line items such as Unit Price.

■ recalculate quarter — Values are recalculated at the end of the quarter or year, 
using the line item equation. Used for line items such as Return on Sales, which 
represents a ratio.

■ do not aggregate — Values are removed from status before any rollups or 
worksheet spread operations are performed.

Aitkens delta-squared solution method

A solution method in which the first two of every three iterations over a block of 
simultaneous equations are solved using the values from the previous iteration, and 
the results are tested for convergence and divergence. In every third iteration, the 
results are obtained not by solving the equations, but by making a next-guess 
calculation. This calculation uses the results of the previous three iterations. The 
results of the guesses are not tested for convergence and divergence, and the 
solution always continues to the next iteration.

area graph

A graph that emphasizes trends in data. While similar to a line graph, an area graph 
highlights the amount of change, not the rate of change.

asymmetric combination

A set of database objects that enables you to customize the layout of a report. An 
asymmetric combination joins the values of two dimensions so that you can 
juxtapose values in a way that lets you compare and contrast them.

attribute

A database object that links or relates the values of two dimensions. For example, 
you might define an attribute that relates the Sales District dimension to the Region 
dimension so that you can select data for sales districts according to region.

auto redisplay feature

An option on the Graph, Report, and Worksheet menus. When you select this 
option, your report, graph, or worksheet is automatically redisplayed when you 
make changes to the format or data in the document.

axis title

A label that you can assign to the X-, Y-, or Y2-axis of a graph to provide 
information about the data represented by that axis.



Glossary-3

bar graph

A graph that compares one or more data series. Each data point is represented by a 
single bar. You can orient a bar graph either vertically or horizontally.

BUD–ACT variance

In formulas, BUD–ACT variance means a positive variance is displayed when 
budget is greater than actual. Typically, if you are defining an expense line item, you 
should select the calculation BUD–ACT so that a negative number is displayed if 
Actuals data is greater than budget data.

Cancel button

A button located to the left of the edit bar which, when chosen, clears all text from 
the bar.

clustered bar graph

A graph that compares data for two or more data series. Each data series is 
represented by bars of the same color. You can orient a clustered bar graph either 
vertically or horizontally.

current dimension

The dimension from which you are selecting values. The current dimension is the 
dimension that you specified in the Dimension box of the Selector dialog box. 
Choices that you make and actions that you take in lower-level dialog boxes 
ultimately affect this dimension by selecting values from it to include in a 
document.

current object

The object upon which the next specified action takes place. Generally, the current 
object is the most recently selected one. However, if you use a highlighter button to 
highlight a group of objects, such as data cells in a column, the first object in the 
group is the current object.

data marker

A graphical object that represents data in a graph. For example, the data markers in 
a bar graph are bars, while in a pie graph they are pie slices.
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data point

A graphical object that represents the point of intersection of multiple values in a 
graph.

DBA library

If a database object belongs to a DBA library, it means that the object was created by 
an administrator and cannot be modified by a user.

decimal data type

Variables with a decimal data type contain decimal numbers with up to 15 
significant digits.

Defined by DBA option

If a dimension has the Defined by option set to DBA for hierarchies, models, or 
relationships, that dimension can be used only by an administrator in hierarchy, 
model, or relationship definitions.

Defined by Everyone option

If a dimension has the Defined by option set to EveryOne for hierarchies, models, or 
relationships, that dimension can be used by any user in hierarchy, model, or 
relationship definitions.

Defined by No One option

If a dimension has the Defined by option set to NoOne for hierarchies, models, or 
relationships, that dimension cannot be used in any hierarchy, model, or 
relationship definition.

dimension

A database object used to organize and index the data stored in a variable. 
Dimensions answer the following questions about data: “What?” “When?” and 
“Where?” For example, a variable called Units Sold might be associated with the 
dimensions Product, Month, and District. In this case, Units Sold describes the 
number of products sold during specific months within specific districts.

dimension label

A text label that displays the name of the dimension associated with an element of a 
report, graph, or worksheet. For example, the data markers in a graph’s legend 
contain dimension labels that show what data each data marker represents. 
Dimension labels can be short, which means that they display the object name of a 
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dimension, or user-specified, which means that they display a label that you typed 
using the Dimension Labels option on the Graph, Report, or Worksheet menus.

dimension tile panel

A set of tiles in a graph, report, or worksheet.

dimension values

Elements that make up a dimension. For example, the dimension values of a 
Product dimension might include Tents, Canoes, Rackets, and Sportswear.

draft quality printouts

You can print reports in either final quality or draft quality mode. Both modes print 
out all data included in your report. Final quality printouts reflect all formatting 
you have applied to the body of your report as well as any customized headers and 
footers you add to your report. Draft quality reports include customized headers 
and footers as well as row and column labels, but they do not reflect any 
customized formatting in the body of the report.

Because draft printouts use a default draft font and do not include customized 
formatting they can print faster than final quality printouts.

You cannot print drafts of graphs or worksheets.

Drill button

Opens the Drill dialog box, which enables you to move up or down through the 
levels of aggregated data in a report, graph, or worksheet.

drill icons

Icons on which you click to move up or down through the levels of aggregated data 
in a report, graph, or worksheet. There are two drill icons:
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The following icon expands the list of related financial data items, enabling you to 
view more detailed levels of aggregated data.

The following icon collapses the list of related financial data items, enabling you to 
view higher levels of aggregated data.

edge

The position in a report or worksheet along which a dimension or financial data 
item is located. The report edges correspond to the sides of a three-dimensional data 
slice.

edit bar

An element of the document area that enables you to edit the text associated with 
components and options in graphs, reports, and worksheets.
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Ellipsis button

A button that opens a Choice List dialog box, which provides a list of values from 
which you can make one or more selections.

Enter button

A button located to the left of the edit bar which, when chosen, applies the text in 
the box to a selected graph, report, or worksheet option.

financial data item

A database object that is made up of either a variable, or a variable and a formula. 
For example, a financial data item called “Actuals” would be a variable, while a 
financial data item called “Actuals Variance” would be made up of a variable 
(Actuals) and a formula that calculates a variance.

fitline

Represents a new series of data that is statistically based on an original series. 
Fitlines, also called trend lines, illustrate how original data series are changed by 
exponential, linear, or logarithmic calculations. A fitline answers the question, 
“What, mathematically, can we say about the original series?”

folder

An object in which you can store documents such as reports and graphs. You can 
create a new folder and add documents to it by choosing the Maintain Folders 
option from the Tools menu.

footnote

Text that you can include at the bottom of a graph, report, or worksheet to annotate 
that document. Footnotes appear on your screen and on printouts of a document.
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Formula Tools button 

A button located to the left of the edit bar which, when chosen, invokes the Formula 
Tools dialog box. You can then use the formula tools to create a formula to be used 
in the current report.

Gauss-Seidel solution method

A solution method in which equations in a simultaneous block are solved in each 
iteration over the block. The results are tested for convergence and divergence in 
each iteration.

graph components

The basic structural elements of a graph, such as the X- and Y-axes in line and bar 
graphs, or the pie slices in pie graphs.

graph options

Elements, such as a title or legend, that provide additional information about the 
data represented in a graph. Graph options can be displayed or hidden using 
commands on the Graph menu.

grids

Lines that help to visually separate the data cells and labels in a report or 
worksheet, or that help to relate data markers and data points to axis tick labels in a 
graph.

growing data

A worksheet calculation method that enables you to augment or decrement the 
values of financial data items in a range of cells over a specified amount of time by a 
constant amount or by a percentage.

highlighter buttons

Small rectangular graphical objects that cause specific areas of a report or worksheet 
to become highlighted when you click on them. Highlighter buttons produce 
highlighted areas in the following ways:

■ Clicking on the button to the right of a row label highlights that row of data.

■ Clicking on the button beneath a column label highlights that column of data.
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■ Clicking on the square button at the intersection of the first row and first 
column highlights all rows and columns of data on the current page.

Following is an illustration of the highlighter buttons.

increasing data

A worksheet calculation method that enables you to augment or decrement the 
values of specific financial data items for specific time periods by a constant amount 
or by a percentage.

integer data type

Variables with an integer data type contain whole numbers with values between 
-2.14 billion and +2.14 billion.

legend

A graphical key that displays a graph’s data markers and the dimension labels for 
the data that the markers represent.

library

An ownership designation associated with a database object, which specifies who 
created the object and, therefore, who is permitted to modify or delete it. Objects 
can have the following library designations:

■ Personal — An object that you created and which you can modify or delete.

■ DBA — An object that your administrator created, which only that 
administrator can modify or delete.

■ System — An object that is delivered with the software, which no user or 
administrator can modify or delete.

line graph

A graph that depicts trends. Each data point is represented by a point on the graph. 
When the points are connected by lines, trends become visible.
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major gridlines

Vertical and horizontal lines that you can display in a report, graph, or worksheet to 
visually separate data. Major gridlines visually segment the report, graph, or 
worksheet area into larger areas than do minor gridlines.

Many-to-Many attribute

A relationship between one or more values of one base dimension with one or more 
values of a second base dimension. For example, if you have a Many-to-Many 
attribute definition where the first base dimension is Organization and the second 
base dimension is Line Item, then a single organization can be related to several line 
items, and a single line item can be related to several organizations.

metadata

Data that describes other data. An example of metadata is a variable that lists the 
names of levels in a hierarchy or that holds the number of decimal places to be used 
for displaying data. Client applications use metadata when displaying 
multidimensional data in graphs, reports, tables, and so on.

minor gridlines

Vertical and horizontal lines that you can display in a report, graph, or worksheet to 
visually separate data. Minor gridlines visually segment the report, graph, or 
worksheet area into smaller areas than do major gridlines.

model

A set of interrelated equations for calculating data.

One-to-Many attribute

A relationship where one or more values of a base dimension are related to a single 
value of an aggregate dimension. For example, if you have a One-to-Many attribute 
definition where the base dimension is Organization and the aggregate dimension 
is Level, each organization can be related to only a single level.

Oracle GL library

If a database object belongs to an Oracle GL library, it means that the object was 
created by importing data from Oracle General Ledger. Users can add and move 
values that belong to Oracle GL libraries, but they cannot rename or delete them.
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page control

A graphical element that enables you to page through a graph, report, or worksheet.

Tip: To quickly page through an open report or worksheet, select the paging 
dimension by clicking on it and press ALT+PAGE UP or ALT+PAGE DOWN.

personal database

Personal databases are used to store objects, and on some types of workstations, 
financial data. Objects include dimensions, financial data items, attributes, and 
hierarchies, as well as documents such as reports, worksheets and graphs.

personal library

If a database object belongs to a personal library, it means that the object was 
created by the workstation user and can be modified.

pie slice feelers

Graphical lines that help you annotate a pie graph by connecting a pie slice label to 
a pie slice.

qualified data reference

In reports, qualified data references (QDRs) are used to describe specific cells that 
are referenced by one or more dimensions. For example, a QDR can be used to 
reference the cell that represents the Total Assets line item for the year 1996 for the 
East organization.

Redisplay button

Lets you redisplay a report, graph, or worksheet after you have modified it.
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Remove button

Button appearing on the Selector dialog box that enables you to remove selected 
items from the Selected box.

report components

The basic structural elements of a report, such as its rows and columns.

report options

Structural elements, such as titles or column headings, that organize the data 
represented in a report. Report options can be displayed or hidden using 
commands on the Report menu.

scroll bars

Graphical elements of a report or worksheet that enable you to view information 
that currently does not fit into the window display.

selection tools

A set of tools that provide shortcut methods for selecting the values that you want 
to work with in a document.

shared database

The shared database contains financial data and objects that are shared by all users. 
Objects include dimensions, financial data items, attributes, and hierarchies, as well 
as documents such as reports, graphs, worksheets and data entry forms. Shared 
databases are maintained by administrators.
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shortdecimal data type

Variables with a shortdecimal data type contain decimal numbers with up to 7 
significant digits.

shortinteger data type

Variables with a shortinteger data type contain whole numbers with values between 
-32768 and +32768.

solve definition

A set of information used to calculate new values for financial data items. This 
information includes the variable for which new values are to be calculated, the 
model to be used in the calculation, the dimensions of the variable, and any 
hierarchies associated with the dimensions. When you run a solve definition, the 
model is solved for the variable referenced in the definition.

spreading data

A worksheet calculation method that enables you to augment or decrement the 
values of descendants in a hierarchy by entering a value for a parent value in the 
hierarchy and modifying the descendants based on their relationship with the 
parent.

text data type

Variables with a text data type can contain multiple lines of alphanumeric text.

text dimension

A dimension whose values can contain characters in both upper and lower case. 
The length of a text dimension’s values is determined by the Width option on the 
Maintain Dimension dialog box.

thick client

A client is considered thick if the personal database and Express Server are installed 
on the PC and all processing takes place on the PC.

thin client

A client is considered thin if the personal database and Express Server are installed 
on the server and all processing occurs on the server.

tick labels

Text or numbers, located along a graph’s axes, that describe the data presented in a 
graph.
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tick marks

Short line segments, located on a graph’s axes, that denote increments of data. 
Major tick marks indicate primary levels of gradation, while minor tick marks 
indicate secondary levels. When working with a bar, line, or scatter graph, you can 
choose to include major tick marks, minor tick marks, or both, to make the graph’s 
data easier to interpret.

tile

A graphical element of a report, graph, or worksheet that displays the name of a 
dimension whose data appears in that document.

A tile’s location in a document indicates the position of the dimension it represents. 
For example:

■ Tiles located above and to the left of a report represent dimensions in the page 
position.

■ Tiles located above and to the right of a report represent dimensions in the 
across position.

■ Tiles located at the bottom of a report represent dimensions in the down 
position.

Tiles contain a number in parentheses beside the dimension name. This number 
indicates how many values have been selected for the dimension.
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You can manipulate the data in a document by dragging one or more tiles to new 
locations in the document. This action changes the position of the tiles’ related 
dimensions.

Time dimension

A dimension whose values represent time periods. A time period can be a month, 
quarter, or year. The length of the Time dimension’s values is determined by the 
Width option on the Maintain Dimension dialog box.

variable

A database object that holds raw data. Data can be numerical, such as sales or 
expense data, or textual, such as descriptive labels for products.

worksheet components

The basic structural elements of a worksheet, such as its rows and columns.

worksheet options

Structural elements, such as titles or column headings, that provide additional 
information about the data represented in a worksheet. Worksheet options can be 
displayed or hidden using commands on the Worksheet menu.

Y2-axis

A secondary vertical axis that can display:

■ A numeric scale that is different from that of the Y-axis, which can help you 
compare values that belong to different ranges.

■ A numeric scale that is the same as that of the Y-axis, which can be used to 
make a graph more easily readable.
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administrator tasks

controlling access to data, 12-8
distributing structures, 10-5
maintaining users, 12-6
refreshing data in the shared database, 10-19
submitting data to the shared database, 10-11

Administrator workstations
defined, 1-4
submitting data from, 10-11

advanced mathematical functions, 8-8
aggregation functions, 8-11
aggregation type for dimension values, 3-9
aligning text

in graphs, 14-9
in reports, 13-23
in worksheets, 15-11

Analyst workstations
defined, 1-10
saving data, 10-14

ancestor values, 5-4
annotations in data entry forms, 16-7
area graphs

description, 14-3
including tick marks in, 14-12

asymmetric formatting
defined, 13-7
example, 13-8
in data entry forms, 16-8
in reports, 13-7

asymmetric reports. See asymmetric formatting
attributes

creating, 6-5

defined, 6-2
deleting, 6-7
many-to-many, 6-4
one-to-many, 6-3
renaming, 6-7
types, 6-3

Auto Redisplay option
in reports, 2-10, 13-5
in worksheets, 15-6

B
bar graphs

arranging X-axis labels in, 14-12
changing data marker shape in, 14-11
description, 14-2
including tick marks in, 14-12
using fitlines in, 14-11

bar-line graphs, 14-3
blank columns

inserting in reports, 13-24
inserting in worksheets, 15-12

blank rows
inserting in reports, 13-24
inserting in worksheets, 15-12

borders
placing around text in reports, 13-23
placing around text in worksheets, 15-11

browser requirements, 18-2
Budget workstations

defined, 1-8
submitting data from, 10-13



Index-2

C
calculations in reports. See report calculations
child values, 5-3
closing

graphs, 14-14
Web documents, 19-6
worksheets, 15-13

color coding in Web reports, 19-26
colors

specifying in graphs, 14-9
specifying in reports, 13-24
specifying in worksheets, 15-12

columns
formatting in Web reports, 19-22
inserting in reports, 13-24
inserting in worksheets, 15-12

compiling models, 8-4
conditions, using with functions, 8-6
configuring Financial Analyzer, 1-18
copy data feature, 4-16
copy data profiles, 4-18
copying

data in Web interface, 19-37, 20-8
Web documents between folders, 19-40
Web documents to folders, 19-40

creating
attributes, 6-5
data entry forms, 16-2
dimension values, 3-9
dimensions, 3-4
folders, 17-2
graphs, 14-6
hierarchies, 5-9
models, 8-3
reports, 13-5
solve definitions, 9-4
users, 12-2
worksheets, 15-6

custom menu feature, 2-17, 2-23
custom time dimension, 3-8

D
data

calculating using group solve definitions, 9-2
calculating using models, 8-2
calculating using solve definitions, 9-5
entering into worksheets, 15-19
formatting in Web reports, 19-19
loading into Financial Analyzer, 22-1
querying with Express Spreadsheet 

Add-In, 21-3
refreshing, 10-19
saving in worksheets, 15-16, 15-20
solving, 9-2
submitting from Administrator 

workstations, 10-11
submitting from Budget workstations, 10-13
transferring, 10-3

data collection toolkit
components, 21-6
defining Express programs for, 21-13
defining macro routines for, 21-9
description, 21-5
implementing, 21-7
installing, 21-15
sample, 21-6
technical reference, 21-16

data distribution profiles, 10-7
Data Entry Form menu, 2-13, 16-3
data entry forms

adding to folders, 16-12
asymmetric formatting, 16-8
calculations, 16-5
copying data in Web interface, 20-8
creating, 16-2
data formats, 16-6
defined, 16-2
deleting, 16-12
distributing, 16-11, 16-12
editing, 16-12
entering data in Web interface, 20-4
example, 2-5, 16-5
exporting data in Web interface, 20-10
form options, 16-7
locking cells, 16-9
pasting data in Web interface, 20-5
previewing, 16-10
printing, 16-10
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printing in Web interface, 20-7
recalculating data in Web interface, 20-6
saving, 16-9
submitting data from Web interface, 20-6
Web example, 16-11, 20-2

data files
guidelines, 22-6
samples, 22-8

data loader feature, 22-1
data loader program

creating, 22-2
guidelines for data files, 22-6

data markers, changing shape of, 14-11
data refresh profiles, 10-20
data submission profiles, 10-12
databases

Administrator workstations, 1-6
Super administrator, 1-4
types, 1-3

deleting
attributes, 6-7
data entry forms, 16-12
folders, 17-3
graphs, 14-15
page breaks from reports, 13-24
page breaks from worksheets, 15-12
reports, 13-27
tasks from the task queue, 11-4
users from the user list, 12-6
Web documents, 19-42
worksheets, 15-14

descendant values, 5-4
dimension tiles

in graphs, 14-5
in reports, 13-4
in worksheets, 15-3

dimension value labels
in graphs, 14-8
in reports, 13-23
specifying predefined in graphs, 14-8
specifying predefined in reports, 13-25
specifying predefined in worksheets, 15-12

dimension values
creating, 3-9
defined, 3-2

deleting, 3-12
in report calculations, 13-18
modifying, 3-12
selecting, 7-3
selecting in Web interface, 19-7
sorting in Web interface, 19-10

dimensions
creating, 3-4
defined, 3-2
deleting, 3-6
modifying, 3-6
ordering in stored financial data items, 4-10
using as attributes, 3-8
using in hierarchies, 3-7
using in models, 3-7

distribution
data entry forms, 16-11
defined, 10-4
of data, 10-8
of documents, 10-7
of structures, 10-5
when to use, 10-5

documents
data entry forms, 16-2, 20-1
distributing, 10-7
graphs, 14-2, 19-3
reports, 13-2, 19-2
Web data entry forms, 20-1
Web graphs, 19-3
Web reports, 19-2
worksheets, 15-2

drilling
in reports, 13-29
in Web graphs, 19-16
in Web reports, 19-16
in worksheets, 15-17

E
Edit bar, 2-20
Edit bar buttons

in graphs, 14-5
in reports, 13-4
in worksheets, 15-4

Edit menu, 2-8
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embedded total dimensions, 5-2
errors in report calculations, 13-22
Excel, exporting to, 13-27, 14-15, 15-14
exporting

data from graphs, 14-15
data from reports, 13-27
data from Web documents, 19-38, 20-10
data from worksheets, 15-14

Express database objects, 22-3
Express Server, logging in, 2-20
Express Spreadsheet Add-In

data collection toolkit, 21-5
described, 21-2
queries, 21-3

external users, 1-20, 12-3

F
File menu, 2-8
Financial Analyzer

compatibility with other products, 2-5
documents, 2-2
logging in, 2-20
structures associated with database objects, 22-3
Web interface, 18-1, 19-1, 20-1

financial data items
calculating using group solve definitions, 9-2
calculating using solve definitions, 9-5
defined, 4-2
deleting, 4-12, 4-15
formula, 4-2
modifying, 4-12
stored, 4-2

financial functions, 8-10
fitlines in graphs, 14-11
folders

adding data entry forms to, 16-12
adding documents to, 17-2
adding graphs to, 14-15
adding reports to, 13-27
adding worksheets to, 15-14
creating, 17-2
creating in Web interface, 19-39
defined, 17-1
deleting, 17-3

printing documents from, 17-2
renaming, 17-3
viewing contents, 17-2

fonts
specifying in graphs, 14-9
specifying in reports, 13-24
specifying in worksheets, 15-12

footnotes
adding to graphs, 14-8
adding to reports, 13-23
adding to worksheets, 15-11

Format menu, 2-9
formatting

graphs, 14-8
graphs in Web interface, 19-31
reports, 13-23
reports in Web interface, 19-19, 19-26
worksheets, 15-11

formula financial data items. See financial data items
functions

advanced mathematical, 8-8
aggregation, 8-11
conditional, 8-6
examples, 8-14
financial, 8-10
time-series, 8-9
types, 8-8
using in models, 8-8

G
General Ledger, compatibility with Financial 

Analyzer, 2-5
Graph menu, 2-11, 14-6
graphs

adding to folders, 14-15
assigning data series to axes, 14-11
changing the layout of, 14-7
changing the scale of the Y1- or Y2-axis, 14-12
closing, 14-14
creating, 14-6
creating in Web interface, 19-7
defined, 2-3, 14-2
deleting, 14-15
drilling in Web interface, 19-16
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elements of, 14-4
example, 2-3
exporting data, 14-15
exporting data from Web interface, 19-38
formatting, 14-8
formatting in Web interface, 19-31
legends, 14-8
linking, 14-16
opening, 14-14
opening in Web interface, 19-4
printing in Web interface, 19-33
saving, 14-13
saving in Web interface, 19-35
selecting data in Web interface, 19-7
specifying axis options in, 14-11
specifying pie options in, 14-12
types, 14-2
types in Web interface, 19-3
using fitlines in, 14-11
Web example, 19-4

group solve definitions
associating with financial data items, 9-9
creating, 9-7
defined, 9-2
modifying, 9-8
operational mode, 9-8
running, 9-7
using to calculate data, 9-2

growing data in worksheets, 15-21

H
Help menu, 2-17
Help system, 2-25
hierarchies

creating, 5-9
defined, 5-2
drilling through in reports, 13-29
drilling through in worksheets, 15-17
example, 5-5
multiple, 5-6
renaming, 5-10
typical structure, 5-2

highlighter buttons
in reports, 13-4

in worksheets, 15-4
horizontal bar graphs, 14-2

I
importing user names

from operating system, 12-4
from Oracle Applications, 12-4

increasing data in worksheets, 15-22
indenting row labels

in reports, 13-23
in worksheets, 15-11

inserting
page breaks in reports, 13-24
page breaks in worksheets, 15-12

L
leaf values, 5-5
legends in graphs, 14-8
line graphs

arranging X-axis labels in, 14-12
changing data marker shape in, 14-11
description, 14-2
using fitlines in, 14-11

linking
graphs, 14-16
reports, 13-28
worksheets, 15-16

loading data, 22-1

M
Maintain menu, 2-14
Manage menu, 2-15
many-to-many attributes

defined, 6-4
example, 6-4

Menu bar, 2-7
Microsoft Excel compatibility with Oracle Financial 

Analyzer, 2-5
models

compiling, 8-4
defined, 8-2
modifying, 8-4
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modifying equations associated with, 8-4
saving, 8-4
specifying options for, 8-3
viewing associated equations, 8-4

moving inserts in reports, 13-24

N
N/A values, suppressing in reports, 13-23
navigation list, in Web interface, 18-6
numbers

formatting in graphs, 14-9
formatting in reports, 13-24
formatting in worksheets, 15-12

O
one-to-many attributes, 6-3
opening Web documents, 19-4, 20-2
operational mode

for copying data, 4-17
for group solve, 9-8
for refreshing data, 10-19
for solve, 9-6

Oracle Applications
importing users from, 12-4
single sign-on, 12-2, 12-3

Oracle Express Analyzer compatibility with 
Financial Analyzer, 2-5

Oracle Express Objects compatibility with Financial 
Analyzer, 2-5

Oracle General Ledger compatibility with Oracle 
Financial Analyzer, 2-5

P
page breaks

deleting from reports, 13-24
deleting from worksheets, 15-12
inserting in reports, 13-24
inserting in worksheets, 15-12

page controls
in graphs, 14-5
in reports, 13-4
in worksheets, 15-4

parent values, 5-3
Paste Link feature

in graphs, 14-16
in reports, 13-28
in worksheets, 15-16

pie graphs
adding pie slice feelers to, 14-13
description, 14-3
exploding slices in, 14-13
labeling multiple pies, 14-13
labeling pie slices, 14-13

precedence order
specifying in reports, 13-23
specifying in worksheets, 15-11

printing
data entry forms, 16-10
documents from folders, 17-2
documents in Web interface, 19-33, 20-7
reports, 13-26
worksheets, 15-13

profiles
copy data, 4-18
data distribution, 10-7
data refresh, 10-20
data submission, 10-12

Q
QDRs in report calculations, 13-18
qualified data references. See QDRs
queries

clearing, 21-15
defining with Express Spreadsheet Add-In, 21-8

R
recalculating worksheet data, 15-20
Redisplay button

in graphs, 14-5
in reports, 13-4
in worksheets, 15-4

refreshing
data, 10-19
structures, 10-17

renaming
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attributes, 6-7
folders, 17-3
hierarchies, 5-10
Web documents, 19-43

report calculations
creating formulas, 13-17
creating inserts for, 13-15
dimension values in, 13-16
errors, 13-22
examples, 13-19
using dimension values, 13-18
using QDRs, 13-18

Report menu, 2-10, 13-5
reports

adding to folders, 13-27
calculations. See report calculations
changing the layout, 13-7
creating, 13-5
creating in Web interface, 19-7
defined, 13-2
deleting, 13-27
drilling in Web interface, 19-16
drilling through data in, 13-29
elements of, 13-3
example, 2-2
exporting data, 13-27
exporting data from Web interface, 19-38
formatting, 13-23
formatting in Web interface, 19-19, 19-26
linking dimensions, 13-28
opening in Web interface, 19-4
printing, 13-26
printing in Web interface, 19-33
saving in Web interface, 19-35
selecting data in, 13-6
selecting data in Web interface, 19-7
Web example, 19-2

resetting worksheet data, 15-20
row labels

indenting in reports, 13-23
indenting in worksheets, 15-11

rows
formatting in Web reports, 19-22
inserting in reports, 13-24
inserting in worksheets, 15-12

S
saved selections in Web interface, 19-11
saving

data entry forms, 16-9
data in worksheets, 15-20
graphs, 14-13
graphs in Web interface, 19-35
models, 8-4
reports in Web interface, 19-35
worksheets, 15-15

scale, changing in graphs, 14-12
scatter graphs

arranging X-axis labels in, 14-12
description, 14-3
including tick marks in, 14-12
using fitlines in, 14-11

scheduling tasks, 11-3
selecting data

in data entry forms, 16-4
in graphs, 14-7
in reports, 13-6
in Web interface, 19-7
in worksheets, 15-7

Selector
items you can select, 7-3
tools, 7-4

series options, 14-10
shareable documents, 10-15
shared database

Administrator workstations, 1-6
Analyst workstations, 1-11
maintaining, 11-1

sibling values, 5-3
single sign-on, 12-2, 12-3
solve definitions

associating with financial data items, 9-9
creating, 9-4
description, 9-2
in data entry forms, 16-5
modifying, 9-6
running, 9-5
using to calculate data, 9-5

solving data, 9-2
sorting dimension values in Web interface, 19-10
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sparse data handling, 4-10, 4-12
sparse data, defined, 4-9
spreading worksheet data

based on another dimension value, 15-23
defined, 15-22
evenly, 15-22
proportionally, 15-23
to visible elements only, 15-24

Spreadsheet Add-In. See Express Spreadsheet 
Add-In, 21-5

stand-alone sessions, conditions for working 
in, 2-21

stoplight formatting in Web reports, 19-26
stored financial data items. See financial data items
structures

distributing, 10-5
refreshing, 10-17
transferring, 10-3

submitting data
from Administrator workstations, 10-11
from Budget workstations, 10-13

subtitles
adding to data entry forms, 16-7
adding to graphs, 14-8
adding to reports, 13-23
adding to worksheets, 15-11

system configurations, 1-18

T
Task Processor

configurations, 11-2
relation to distribution, 10-8, 10-10
using, 11-1
when to run, 11-2

Task Processor workstations
defined, 1-6
methods of running, 1-7

Task queue
deleting tasks, 11-4
obtaining information using, 11-3
rescheduling tasks, 11-4
viewing tasks, 11-4

text
aligning in graphs, 14-9

aligning in reports, 13-23
aligning in worksheets, 15-11

thick clients, 2-21
thin clients, 2-21
tick marks, including in graphs, 14-12
time-series functions, 8-9
titles

adding to data entry forms, 16-7
adding to graphs, 14-8
adding to reports, 13-23
adding to Web graphs, 19-32
adding to Web reports, 19-24
adding to worksheets, 15-11

Toolbar, Windows client, 2-18

U
user names

importing from operating system, 12-4
importing from Oracle Applications, 12-4

users
creating, 12-2
deleting from user list, 12-6
types, 12-3

V
viewing

contents of folders, 17-2
tasks, 11-4

W
Web interface

browser requirements, 18-2
closing documents, 19-6, 20-4
color coding reports, 19-26
copying data, 19-37, 20-8
copying documents, 19-40
creating documents, 19-7
Data Selection toolbar, 19-8
deleting documents, 19-42
description, 18-2
document layout, 19-14
Document toolbar, 19-5, 20-3
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document workspace, 18-5
entering data in data entry forms, 20-4
exporting data, 19-38, 20-10
Financial Analyzer page, 18-4
folders, 19-39
formatting graphs, 19-31
formatting reports, 19-19, 19-26
graphs, 19-3
methods of access, 18-3
navigation list, 18-6
Navigation toolbar, 18-8
opening documents, 20-2
pasting data, 20-5
printing documents, 19-33, 20-7
reports, 19-2
saved selections, 19-11
selecting data, 19-7
sorting data, 19-10
sorting dimension values, 19-10
submitting data, 20-6
system requirements, 18-2
user requirements, 18-2

Window components, 2-6
Window menu, 2-17
Worksheet menu, 2-11, 15-4
worksheets

adding to folders, 15-14
calculating data in, 15-21
changing the layout of, 15-8
closing, 15-13
creating, 15-6
deleting, 15-14
description, 15-2
example, 2-4
exporting data, 15-14
formatting, 15-11
growing data in, 15-21
increasing data in, 15-22
linking dimensions, 15-16
opening, 15-13
printing, 15-13
recalculating data in, 15-20
resetting data in, 15-20
saving, 15-15
saving data in, 15-16

selecting data in, 15-7
spreading data in, 15-22

workstations
comparison of types, 1-17
in a typical corporate environment, 1-11
Super administrator, 1-3
types, 1-2

write access, 10-17, 12-8, 16-9

X
X-axis labels, 14-12

Y
Y1-axis

assigning a data series to, 14-11
changing the scale of, 14-12

Y2-axis
assigning a data series to, 14-11
changing the scale of, 14-12

Z
zeros

as N/A values in worksheets, 15-19
suppressing in reports, 13-23
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